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Enterprise Developer 10.0 for Eclipse
Release Notes

These release notes contain information that might not appear in the Help. Read them in their entirety
before you install the product.

Note:

• This document contains a number of links to external Web sites. Micro Focus cannot be
responsible for the contents of the Web site or for the contents of any site to which it might link.
Web sites by their nature can change very rapidly and although we try to keep our links up-to-date,
we cannot guarantee that they will always work as expected.

• Check the Product Documentation section of the OpenText Support and Services Documentation
Web site for Micro Focus products for any documentation updates.

Product Overview

Upgrading from earlier Micro Focus products

Note: Windows-only.

This version of your product is dependent on a later version of the Microsoft C run-time system than earlier
Micro Focus products. This means that COBOL executables (.exe) built with a version earlier than 4.0
might not be compatible with the current version of the run-time products. If the behavior of your application
changes with the current version, we strongly recommend that you relink the main executable with the
current version. This will ensure that the COBOL run-time system fully handles any run-time error
conditions that might occur.

A new executable that is fully compatible with the current version can be produced without recompiling the
application, as long as the original object code is available and it is relinked with the current version.

To allow your executables to benefit from the product's latest programming and performance
enhancements, we recommend a full recompilation of your source code.

If you are using Eclipse, Enterprise Developer can automatically relink existing projects created with
Enterprise Developer earlier than 4.0 that have executable link artefacts. Eclipse displays a warning in the
Problems view that the project requires relinking. It then offers a Quick Fix action for you to execute that
will link your project with the most recent version of the Run-Time System.
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What's New
This What's New? document covers some of the new features and functions in the latest release of the
Micro Focus Enterprise Product Suite. Updates apply to the following products:

• Micro Focus Enterprise Developer which provides a contemporary development suite for developing
and maintaining mainframe applications, whether the target deployment is on or off the mainframe.

• Micro Focus Enterprise Test Server which provides a comprehensive test platform that takes
advantage of low cost processing power on Windows environments, to supply scalable capacity for
testing z/OS applications without consuming z/OS resources.

• Micro Focus Enterprise Server which provides the execution environment to deploy fit-for-purpose
mainframe workload on Linux, UNIX and Windows (LUW) environments on IBM LinuxONE (IFLs),
standalone servers, virtual servers, or the Cloud.

• Micro Focus Enterprise Server for .NET which provides the execution and modernization platform to
deploy fit-for-purpose mainframe workload on a scale-out .NET infrastructure and the Azure Cloud.

This document helps you to quickly understand the new capabilities within the 10.0 release.

Enhancements are available in the following areas:

• Rocket COBOL Extensions for Visual Studio Code
• Application Workflow Manager
• .NET Support
• COBOL Language
• Code Analysis and a Natural Language Assistant
• Compiler Directives
• Containers
• Customer Experience Improvement Program
• Data Tools
• Eclipse Integration
• Enterprise Server
• Enterprise Server Common Web Administration (ESCWA)
• Enterprise Server Security
• IMS Support
• Interface Mapping Toolkit
• Licensing Changes
• Mainframe Access
• Micro Focus Unit Testing Framework
• OpenTelemetry
• PL/I Support
• Terminal Emulation

Rocket COBOL and Enterprise Extensions for Visual
Studio Code

Back to Top

The Micro Focus COBOL and Enterprise extensions for Visual Studio Code have been repackaged by
Rocket Software on the Microsoft Visual Studio Marketplace.
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• The Rocket COBOL extension for Visual Studio Code (formerly Micro Focus COBOL Extension for
Visual Studio Code) provides COBOL edit, compile and debug support for Visual COBOL and
Enterprise Developer users in Visual Studio Code.

• The Rocket Enterprise extension for Visual Studio Code (formerly Micro Focus Enterprise extension for
Visual Studio Code) provides PL/I edit, compile and debug support for Enterprise Developer users in
Visual Studio Code. This extension installs the Rocket COBOL extension.

• The Rocket JVM COBOL extension for Visual Studio Code (formerly Micro Focus JVM COBOL
extension for Visual Studio Code) provides support for debugging JVM COBOL code in Visual Studio
Code.

• The Learn COBOL extension for Visual Studio Code provides all training materials for the Micro Focus
COBOL Fundamentals Training course.

New enhancements in this release are:

• Support for accepting command-line arguments in COBOL notebooks.
• New debug launch options - console and integrated Terminal support for platform specific values in the

launch.json file.

• Support is available for fine-tuning the colors of different parts of the code in the editor via Visual Studio
Code's settings.json file. This requires a minimum release 10.0 of Enterprise Developer.

Note: These extensions are not included with the Enterprise Developer installer. They are available
from the Microsoft Visual Studio Marketplace website. All of the extensions are available on Windows
and Linux.

Application Workflow Manager
Back to Top

This release includes the following improvement:

• Two new tools, Get Editor Content and Set Editor Content, have been added to the Eclipse function
package. These tools enable you to copy or set the content of an Eclipse text editor to or from a string
or file. For example, you can use these tools to change the editor content by an external script written in
Python or PowerShell. See Tool Types for the Eclipse Function Package in your product Help.

.NET Support
Back to Top

This release provides the following enhancements to .NET support:

• .NET COBOL projects now target .NET 8. You can use .NET 8 SDK or Visual Studio Code to build .NET
8 COBOL projects. Earlier versions of .NET are not supported.

COBOL Language
Back to Top

This release includes the following enhancements:

• The FREE statement - under the MF dialect, you can now free memory, allocated via the ALLOCATE
statement, directly by using FREE ADDRESS OF data-name. This negates the need to specify a
returning pointer during allocation (i.e. ALLOCATE data-name RETURNING my-pointer) and then
freeing the pointer.

• COBOL/Java interoperability - the following features have been added to the COBOL and Java
interoperability for native COBOL code:
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• Support for the use of dynamic length COBOL items when running under an MF dialect. See
Mapping COBOL Items and Java Types.

• User-defined exception handling when calling Java static methods. See Example 5 - Exception
Reporting When Calling Java Static Methods.

• The entry_point_mapper_disable_auto_aliasing run-time tunable - this new tunable has been
introduced to determine whether the Entry Point Mapping facility should not emulate the alias function of
an IBM mainframe linkage editor, and instead generate a COBRT173 Called program file not
found in drive/directory run-time system error.

• Enterprise COBOL support - the following enhancements provide greater compatibility with IBM
Enterprise COBOL version 6.4:

• The STRING and UNSTRING statements now support USAGE UTF-8 data items.
• The ENCODING phrase of the JSON-GENERATE and JSON-PARSE statements is now supported.
• The ENTRY-NAME and ENTRY-INTERFACE clauses of the Function-ID paragraph are now

supported; however, these clauses are strictly documentary.
• New MF Level - this release includes a new default level (MF"23") of reserved words. See Reserved

Words Table for words associated with this level.
• Pointer dereferencing - improvements have been made in the ability to dereference pointers using

both the DATA...AT and :: (colon-colon) syntax. See Pointer Dereferencing.

Code Analysis and a Natural Language Analysis Assistant
Back to Top

This release includes the following enhancements related to integration with COBOL Analyzer and
Enterprise Analyzer:

• Natural Language Analysis Assistant in the IDE - integration with COBOL Analyzer and Enterprise
Analyzer now provides a natural language Analysis Assistant chat window in the IDE. You can type
queries about a COBOL workspace in a COBOL Analyzer or an Enterprise Analyzer repository. From
the Analysis Assistant window results you can open Program Flow Graphs, view Complexity Reports,
and open COBOL source files.

Note: This functionality requires a licensed copy of either COBOL Analyzer 10.0 or Enterprise
Analyzer 10.0.

• Complexity reports - you can now generate a Complexity Report for a workspace in the Application
Server Explorer view. A complexity report enables you to view and compare various metrics of files in
your workspace.

• On Windows, the Program Flow Graph (a Windows-only feature) is now available from Server Explorer
for workspaces and source files in COBOL Analyzer and Enterprise Analyzer in the Eclipse IDE.

Compiler Directives
Back to Top

The following Compiler directive is new in this release:

• ILPOINTER-REFERENCE - Determines how a pointer used as a method parameter is passed if BY
VALUE or BY REFERENCE is not specified as part of the parameter.

Containers
Back to Top

8 | What's New



On Ubuntu platforms, this product now provides a full development containers demonstration capable of
providing a full COBOL development environment, running in a container, accessible from Visual Studio
Code; see Running the Development Containers Demonstration Base Image for more information.

Customer Experience Improvement Program
Back to Top

Starting this release, the Customer Experience Improvement Program collects high-level, anonymous
information on how Micro Focus products are used. The information collected includes product name and
version, OS in use, and features used with the purpose to improve the products and, consequently, the
customer experience.

Customer Experience Improvement Program participation is enabled by default. You can opt out with the
help of the mfceipconfig command-line utility.

Data Tools
Back to Top

This release includes the following enhancements in the Enterprise Developer and Enterprise Server
products:

Attention: This feature is in Early Adopter Program (EAP) release status. We intend to provide the
finalized feature in a future release. Please contact OpenText Support for Micro Focus Products if you
require further clarification.

• A new Data Tools utility, an Eclipse-based RCP (Rich Client Platform) application, is available. The new
Data Tools is designed to overcome several restrictions in the existing Data File Tools and Classic Data
File Tools. The new Data Tools application is a multi-line editor where the previous Data File Tools
support editing one line at a time. Changes are made in the editor window, not in a separate line at the
bottom of the editor.

• A new REST-based file service API is now available. This enables you to access Micro Focus formatted
data sets as follows - get dataset attributes, open or close datasets, get or set a dataset’s content, and
to create datasets. The API commands can be used in customer scripts to access datasets with Micro
Focus formats to automate application development processes. The REST-based file service API is
used by the new Data Tools utility.

Features of the new Data Tools include:

• Open/save of Enterprise Server-cataloged datasets of the following Micro Focus formats: Fixed blocked,
Variable blocked, and Indexed

• Multi-line editing support
• Insert, delete, update of lines or records
• Different coloring of changed lines/records to highlight changes
• Undo/redo
• Page-based navigation
• Toggle HEX on/off
• EBCDIC/ASCII switch
• Options for specifying the fonts and colors
• Display file information in a separate view
• Comprehensive logging and tracing capabilities
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Eclipse Integration
Back to Top

This release provides the following enhancements:

• Enterprise Developer supports, and is shipped with, Eclipse 4.28 (2023-06). Versions of Eclipse prior to
this one are not supported.

• Quick fixes - quick fix functionality has been enhanced to provide a list of possible fixes that can
automatically be applied from the popup box displayed when hovering over an error in the editor; this is
similar to the functionality provided when working with Java.

• Session profiles when using Reflection Desktop or Rumba+ Desktop as your TN3270 emulator -
you can specify an existing session profile to automatically use when you connect to your emulator
when running or debugging your mainframe subsystem project. See Choosing a TN3270 Mainframe
Display in your product Help.

• Pre- and post-build processing events - script files used as part of build processing events
(Properties > Micro Focus > Build Configurations > Events) can now be coded to affect the
outcome of the COBOL build process, and also introduce error messages into the IDE. See Pre- and
post-build processing events.

• Copybook Graph support - you can now see a graph of the copybook dependencies of COBOL files.
The graph enables you to see any incoming and outgoing dependencies.

• Copybook Paths preference - a new preference page has been introduced to help locate copybook
files, referenced in standalone files, when debugging. Use this page if your copybook files (or the files
that call them) have been moved from their original (built) location. The list is searched in order until a
match is found.

• Conditional breakpoints when debugging JVM COBOL now support the use of the following
operators: <, >, <=, and >= within expressions.

• Formatting preferences applied on sentence termination - a new formatting preference (Window >
Preferences > Micro Focus > COBOL > Editor > Typing > Format sentence on period) formats the
current sentence as per the current formatter profile settings, when it is terminated by a period.

Enterprise Server
Back to Top

This release provides the following enhancements:

• Remote File Access - it is now possible to remotely access files using a configured Remote File Access
(RFA) MFCS Connector. You can access ordinary files, cataloged datasets, and spool output. This also
enables remote editing of COBOL data files using the new Data Tools utility. This enables you to
download and upload files, datasets, and spool output locally or remotely using the existing Enterprise
Server Security configuration. Various security features make this solution a more secure alternative to
more generic solutions such as FTP and SSH.

Enterprise Server Common Web Administration (ESCWA)
Back to Top

This release includes the following enhancements:

• Catalog view has improved filtering options and now includes paging. A new Load on navigation check
box enables you to filter based on the previously selected conditions. See Catalog List in the product
Help.
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• A new Configuration Report page enables you to visualize potential security vulnerabilities in the
ESCWA and MFDS configurations. Each domain and configuration attribute combination has its own
help dialog. See Configuration Report in the product Help.

• Role-based security configuration. You can now configure a users view of ESCWA. If a user does not
require specific roles then you can hide corresponding pages and API. You can configure the role-based
access from the Role Options page. Click Security , expand ESCWA Configuration followed by the
ESM, and then click Roles. See Role Options in the product Help.

Note: Role-based security is an ESCWA only feature that works on top of existing product security.

• It is now possible to remove Locks, if necessary, to fix applications that are broken due to a lock that has
not been removed. You can enable this feature from the Locks page. Click Native > Monitor > Locks,
and then click Remove Locks. This functionality is controlled by the casstop resource entity in the
OPERCMDS resource class. See Locks in the product Help.

Caution: Incorrectly removing locks can result in system instability and corruption or loss of data.

• Region verification - ESCWA can now verify the configuration of selected components for an enterprise
server region. You can use this feature to identify potential start up or configuration issues for the
selected region. The verification process uses the casverify utility to perform the verification action. See
Verify in the product Help.

• Improved CICS resource navigation. Active resources can now be filtered by group and large sets of
filtered data can be paged.

• The API return codes have been improved. Previously, when the region monitor and control APIs were
called, they would return a HTTP 200 code, with the error specified in the JSON output. The return
codes have been improved to give more information. You can configure the API to use the new or old
behavior.

• The ESCWA user interface is now more responsive and can be used with a greater variety of smaller
Web browsers.

Enterprise Server Security
Back to Top

This release includes the following enhancements:

• Enterprise Server security features provided by the VSAM External Security Manager (ESM) module
are enabled by default. You will need to supply valid credentials when you interact with ESCWA, the
Micro Focus Directory Server and regions in the browser based UI or in the IDE, use certain utilities
from the command line, use TN3270 emulator to access regions, log into or with FileShare. See After
Installing > Enterprise Server Security Features for details on how to configure this product.

• TLS Certificate Checking Utility - a new executable in the product that can be used to help diagnose
problems with TLS certificates. It can check the validity of certificates, verify certificate chains, check
that certificates and private keys match and check that a certificate contains a SAN that matches a
provided hostname/address. Improves TLS usability by diagnosing TLS certificate problems. See
CertChecker Utility for more information.

• The VSAM ESM Module, which provides file-based security for Enterprise Server is now a GA quality.

• User authentication and resource authorization control can be enabled through a simple file-based
security mechanism.

• Security data can be imported from YAML or LDIF and exported to YAML for portability and ease of
editing / scripting.

• Additional optional security features are available for HTTP and MFBINP conversations, for the Web
Services and J2EE, Web, and Remote File Access conversation types. Listeners can be configured to
require user authentication and/or to restrict access to specific types of requests. See Enhanced
Security for HTTP and MFBINP for more information.
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IMS Support
Back to Top

This release provides the following new features:

• APARM handling has been updated to use EBCDIC APARMs obtained from EBCDIC applications. In
addition, the APARM positional parameter for DLI has been changed from 19 to 20 to be consistent with
the IBM IMS documentation. The APARM positional parameter for BMP applications remains at 19.

• The ES_IMS_APARM_DLI environment variable has been added to enable the APARM handing
behavior of previous releases.

Interface Mapping Toolkit
Back to Top

This release provides the following enhancement:

• The imtkmake -defmap command now support the following new parameters that enhance the
default mapping support for service interfaces - entrypoint, method, and path.

Licensing Changes
Back to Top

• The SafeNet Sentinel licensing system that was available with previous releases of this product has
been deprecated and is no longer available in release 10.0. This product also uses the Micro Focus
AutoPass licensing technology which was introduced in release 8.0. Starting with release 10.0,
AutoPass is the only licensing technology available in this product.

• The SafeNet Sentinel licenses are no longer supported, and you need to use AutoPass licenses starting
with release 10.0. Contact your account manager to replace your existing SafeNet Sentinel with
AutoPass licenses.

Note: Installing 10.0 on a machine where there are other Micro Focus products or versions installed
that use SafeNet Sentinel licensing might result in some compatibility issues. While the 10.0
installation process has been designed to address such issues, you should be aware of the following
scenarios and if any action might be required to ensure licensing works as expected. See Advanced
Installation Tasks > Licensing Coexistence when Upgrading to Release 10.0 in the Installation section.

Mainframe Access
Back to Top

This release includes the following new features:

• z/OSMF support - MFDAS and Syncmon now have access to mainframe-hosted PDS files using the z/
OSMF interface. This enables you to list and download PDS files without having to install Mainframe
Access Server. See Using z/OSMF in your product Help.

• MFA Compare and Synchronization Monitor (Syncmon) is now supported on UNIX. It enables you to
compare and synchronize source (PDS) and data (VSAM and Sequential) between UNIX and the
mainframe. See Compare and Synchronization Monitor.

• MFDAS on UNIX platforms now supports USS commands. See MFDAS Syntax and Options.
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Micro Focus Unit Testing Framework
Back to Top

This release includes the following enhancement:

• A new configuration file format has been introduced that enables you to use environment variables in
your unit test code for tests that are compiled for more than one scenario. A portable environment file
can provide environment variables for a test case that has been compiled in multiple ways (for Windows/
UNIX, 32-bit/64-bit, etc...). See Configuring the Run-Time System Environment in your product Help.

OpenTelemetry
Back to Top

This release includes support for OpenTelemetry on UNIX platforms. OpenTelemetry provides observability
of Enterprise Server applications by collecting telemetry data. You can configure OpenTelemetry to emit
the information that you require and in a form that can be consumed by third-party monitoring software,
such as Prometheus, Grafana, and Dynatrace. This can enable you to visualize processes and workflow
performance and behavior.

PL/I Support
Back to Top

This release provides improvements in the following areas:

Open PL/I compiler:

• Support for ORDINAL data types.
• Support for ORDINALNAME, ORDINALPRED and ORDINALSUCC ordinal built-ins.
• New -gen_entry_dcl compile option which will automatically generate ENTRY declarations and write

them to the specified file.
• Improved mainframe compatibility of E and F edit FORMATs.
• Optimizer inlining support to improve performance. The new -noinline compiler option prevents the

optimizer from attempting to inline PROCEDURE or BEGIN blocks.
• Support for UPTHRU and DOWNTHRU in loop iterations.
• Support for the TRANSMIT condition.
• Compiler cross-reference listings now indicate which variables and other identifiers are unreferenced

and where they are declared within include files. Compiler cross-reference listing also include unique
statement IDs to help correlate diagnostics to ambiguous line numbers within generated macro
expansion.

• Support for static data structures and arrays exceeding 2GB in size (with the -largedata compile option).

Open PL/I debugger:

• Support for ORDINAL data types.
• Simplified debugger experience in Enterprise Server by removing PL/I tab from ESCWA.
• Support for asterisk (*) variable names in PL/I structures.
• Improved overall debugger performance when handling large arrays and/or structures.

Open PL/I Run-Time System:

• Improved support for controlled storage in CICS transactions running in Enterprise Server.
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• Support for the TRANSMIT condition.
• Improved support for ENDPAGE emulation.

Terminal Emulation
Back to Top

This release includes the following enhancements:

• Host Access for the Cloud shipped with this product is now version 3.0.0.2. The HACloud configuration
file has changed is now the application-userprefs.properties file in %ALLUSERSPROFILE%
\Micro Focus\Enterprise Developer\hacloud (Windows) or $COBDIR/etc/hacloud
(UNIX). If there is an existing hacloud.properties file in from an earlier Enterprise Developer
release in %ALLUSERSPROFILE%\Micro Focus\Enterprise Developer, this file is backed up the
first time you start the HACloud session server. Micro Focus recommends that you migrate any non-
default settings from the older configuration file over to the application-userprefs.properties
file after the upgrade. See HACloud Configuration File for details.

• For secured ESCWA scenarios, HACloud now retrieves credentials for the ESCWA connection from a
default secret shipped with the product (in microfocus/common/readonly). You can override the default
user credentials by supplying an escwacreds and/or an mfdscreds secret. If these secrets do not exist
then the default supplied user will be used.
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Significant Changes in Behavior or Usage
This section describes significant changes in behavior or usage. These changes could potentially affect the
behavior of existing applications or impact the way the tools are used.

• Licensing Changes
• Significant Changes in Behavior or Usage - Enhancements
• Significant Changes in Behavior or Usage - Fixes

Licensing Changes

Back to the list

• With release 10.0, the SafeNet Sentinel licensing technology has been deprecated. This can result in
some compatibility issues if you install 10.0 on a machine where there are other Micro Focus products
or versions installed that use SafeNet Sentinel licensing. While the 10.0 installation process has been
designed to address such issues, you should be aware of the following scenarios and if any action
might be required to ensure licensing works as expected. See Advanced Installation Tasks > Licensing
Coexistence when Upgrading to Release 10.0 in the Installation section.

Significant Changes in Behavior or Usage - Enhancements

Back to the list

The numbers that follow each issue are the Support Case Numbers followed by the Issue number (in
parentheses).

• Data Tools
• Eclipse IDE
• Enterprise Server
• File Handling
• IMS Support
• PL/I Support
• SQL: HCO for SQL Server
• SQL: Mainframe Batch Database Tools

Data Tools

Back to the list

• In the new Data Tools Editor, positioning is no longer lost when switching between character and HEX
mode.

02526087 (410104)
• The new Data Tools Editor has a preference page that allows users to adjust the font size of various

editor parts.

02315408 (285050)

Eclipse IDE

Back to the list

• A new smart editing preference - Format sentence on period - which formats a sentence according to
the current formatter profile when it is terminated with a period, can be configured from Window >
Preferences > Micro Focus > COBOL > Editor > Typing.
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(8294)

Enterprise Server

Back to the list

• Enterprise Server's PAM ESM Module now has a group-filter option that can be used to ignore all user
groups that do not matching a specified pattern. See PAM ESM Module Custom Configuration
Information in your product Help for more information.

3176983 (12500)
• In ESCWA, the Enable Single Sign-On for Unsecured Resources has been renamed to Single Sign-

On Behavior which has three options:

• Disabled - This disables all single sign-on including live enterprise server regions.
• Only Secure and Loopback - This is the old 'default' behavior, single sign-on will be enabled for

secured and localhost resources.
• Allow Insecure (All) - Single sign-on will be enabled for everything. This list controls two boolean

configuration attributes specified in the commonwebadmin.json file:

• InsecureAutoSignOn - this is an existing attribute.
• DisableAutoSignOn - this is a new attribute, if this is set to true then InsecureAutoSignOn will

have no effect and all single sign-on will be disabled. If set to false then InsecureAutoSignOn
will operate as before.

02663941 (658042)
• In ESCWA, on the Spool page you can now specify default filters for all users. See Spool in your

product Help for more information.

02497901 02573796 (465005)
• In ESCWA, you can now set table column defaults for users. This can be configured from the column

filtering option of the table in ESCWA. If an administrator has not set table defaults then the table
columns displayed will match the ESCWA defaults. You can specify which users are able to configure
default columns. This can be performed by modifying the Table Column Configuration security
resource entity. See Security Resources to Control ESCWA and API Access in your product Help for
more information.

Note: If Table Column Configuration is not specified then ESCWA will use the configuration
specified for the Common Web Administration resource class.  

02618280 (532051)
• The casverify utility has been improved with new functionality and additional verification stages. See

casverify in your product Help for more information.

Note: The changes to its text and JSON output formats are incompatible with earlier versions.

(527008)

File Handling

Back to the list

• ICETOOL emulation now supports WRITE, DIGITS and WIDTH for the COUNT operator.

02650300 (539002)
• A new EXTFH config option, FLUSHSYSOUT, has been introduced. FLUSHSYSOUT=ON (which is the

default setting) enables you to view records for an active spool job as they are written/opened. This new
setting is not as performant as the previous behavior (which you can reinstate using
FLUSHSYSOUT=OFF) where records for an active spool job would only be displayed after a
determined buffer size was written to.

02641736 02658226 (528102)
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IMS Support

Back to the list

• The new ES_IMS_LINKAGE_NULL environment variable has been added to handle a scenario in which
more linkage items are passed by the program than there are PCBs in the PSB. When
ES_IMS_LINKAGE_NULL=Y, extraneous linkage items are assigned a value of NULL.

02796708 (665033)
• APARM handling has been updated to use EBCDIC APARMs obtained from EBCDIC applications. In

addition, the APARM positional parameter for DLI has been changed from 19 to 20 to be consistent with
the IBM IMS documentation. The APARM positional parameter for BMP applications remains at 19. The
ES_IMS_APARM_DLI environment variable has been added to enable the APARM handing behavior of
previous releases.

02709072 (614050)
• You can now configure MFS to support input type option 2 just as it supports option1. To enable this, set

the new ES_IMS_MFS_OPT2_LEGACY environment value to Y. This enables legacy MFS input type
option 2 behavior. When set to N, MFS input type option 2 behavior is like on MFS on z/OS mainframes.
The default is N.

02614651 (515070)

PL/I Support

Back to the list

• The internal consistency error in the PUT EDIT statement with a DO-loop that was never iterated has
been fixed; however, we recommend avoiding dead DO-loops in PUT EDIT statements as they result in
redundant code.

02518315 (407194)
• The DO UPTHRU and DO DOWNTHRU options are now supported for both arithmetic and ordinal

types.

00366167 (11718)
• PL/I now supports the ORDINALNAME, ORDINALPRED, and ORDINALSUCC built-in functions. This

support is provided in this release as an Early Adopter Product (EAP) feature.

00366176 (12535)
• Support for the PL/I FORMAT statement has been updated. The repetition value limit for the repeat field

has been increased from 255 to 999999.

02382223 (333007)
• The Open PL/I compiler now supports the -initautuo, -initbased, -initctl, and -initstatic options.

02725021 (623003)
• The Open-PLI compiler now supports unique statement ID numbers in the compiler listing file. The -stmt

compiler option (or *PROCESS STMT) enables this feature. The statement ID numbers are enclosed in
curly braces, e.g. {367} for easy identification in the listing. Likewise, the associated statement ID for a
given line is included in compiler listing diagnostics. This can be particularly effective during macro
expansion when line numbers in the listing file are held constant and a compilation error occurs due
incorrect PLI code in the expansion of the macro.

02501000 (401114)

SQL: HCO for SQL Server

Back to the list

• The HCOSS Define Lists UI has been enhanced to enable you to select a dependency mode to use
when creating a transfer list. The available modes are:
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• Default - Automatically include all parent objects of the selected object.
• Family tree - Automatically include all parent objects of the selected table and the child objects of

each parent object
• No dependency handling - Do not include any parent or child objects of the selected table. In

addition, the start and end date and time for each table transfer is now part of output when
transferring data.

02544930 (440008)

SQL: Mainframe Batch Database Tools

Back to the list

• The SQLTUL tool has been updated to enable you to specify that the return code (RC=04) for execution
of non-SELECT * statements should match the mainframe DSNTIAUL return code. The default is to not
match the return code, but to return RC=0. In addition, the -r option has been added to the
mbdtconfig command to enable the same functionality from the command line.

02669700 (547020)

Significant Changes in Behavior or Usage - Fixes

Back to the list

The numbers that follow each issue are the Support Case Numbers followed by the Issue number (in
parentheses).

• Application Workflow Manager
• CICS Support
• Compiler
• Eclipse IDE
• Enterprise Server
• File Handling
• Host Access for the Cloud
• IMS Support
• Interface Mapping Toolkit
• JCL Support
• Mainframe Access
• Micro Focus Batch Scheduler Integration
• Micro Focus Directory Server
• PL/I Support
• Run-Time System
• SQL: Mainframe Batch Database Tools

Application Workflow Manager

Back to the list

• The name of the connection type Micro Focus z/Server" in the Remote Systems view has been
changed to Micro Focus z/OS.

(58344)

CICS Support

Back to the list

• When an FCT entry had the start empty property set either in the definition itself or via a SET FILE
EMPTYSTATUS(EMPTYREQ) command, the file was emptied on every OPEN. This was not in line with
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mainframe behavior. In this release, setting the start empty property now causes the file to be emptied
only on the next OPEN, which aligns with mainframe behavior.

02746607 (633025)

Compiler

Back to the list

• C++ compiler and runtime updates on AIX platforms (AIX platforms only)

If your applications contain C++ code or they rely on third-party applications containing C++ code, you
will be affected by a change IBM have made to their AIX platforms.

IBM has changed the C++ compiler and C++ runtime on AIX from the old xlC compiler and runtime to
the new Clang-based C++ compiler (ibm-clang++_r) and runtime, and your COBOL development
system has been built to work with these new versions .

As you cannot mix C++ code that has been compiled using the xlC compiler with C++ code compiled
with the ibm-clang++_r compiler, this will result in you being required to recompile any xlC-compiled C+
+ code with the new compiler, so it can run in the new Clang C++ runtime.

Before recompiling, ensure that you install the Open XL C/C++ 17.1 (or later) runtime environment and
utilities package; see https://www.ibm.com/support/pages/ibm-open-xl-cc-utilities-aix-1711#DNLD for
more information.

If you are unsure of your reliance on C++ code, you can run the checkbin script, available from
$COBDIR/bin: run checkbin -h for details. This utility will scan a directory structure or file and report
any dependence on the xlC C++ runtime, which would indicate code that needs recompilation.

• The intrinsic function LENGTH and special register LENGTH OF were not always returning the correct
result for PIC N NATIONAL fields. These have been updated to the correct behavior, namely returning
the number of characters for the former and number of bytes for the latter. If your legacy code has been
relying on the previously incorrect behavior, results might now differ.

(613039)
• Generated code only (excluding Intel x86 32-bit platforms): an error when moving from a COMP-6 item

to another COMP-6 item when the SIGNFIXUP Compiler directive is specified has been fixed.

(665005)

Eclipse IDE

Back to the list

• The Skip all breakpoints option, available in the Breakpoints view for COBOL programs, can now be
toggled on and off during an active debug session.

(429042)
• From the Server Explorer in Eclipse, remote catalog entries can now be opened in the Data File

Editor when they are running through a Fileshare server.

(485063)
• A new preference can be set within Eclipse to add search paths for copybooks within standalone files.

Select Windows > Preferences > Micro Focus > COBOL > Standalone Files > Copybook Paths,
and then add one or more paths (or environment variables containing paths) to be searched when
debugging. When the paths in a symbols file cannot be found (for example, source has moved and
debugged from a different location) the missing copybooks are searched for along these paths until a
match is found.

02598103 (517053)
• A new preference, Preserve Ant build file for Maven projects has been added to the Micro Focus >

Builder preference page. Select this option to automatically create a build file (.cobolBuild) when
importing a Maven project.
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02540902 (443016)
• The PL/I launch configuration for remote projects using the SSH Only connection now allows the Use

X-Server setting to be unchecked, and the output of a program to be displayed in the Eclipse console.
This is permitted when running an application, but the use of an X-Server is still necessary when
debugging, and so this option must be selected for that scenario, otherwise an error is shown.

(420024)
• For new workspaces, the Server Explorer view no longer contains a connection to the local ESCWA

server by default. You must add the connection manually, when required.

(656022)
• When launching Rumba Desktop or Reflection Desktop (as your TN3270 emulator) from within Eclipse,

you can now select a custom profile with which to start the session; see Choosing a TN3270 Mainframe
Display within the product documentation for more details.

02498222 (403108)
• New COBOL projects created under a Japanese locale now default to a source encoding of UTF-8. This

new default can be changed by a new preference setting in Preferences > General > Workspace >
Source encoding directives. Also, within each project, this setting can be overridden at the usual project
levels (project settings, build config, etc...) by using the SOURCE-ENCODING directive. Additionally, the
COBOL project settings (Properties > Micro Focus > COBOL) contain a new setting - source-
encoding - which also explicitly passes through the file encoding to the Compiler. This setting can be
used instead of the previous method of specifying the SOURCE-ENCODING directive within Additional
directives.

(481005)
• The option to specify a script file for environment variables has been removed from the Enterprise

Server runtime launch configuration, as it is not supported for this type of configuration.

02661247 (543073)
• The Generate Client wizard now enables you to select YAML files, and use them to generate web

service clients.

(648043)

Enterprise Server

Back to the list

• An APPC DPL from an enterprise server region to TX Series would result in an ASRA abend on the
enterprise server side.

02686079 (566028)
• When performing a Distributed Program Link (DPL) to a remote system through an intermediate

enterprise server region using a transaction ID that declared a TWA, the program did not run under that
ID and therefore the TWA was not available. This has been fixed and the transaction ID now propagates
through the chain.

02645043 (542077)
• When running with TRANCLASS active, TD Queue transaction triggering was not working.

02737664 (629076)
• In ESCWA, the Catalog list view and the API failed to honor the time value for filters that use date and

time. This has been fixed. Output time values for "created" and "referenced" have been changed in the
Catalog list view to match the format in the Catalog DCB view.

(588011)
• CICS paging is now supported for function shipping. When a SYS62 connection is used, an additional

configuration to the IBM Comms Server is required. A CPMI TP definition is required on the originating
region.

02667779 (583002)
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• ASSIGN INVOKINGPROG did not behave correctly when a CALL was involved.

02662244 (543070)
• A DPL over a SYNCLEVEL2 connection could result in an XA start being driven out of sequence

resulting in a protocol error.

02583717 (477027)
• In a TRANCLASS enabled enterprise server region with a high volume of XA transactions, the logging

overhead could cause performance degradation. This has been improved.

02560536 (468059)
• When a transaction invoked across an Inter System Communications link (Transaction Routed)

executed a RETURN IMMEDIATE TRANSID(...), the specified transaction did not run without an AID
key being pressed.

02695470 (665161)
• Running a transaction that produced paged BMS output over a remote connection would incorrectly

result in an AEXJ abend.

02796589 (662007)
• The PAC compatibility checks that run at startup have now been relaxed. Consistent platform and bitism

are still checked, but product version checks are no longer carried out. The
ES_PAC_MIN_COMP_CHECK environment flag has now been deprecated.

Note: Enterprise Server will still carry out record compatibility checks during start up.

(19756)
• The statusCodes flag has been added to some ESCWA API endpoints which can be used to enable

ESMAC to return appropriate HTTP error status codes instead of embedding failure messages in
successful responses. In a future product release, the new behavior will be enabled by default in the
version 2 of the API and the flag will be removed. The version 1 of the API will maintain the current
behavior.

02601489 (506061)
• ESCWA now limits the session timeout to 20 days. If an existing configuration is greater than that it will

be limited to that value.

(665130)
• In ESCWA, the Listener Properties page now limits user inputs when the smem protocol is selected.

Multiple host names are not permitted, and port selection is also not permitted.

Note: API functionality remains the same.

(665044)
• Remote file and remote SYS ID options can now be modified when adding or editing FCTs with Use

Catalog.

(683164)
• CICS programs referenced the EXCI LINK statement now run under the same user as the

corresponding JCL job.

02747263 (637024)
• On UNIX platforms, the casverify utility no longer lacks the detailed file and folder path checking

previously only supported on Windows platforms.

(407163)
• Runaway timeout was intermittently incorrectly calculated.

02529887 (468050)
• The JSON output format for the casverify utility has changed. Messages specific to casverify

itself are no longer identified by "msgout" but under a "messages" array.
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(570009)
• For Enterprise Server application failure reports and storage dumps generated by runtime errors, the

RTS error code is now taken into account during es-dump-limit (ES_DUMP_LIMIT) processing. Runtime
errors with differing error codes will now be treated as distinct.

02660093 (561067)
• The Allow no-password signon for default users property has been added to the ESCWA Advanced

Region Properties page. If this property is set to false, an explicit signon request with no password
matching an enterprise server default user account will no longer be treated as a no-password verify,
and will instead result in a not authenticated failure.

02728103 (625033)
• Previously, a successful call from JCL to EXCI might result in a ROLLBACK instead of COMMIT.

(504150)
• When no connection string is supplied through ESCWA/MFDS/esfadmin the vsam_esm module will

default to C:\ProgramData\Micro Focus\Enterprise Developer
\es_esm_file_directory.This directory will have been configured through running mfsecconv
init, which is called by the product installer in 10.0 and later.

(545065)
• The es_default_security.yaml file is now supplied with the product and is located at

%ProgramFiles(x86)%\Micro Focus\Enterprise Developer\etc (Windows) or
$COBDIR/etc/vsam_esm (UNIX). You can use this file as a template to configure the VSAM ESM
Module. See the VSAM ESM Module topic in your product Help for more information.

(613052)
• Client connection to Micro Focus Directory Server (MFDS) would sometimes convert a fully qualified

host name to just the simple host name. This could result in TLS connection issues if this did not exactly
match the host names specified in the certificate.

02587914 (486048)

File Handling

Back to the list

• If the SORTOUT was a VSAM data set defined with the NOREUSE option and with DISP=SHR,
MFJSORT was removing existing records (as if the REUSE option was in use). This behavior has been
corrected, and MFJSORT now appends records to an existing NOREUSE VSAM file, regardless of the
disposition.

02583983 (480002)
• During a SORT, SORT-EBCDIC is no longer (incorrectly) converting HEADER, TRAILER FIELDS to

EBCDIC.

02596813 (503043)
• For various ICETOOL operations, the limits for the BI format have been corrected - SPLICE/SELECT

operations limit the BI format to 1500 bytes; for all the other ICETOOL operations, the limit is 8 bytes.

02827146 (662089)
• For SORT operations, an issue in which E15/E35 user exit record flags weren't being set correctly after

returning from the exit, to perform an insert, has been fixed. This particular issue only occurred when an
insert was performed while the user exit record flags were set to 0 (first record). The flags are now set
correctly to align with mainframe behavior.

02725254 (630030)
• During a SORT operation, SORT-EBCDIC PARM no longer (incorrectly) converts INREC FIELDS to

EBCDIC.

02602838 (505058)
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• The Micro Focus file handler now passes correct information to the third-party file handlers for the
implementation of the FS_RENAME_FILE routine.

02794472 (559042)
• When writing records to a sequential spool file, it will not come under the affect of a semaphore.

Additionally, use the FLUSHSYSOUT=OFF configuration option to improve performance when writing to
the spool file; see FLUSHSYSOUT in the documentation for more details.

02805692 (651167)

Host Access for the Cloud

Back to the list

• The hacloud.properties file is now deprecated and the HACloud configuration details are stored in
an application-userprefs.properties file. After installing 10.0, the HA Cloud
startsessionserver script will rename any existing hacloud.properties to
hacloud_backup.properties. You need to port over any configuration settings from the old file to the new
application-userprefs.properties file.

(661065)
• The hacloud.properties file now includes a setting for the default location of a log file with

information about starting the session server as well as other logging fields.  

(502005)
• This release includes version 3.0.0.2 of the HACloud TN3270 emulator. HACloud uses a new

configuration file, application-userprefs.properties in %ALLUSERSPROFILE%\Micro Focus
\Enterprise Developer\hacloud (Windows) or $COBDIR/etc/hacloud (UNIX). If you are
upgrading from a previous Enterprise Developer release, and the old hacloud.properties
configuration file from the previous installation still exists, then the settings in this file take precedence,
with the exception of the setting to enable HTTPS communications to the session server endpoint. If
TLS was previously enabled, then after 10.0 the setting server.ssl.enabled=true needs to be
applied to application-useprefs.properties. It is recommended to migrate your configuration
settings over to the application-userprefs.properties file after the upgrade, and delete the
hacloud.properties file.

(656064)
• In this release, Host Access for the Cloud will now attempt to retrieve credentials for the ESCWA

connection from a secret which will be shipped with the product by default (in microfocus/common/
readonly). You can override the default user credentials by supplying an escwacreds and/or an
mfdscreds secret. If these secrets do not exist then the default supplied user will be used.

(658050)

IMS Support

Back to the list

• A problem that caused a GSAM read error on restart when restoring a GSAM input file to a particular
CheckPointID has been fixed.

02686182 (566027)
• Corrected the MFS handling of PFKEYS pressed with no terminal data on segments in formats with

OPT=2 to make the behavior compatible with MFS on the mainframe.

02615830 (515062)

Interface Mapping Toolkit

Back to the list
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• The base path is no longer part of the Service name field in the Properties dialog box of REST Web
service Deployment Server tab. (It is only visible in the Advanced Settings of the service name.)

02795415 (651091)

JCL Support

Back to the list

• This release provides support for up to DSNAME10 dataset name elements in ES_ALLOC_OVERRIDE
rules.

02800575 (651099)
• Restarted batch jobs now update the condition codes used when evaluating further restarts of the same

job. To this end, the recording of the result from a job restart has been changed to show the latest result
from steps that are within the restart range rather than the results from all steps in the job.

02575437 (477008)

Mainframe Access

Back to the list

• Performing an action in AWM that required a PDS DIR or CATDCB could result in an exception.

(487033)
• On UNIX platforms, the MFDAS command FINDMEM failed to return multi-part forms.

(496020)

Micro Focus Batch Scheduler Integration

Back to the list

• The CASAPI function for MFBSI is now ON by default, which improves performance and security. To
turn it off, meaning that CASSUB/CASOUT external commands submit the job, monitor the JCL region,
and retrieve the JEYSYMSG output, edit the CASAPI entry in the mfbsi.cfg file, or specify
CASAPI=OFF on the command line.

(544087)
• Control-M (CTM) for z/OS does not support embedded spaces in variable values. The CTM behavior of

MFBSI supports spaces, and in the case of AutoEdit variable values, removed the spaces and assigned
the rest of the value to the variable. This caused a problem when executing jobs that used AutoEdit
variables that contained a space at the end of the line followed by a character because the character
was concatenated to the value of the last Autoedit variable. To accommodate spaces in AutoEdit
variables, this release introduces the CTM_SPACE variable, which enables you to change the default
MFBSI behavior to instead mimic the z/OS behavior: CTM_SPACE={[ON|YES]|[OFF|NO]}ON|YES -
Allow embedded spaces in CTM variables. Default is OFF|NO - Do not allow embedded spaces in CTM
variables.

02608301 (526024)

Micro Focus Directory Server

Back to the list

• When starting or stopping an enterprise server region using MFDS or the ESCWA user interface, the
casstart and casstop /m parameter would use the MFDS IP address rather than the host name,
which could result in an issue if TLS certificates were used that required a particular host name.

02603383 (505074)
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• An issue introduced Patch Update 1 resulted in ESCWA not listing all enterprise server regions for
legacy import if they contained script data and the MF Directory Server was not sufficiently authorized
to import script data.

(636060)
• The Micro Focus Directory Server (MFDS) Start on System Start enterprise server region option on

the ESCWA General Properties page was not working because the Automated Execution Control
Enterprise Server Credentials were not being applied correctly.

02795649 (652065)
• When exporting enterprise server regions registered in the MF Directory Server using XML format,

regions for which the user did not have read/write access could also be exported.

(526005)
• Issues existed with importing enterprise server regions saved in JSON, XML, and Legacy format into a

MF Directory Server, which resulted in incorrect listener states and counts.

(559058)
• You can now control the execution and update permission for an enterprise server region's start and

stop, and on unrespondent scripts, by using a new LDAP Enterprise Server Administration security
resource class Scripts entity. If this security resource entity has been specified with appropriate access
control entries, the MFDS session will require Update permission in order for the authorized user to
modify a region s script or to enable or disable it. In addition, for a script to execute, then you must
specify Execute permission. See Class - Enterprise Server Administration in your product Help for more
information.

Note: This is not a region restriction, but applies to the MFDS instance where the region is
specified. If no security or MFDS Internal Security is configured for use then region scripts will not
be executed nor will they be able to be modified. The Scripts resource is not a security resource
created by default. It can be created by the ESCWA interface or other LDAP administration
configuration tools.

Important: In future product versions, the access control that uses the Scripts security resource
will be a requirement in order for any region s scripts to be executed or modified.

02822038 (499063)
• The default UI Session Timeout value for MF Directory Servers has changed from -1 (no timeout) to

600 seconds (10 minutes). The default value for the MF Directory Server API Session Timeout has
been reduced from 3600 seconds (an hour) to 1200 seconds (20 minutes).

(628068)

PL/I Support

Back to the list

• In -noopt mode, the Open PL/I compiler failed to short circuit IF comparisons involving the NOT prefix
operator. This has been corrected.

(567011)
• Running CONTROLLED storage in a PL/I CICS program required that Force Phase-In be enabled to

prevent a SIGSEGV upon the second invocation of the PL/I Program. This has been corrected.

02260472 (258078)
• The Open PL/I compiler erroneously allowed OFFSETVALUE(POINTER)), namely

offsetvalue(sysnull()). The correct usage is: offsetvalue(binarvalue(sysnull())).

(386070)
• The precision of floating point arithmetic on x86 RedHat has been decreased from 63 to 52 to match

mainframe behavior.

(506106)

Significant Changes in Behavior or Usage | 25



• The data type for the Signal1 field in the MQGMO structure (cmqp.inc) has been changed from: 3
Signal1 fixed bin(31) bigendian init(0) to 3 Signal1 pointer init(null()). This
data type change maintains a proper byte alignment in both 32- and 64-bit environments and better
aligns with the same field/structure on the mainframe.

02746362 (632026)
• A problem that prevented the EZASOKET interface from correctly interpreting when the caller was PL/I

has been fixed.

02851309 (681021)
• A problem that occurred when using the Windows API SetEnvironmentVariableA() to set an

environment variable in a language other than PL/I caused the PL/I GETENV() built-in function return an
incorrect modified environment variable value.

02605819 (505140)

Run-Time System

Back to the list

• The Java/COBOL application launcher - cobjrun - now supports Java command-line argument files.
See https://docs.oracle.com/en/java/javase/17/docs/specs/man/java.html#java-command-line-argument-
files for details on how these files should be constructed.

02744842 (636023)
• AIX 7.3 only: a dependence on Open XL C to create COBOL executables or shared objects has been

removed.

02674547 (565031)

SQL: Mainframe Batch Database Tools

Back to the list

• An error that occurred in SQLUTB UNLOAD when the specified size of an LRECL was less than
required for the row size has been fixed. The LRECL is now adjusted to accommodate the actual row
size.

02445817 (612038)
• A problem with unloading GRAPHIC data using DSNTIAUL has been fixed.

02677441 (550046)
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Known Issues
Refer to the Known Issues and Restrictions topic in the Product Information section of your product Help.

In addition, note the following:

• JVM COBOL applications that run on AIX7.3 using Java versions 21.0.1 or 21.0.2 (IBM Semeru
Runtime Open Edition) show intermittent errors in the Java runtime (‘java.lang.SecurityException:
SHA-256 digest error’) resulting in the application not running as expected. The product .jar files are
signed.

• The information available from Help > Help Contents in the new Data Tools client is out-of-date. For an
up-to-date information for the utility, check the Enterprise Developer or Enterprise Server product Help
hosted on the Enterprise Developer documentation pages.

• In Enterprise Developer 4.0 and 5.0 in an extremely small and limited set of cases, an issue could occur
with running .NET executables and .dll files, or JVM .class files, created with an earlier version of the
product. This issue only occurred if:

1. The application performs an IS NUMERIC condition test on a variable declared with USAGE
NATIONAL.

2. The application has been created with Enterprise Developer 3.0 or earlier, then executed in
Enterprise Developer 4.0 or 5.0.

In these rare cases, the IS NUMERIC test could provide the wrong answer.

In order to resolve this issue, in Enterprise Developer 6.0 and later, the .NET COBOL and JVM COBOL
run-times reject any program using IS NUMERIC on a NATIONAL item which was compiled with a
version 5.0 or earlier of the product. You receive a "missing method" exception. To resolve the issue,
you need to recompile any programs that use this construct in the newer versions of Enterprise
Developer.

Program that do not use NATIONAL data, or those that have been recompiled in Enterprise Developer
6.0 or later are not affected.

• The ChangeMan Attachment models of release 5.0 and earlier are not working in the expected manner
under Enterprise Developer 8.0 or later. This is a result of several tools that are called with a static
value=`*` in the input parameter CMG_PROP_STATIC_SUBSYSTEM. If you want to run a ChangeMan
attachment model 5.0 and earlier under the current version of Enterprise Developer, you must remove
the static value=`*` from all CMG_PROP_STATIC_SUBSYSTEM input parameters.
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Resolved Issues
This section describes resolved issues in this release that resulted in product enhancements, and those
that resulted in product fixes.

• Resolved Issues - Enhancements
• Resolved Issues - Fixes

Resolved Issues - Enhancements

Back to the list

The numbers that follow each issue are the Support Incident Numbers followed by the Defect number (in
parentheses).

• Application Workflow Manager
• Compiler
• Eclipse IDE
• Enterprise Server
• File Handling
• IMS Support
• Interface Mapping Toolkit
• JCL Support
• Micro Focus Batch Scheduler Integration
• Micro Focus Common Client
• Micro Focus Cryptographic Library
• PL/I Support
• SQL: Mainframe Batch Database Tools

Application Workflow Manager

Back to the list

• AWM has been updated to submit JCL for files which are not in projects. See Submit To Enterprise
Server in your product Help for more information.

(562044)
• Two new attributes, Key Binding and Key Binding Context, have been added to the Global Action Item.

These new attributes overwrite those defined in the action description. Using these attributes, an action
description can be referenced in multiple global actions with different key bindings and/or key binding
context. See Global Action in your product Help for more information.

02549368 (454049)

Compiler

Back to the list

• For the processing of XML GENERATE, JSON GENERATE, and JSON PARSE statements, data names
with a leading # character are now treated as though the character was not present. This ensures valid
XML and JSON documents are maintained.

(529106)
• Under the MF dialect, you can now use the FREE statement to directly free memory allocated via the

ALLOCATE statement, by using FREE ADDRESS OF data-name. This negates the need to specify a
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returning pointer during allocation (i.e. ALLOCATE data-name RETURNING my-pointer) and then
freeing the pointer.

(528109)
• A new directive, INC-FORMAT"format", where format can be either MAINFRAME or PC, has been

provided to configure the interpretation of periods in --INC and ++INCLUDE names. The long-standing
and default behavior of INC-FORMAT"PC" treats a period as indicating a PC extension, whereas INC-
FORMAT"MAINFRAME" treats it as part of a mainframe superset.subset format.

Note: For the PC setting, an extension from the COPYEXT extension list is not applied when
processed, but it is with the MAINFRAME setting.

02658223 (543045)

Eclipse IDE

Back to the list

• An enhancement has been made to pre/post build events that will monitor the output generated from
any script run, and if an error message is displayed in the required format, then this will be processed in
the IDE and error markers places against the appropriate source file. Also, if the executed script returns
a non-zero exit code, then this will also be handled correctly in the build console output. See Pre- and
post-build processing events in the product documentation for more details.

02651165 (542091)
• A new preference has been added to the clean up preferences profile - Identifier case style. This

enables you to specify your preferences for the case style of the COBOL identifiers (lowercase,
uppercase, or no preference).

(505043)
• Improvements have been made regarding Micro Focus Directory Server (MFDS) creation required when

creating new remote projects, specifically to ensure that a unique name is used if another MFDS
already exists.

02577154 (559012)
• Improvements have been made internally to the storing of server-specific settings when working in

Server Explorer.

(630043)
• When debugging in Eclipse, a new error message has been added to the Expressions view for

expressions that contain indexed tables with invalid indexes.

02596514 (517042)

Enterprise Server

Back to the list

• ESCWA API: Additional filters, output fields, and pagination have been added to the catalog filter
module. Pagination is implemented consistently with the pagination in the spool filter module. If the new
required input parameters for the filter/paging are not supplied by a client, the filter module falls back on
old behavior to maintain backwards compatibility.

02569749 02527126 (469038, 527019)
• The following ESCWA API enhancements have been implemented:

• A new group property has been added to all active CICS resource types, and is now returned by all
active CICS resource listing and details APIs.

• For the FCT details page, an additional field remoteSysId has been added, which will be populated
for remote FCT entries.

• The ability to filter on group name by supplying a groupFilter parameter for all CICS resource listing
modules, with the following exceptions:

Resolved Issues | 29



• The group list, startup list, and SIT pages.
• The ACEE list page.

• New input parameters startIndex and recordCount and new output parameters nextIndex and
recordCount which can be used for pagination and are the same as the catalog and spool filter APIs.
These parameters have been added to every resource listing page with the exception of the startup
list and SIT pages.

• The resource name filtering and max display rules for the active XAT and RNL list has now been
added in addition to the above group filtering and pagination rules.

02602397 02638879 (505063)
• In ESCWA, the Catalog entry APIs that return DCB information now indicate if a VSAM organized data

set is marked as reusable.

(657064)
• When a DEQ fails in a PAC environment, a new message KC2000S will be displayed in the

console.log with the QNAME and RNAME of the resource that failed to DEQ.

02659029 (542115)
• Enterprise Server now avoids unnecessary calls to Redis when not required. When an internal reader

with disposition of MOD is created, installed, opened, or closed, Redis is no longer updated.

02600888 (504037)
• You can now archive the auxiliary trace file by setting the archive_auxiliary_trace property to

true. You can set this property in the Enterprise Server Common Web Administration (ESCWA)
interface on the Advanced Region Properties page. See Auxiliary Trace in your product Help for more
information.

(425091)
• In ESCWA on the JES Spool page, new column filters have been added. These column filters only act

on the rows of the current displayed page. In addition, an informational message is displayed when
using these column filters.

02503185 (440037)
• In ESCWA on both the JES Spool and Catalog DD Entry pages, a Download button has been added.

The download button has Download First and Download Current options. Download First will
attempt to download as much of the first page permitted by the Advanced Region Properties page or
environment variable ES_ESMAC_DISP_MAX_OVERRIDE. Download Current will download only
what is displayed on the current page in ESCWA.

02801646 (651120)
• In ESCWA, when viewing the content of the catalog file you can now check the Reversed paging check

box to view in reverse order.

02644140 (658137)
• In ESCWA, validation has been added to file path inputs to ensure they do not contain leading or tailing

white space characters.

02513150 (446067)
• In ESCWA, on the Spool list page, the Cancel button has been relabeled to Continue on the Cancel

Job? dialog box.

(565037)
• Exporting an enterprise server region as a JSON file will now be formatted.

02818032 (510031)
• Two new audit event codes have been added, 5 10 and 2 21. See Audit Event Codes in your product

Help for more information.

02809915 (658081)
• The Reusable File field has been added to the ESCWA dataset DCB entries that have a DS Org set to

VSAM.
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02816286 (658085)
• In ESCWA, the Password Change Enabled check box has been added to the Security Settings page.

Checking this enables you to change a users password when they log on.

02589857 (498029)
• In ESCWA, a new Active XA Resources widget has been added to the dashboard. See Dashboard in

your product Help for more information.

02621260 (517076)
• Improvements have been made for viewing the content of larger catalog and spool files in ESCWA:

• Improved performance viewing fixed record length files.
• Increased the maximum number of pages from 99999 to 99999999.
• Viewing a file with details enabled correctly displays record numbers up to 10 digits and will include

the total record count, if known.

(656126)
• In ESCWA, you can now remove locks for enterprise server regions that are part of a Performance and

Availability Cluster (PAC). You need to be able to stop an enterprise server region in order to remove
locks. The OPERCMDS(CASSTOP) resource will be checked.

Caution: Incorrectly removing locks can result in system instability and corruption or loss of
data.You can contact Micro Focus Customer Support for more information and guidance on
removing locks.

02659029 02869605 (545043)
• The casverify utility has been improved with a new verification stage to check connectivity to Scale

Out Repositories (SOR) and key records for Performance and Availability Clusters (PAC) enabled
enterprise server regions.

(549010)
• The casverify utility has been improved with new external security manager checks against

configured default users and provided user credentials. Also, step names have became more concise,
which might affect scripts consuming casverify output.

(609033)
• A new CICS transaction has been provided, CDMT which can execute a INQUIRE, DISCARD, or

NEWCOPY command against a DOCTEMPLATE. See the CDMT - Document Template Master
Transaction topic in your product Help for more information. In addition, if a delimiter was specified in
the first byte of a SYMBOLLIST on a DOCUMENT CREATE command then SYMBOLERR was
returned, which was different to mainframe behavior.

02728038 (639003)
• casstart has been updated with the new /J:SYSIDNT=xxxx parameter, which enables you to override

the SYSID of a region.

02635287 (528087)
• The Enterprise Server External Security Facility now has options to fold userids (usernames) and

passwords to upper or lower case, which might be useful when migrating from the mainframe where
uppercase is typically used. See the options userid case, username case, and password case in the
Security Configuration Custom Configuration Information topic in your product Help for more
information.

02570661 (454048)
• If the Micro Focus Common Client (MFCC) attempts to bind to an MFDS directory using configured

credentials, and the credentials are rejected, it will retry the bind anonymously. This emulates the
behavior of older product releases and is not a security weakness since it will only succeed against
non-secured directories.

(673053)
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• The password-expiration heuristic mechanism (expiration-check configuration setting) of the MLDAP
ESM Module has been enhanced to improve accuracy under a number of conditions with various LDAP
servers. Micro Focus recommends that customers using LDAP-based security for Enterprise Server
with bind-mode user verification enable this setting as it results in more precise and accurate return
codes from ESF Verify (user authentication) operations. See MLDAP ESM Module Bind Rejection
Heuristics in your product Help for more information.

02547852 (472036)
• The expiration-check option of the MLDAP ESM Module now supports checking for the commonly-

used LDAP user attributes passwordExpirationTime and pwdChangedAt, when attempting to determine
whether a user bind was rejected due to an expired password. This improves the accuracy of the error
codes returned when using LDAP-based security with bind-mode user verification.

02520274 (411002)
• When switching between enterprise server regions, you will now be directed to CICS resources, spool,

and catalog top-level pages if you were previously on any of the subpages. This is intended as a user
experience improvement, preventing navigation to a resource that does not exist in the newly selected
region.

02554044 (440040)
• Pseudo Wait-For-Input (P-WFI) dispatch behavior has been added to the IMS Control page in ESCWA.

When enabled, the MPR stays scheduled until another input message is received.

(450048)
• Added pagination and group filtering (with exceptions of ACEE, RNL, ICE) and the Remote SysID field

to the CICS active FCT resource page. See Active FCT in your product Help for more information.

(530032)
• A new filter option for the JES Spool and Catalog that enables loading them on navigation has been

added.

02725006 (624004)
• The DFHWBEP is now mainframe compatible. A new version of copybook DFHWBEPO is now

supplied.

02839200 (673009)

File Handling

Back to the list

• SORT: SYMNAMES symbols can now use semicolons, as well as commas, to separate symbols names
from values. Previously, commas were the only valid separator supported. WITH clause SYMNAMES
substitution has also been enhanced so that symbols declared with a position, length and character
format can be substituted into a WITH clause.

02636502 (586010)
• An enhancement has been made to SORT operations to allow the WITH clause, which is a parameter

for the ICETOOL SPLICE operator, to support SYMNAME symbol substitution. Previously, a parsing
error occurred if SYMNAME symbols were used.

02636502 (526079)
• For SORT operations, the LENGTH operand is now supported when no mask is specified.

02667112 (544076)
• SORT: OUTFILE can now be used in place of OUTFIL as a valid keyword when writing SORT

programs.

02606155 (504146)
• SORT: MFSORT and MFJSORT SUM processing has been enhanced to support 31-digit Zoned

Decimal values. Previously, attempting to perform arithmetic with Zoned Decimal values larger than 18
digits would produce the Field length exceeds maximum allowed error message.
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02538998 (429076)

Interface Mapping Toolkit

Back to the list

• COBOL clients now correctly format an x-www-form-urlencoded JSON request body.

02495086 (402050)
• The generated COBOL Web service client proxy program now keeps the communication session open

for the duration of potentially multiple service-invocation calls.

02441897 (385004)

IMS Support

Back to the list

• The ES_IMS_OTMA_DEST environment variable has been updated to enable you to specify two new
types of destination: IMS Connect (IMSCON) and MQ-Bridge (MQ). With these types, you can specify
one or more asterisks to represent a series of multiple destinations. For example, an LTERM-name of
TERM*** creates 1000 LTERM destinations named TERM000 through TERM999. Use this method to
avoid defining each destination separately. For details, see the ES_IMS_OTMA_DEST entry in IMS
Environment Variables in your product Help.

02396717 (354001)

JCL Support

Back to the list

• The MERGESPL utility has been updated to support the separation of spool files into different folders
when archives are merged. Specify folders using new options for the MERGESPL.JCL file. For details,
see Running the Process to Merge Archived Spool Files in your product Help.

02518347 (406181)

Micro Focus Batch Scheduler Integration

Back to the list

• The new JCLTEMP_DIR environment variable, which can be set as an environment variable in
Enterprise Server or in the mfbsi.cfg file, enables you to specify a separate location for the JCLTEMP
directory. When not specified, the JCLTEMP directory defaults to MFBSI_DIR.

02764951 (638116)
• Asyncronhous MFBSI submission is now supported via the new MFBSISUB-ONLY parameter, which

you can use on the command line or add to the mfbsi.cfg file. For details, see The MFBSI Configuration
File and MFBSIJCL Command Line Parameters topics in your online Help.

02664714 (544066)

Micro Focus Common Client

Back to the list

• When the Micro Focus Common Client (MFCC) needs to use MFDS to find the location of a service, it
now by default tries to use the readonly account configured as part of the default Enterprise Server
security to bind to MFDS. This is enabled through the mf-client.dat configuration file, and can be
changed after installation. The effect of this change is that functions such as listing deployment listeners
with the imtkmake command will typically work in a fresh product installation with no further
configuration changes required.
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(656131)

Micro Focus Cryptographic Library

Back to the list

• The TLS Certificate Checking Utility is a new executable that can be used to help diagnose problems
with TLS certificates. It can check the validity of certificates, verify certificate chains, check that
certificates and private keys match and check that a certificate contains a SAN that matches a provided
hostname/address. It improves TLS usability by diagnosing TLS certificate problems.

(666106)

PL/I Support

Back to the list

• A problem calculating the result length of the STRING built-in when applied to non-connected storage
has been fixed.

02514231 (406150)
• The ALLOCATION built-in now returns a fixed bin (31) value; in previous releases it returned a fixed bin

(15) value.

(484003)

SQL: Mainframe Batch Database Tools

Back to the list

• The out-of-order syntax of UNLDDN is now supported in SQLUTBA. In addition, a problem using
TEMPLATE in SQLUTB UNLOAD when the template contained no symbolic variables has been fixed.

02445817 02445913 (387038)
• SQLTUL has been updated to support common table expressions as SELECT statements.

02600608 (506085)

Resolved Issues - Fixes

Back to the list

The numbers that follow each issue are the Support Case Numbers followed by the Issue number (in
parentheses).

• Application Workflow Manager
• AppMaster Builder
• CICS Support
• Common Communications Interface
• Communications Server
• Compiler
• Data Tools
• Debugger
• Documentation
• Eclipse IDE
• Enterprise Server
• Enterprise Server Auditing
• File Handling
• Host Access for the Cloud
• IMS Support
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• Interface Mapping Toolkit
• JCL Support
• Mainframe Access
• Mainframe Batch Scheduler Integration
• MFUnit Testing Framework
• Micro Focus Directory Server
• Micro Focus License Administration
• PL/I Support
• Run-Time System
• SQL Option for DB2
• SQL: COBSQL
• SQL: SQL for DB2 LUW
• SQL: Mainframe Batch Database Tools
• SQL: HCO for SQL Server
• SQL: OpenESQL
• XML Support

Application Workflow Manager

Back to the list

• Copybooks are now resolved in a remote edit scenario for Enterprise Developer (UNIX).

(460007)
• Copying sections between action descriptors did not update the tool sequence number correctly.

02552492 (440026)

AppMaster Builder

Back to the list

• A logic issue has been corrected and a new message and error status added which checks whether a
Report process had encountered errors.  Also, output in the Jobqueue file has been updated to ensure
the PRINTUTL file shows any errors correctly.

02794940 (653084)

CICS Support

Back to the list

• The BMS compiler no longer throws an error when a field is positioned in column 0.

02868255 (684130)
• A problem that prevented BMS directives from being discovered as common directives has been fixed.

(544018)

Common Communications Interface

Back to the list

• MRPI clients no longer experience high CPU usage when trying to contact a TLS enabled Micro Focus
Directory Server (MFDS).

(474026)
• The CreateDemoCA script will now error with an informational message if the target directory does not

exist.

(679011)
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• Memory leaks occurred on outbound connections.

(632064)

Communications Server

Back to the list

• In ESCWA, non-ASCII characters would corrupt an enterprise server region s console log. This was a
result of MFCS failing to respect the MFACCCGI_CHARSET environment variable.

(486021)
• The SELECT and SELECTEX functions of the Enterprise Server EZ Sockets API might, in some cases,

operate on the wrong file descriptors on Linux platforms. This would result in incorrect behavior of EZ
Sockets applications. In particular, this might cause high CPU use or failure to accept incoming
connections in the CICS sockets listener transaction CSKL, or programs using a similar design. This
issue was introduced in 6.0 PU17, 7.0 PU7, and 8.0.

(409093)
• The Micro Focus Communications Server (MFCS) could exit prematurely if processing was blocked for

a significant period of time. For example, due to problems processing security requests. When MFCS
reaches its limit on the number of task-processing threads it can create, it will wait for one of those
threads to become available and then continue processing work.

02541097 (424021)
• In rare instances, an application performing an EZ Sockets TAKESOCKET operation under Enterprise

Server could cause EZ Sockets errors in the task which had performed the corresponding
GIVESOCKET, resulting in the application prematurely terminating.

02854684 02761057 02856905 (679026)
• The MFCS Remote File Access (RFA) conversation type now implements origin validation, a defense-

in-depth measure against Cross-Site Request Forgery. See Remote File Access conversation type in
your product Help for information on configuring this feature.

(647045)
• CCI TLS tracing configuration was overwritten when running under MFCS.

(675095)
• MFCS no longer logs the information conversation closed during initial receive message by default. You

can enable this logging by adding the following configuration to your mf-server.dat file, the
enterprise server region's Configuration Information field, or the Custom Configuration field for the
Communications Server Properties: [logging]closed during initial receive=yes

(478029)
• The Micro Focus Communications Server (MFCS) process is now stricter about terminating if it

encounters problems during initialization, especially when initializing security.

(613094)
• Additional guidance has been provided for the Conversation Filtering feature of Enterprise Server, with

regard to default rules such as deny:**. See Conversation Filtering in your product Help for more
information.

02528423 (415106)
• Micro Focus Demo CA on Windows no longer creates Registry keys identifying its installation directory.

Therefore, MFCS and MFCC now use the environment variable COBSSL as the default directory for
certificate and key files, if those are specified with relative paths. If COBSSL is not set, MFCS and
MFCC will look to see if COBDIR is set and if so, whether there is a directory named DemoCA under it.
If this also fails, they default to C:\ (Windows) or / (UNIX).

(469048)

36 | Resolved Issues



Compiler

Back to the list

• When a program was compiled with PERFORM-TYPE(RM) and TESTCOVER an error could occur.

02810218 (656001)
• 64-bit Windows only. Native code only. When a program used parameterized performs, and passed a

two-byte comp-x item by value in a call statement, the NCG sometimes failed to generate the code and
give an error.

(549015)
• Windows 64-bit generated code only: an issue where a program uses nested programs and

parameterized sections has been fixed.

(587005)
• An error in generated code when the size of perform-frame local variables is large - typically > 32K - has

been fixed.

(529009)
• All platforms except Intel x86 32-bit. For generated code only, an error accessing perform-frame local

variables has been fixed.

(614046)
• An issue that could occur on AIX platforms only, when a perform range was only performed by

PERFORM statements at the end of a perform range, has been fixed.

(628141)
• An issue in generated code, which was applicable to all platforms except Intel x86 32-bit, regarding

perform frame local variables used as actual parameters to an invocation of a parameterized perform,
has been fixed.

(640145)
• Compiling COPY REPLACING syntax with the CP preprocessor, where more than one replacing text

string is a match, is now processed with correct precedence (that is, the earliest specified).

02615125 (515001)
• Compiling a program with the CP preprocessor, that includes DIRECTIVES-IN-COMMENTS, now has

that option fully respected.

02625721 (522038)
• Optimization work has been completed on internal structures for certain sizes of COMP-5 FILLER items

to mitigate against internal limits being broken when there are a large number of these items.

02622866 (522008)
• The CP preprocessor (and hence the COBSQL preprocessor) now correctly processes lines which,

after COPY REPLACING has taken effect, are longer than the specified SOURCEFORMAT setting
allows.

02694883 (569001)
• A COMPUTE statement with an index name operand now compiles and executes as expected.

02616505 (516028)
• Non-unique paragraphs in non-unique sections now compile and execute as expected.

02673302 02709104 (550010)
• Issues with SBCS Kana characters when used in the sequence area have been fixed.

02805785 (653168)
• A source file with a large number of external programs can now be edited normally, without background

syntax checks slowing down and eventually being disabled.

02802818 (657005)
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• Very large programs that exceeded a Compiler system limit and received error message COBCH1674S
Internal dictionary overflow now compile without error.

02744922 (640020)
• A COMP-3 field without decimal places can now be generated by Is2ws as a type-decimal SOAP field

rather than type-integer by adding a nominal trailing V to the PICTURE clause, for example S9(5)V.
This has no effect on the compiled code, but provides a way to emulate the IBM behavior of always
generating type-decimal fields for all COMP-3 items.

02684426 (564011)
• A COBCH808S Maximum number of data items exceeded error no longer occurs for a program

with a very large number of data items, most of which are unreferenced.

02711056 (615041)
• Previously, cobprof was truncating output to 79 columns when +wide was specified, and was not

truncating when +wide was omitted. This is the opposite of the correct behavior, and so has been fixed.

00367108 (13279)
• Programs with a very large number of predominantly unreferenced data items, can now compile without

breaking system limits.

02622364 (519033)
• The INITIALIZE of a reference-modified numeric item now executes as expected.

02757198 (640076)
• The external names of functions and function prototypes are now checked for consistency.

(666084)
• The syntax LENGTH OF variable-length-group used as a reference modification offset now

executes as expected in all scenarios.

02757096 (637070)
• Illegal MOVE statements involving level-88 condition names now correctly receive a syntax error rather

than generating illegal intermediate code.

02787014 (643131)
• Processing of the BASIS control file now correctly differentiates between a BASIS DELETE statement

and a DELETE token that is part of an EXEC SQL statement.

02629601 (526116)
• The INITIALIZE .. TO VALUE statement now works as expected for table value syntax.

02613611 (510045)
• An INITIALIZE ..TO VALUE statement, which refers to multi-value table syntax, now compiles and

executes as expected.

(9332)
• A CALL to the JCL MFJZLPSA routine now works as expected when executed from a program compiled

with a mainframe dialect.

02684738 (564031)
• Within an EVALUATE statement, you now correctly receive a COBCH0334 Cannot follow WHEN

OTHER error if a WHEN clause follows a WHEN OTHER clause.

(516009)
• MOVE statements involving condition names now execute correctly when valid, and are rejected when

invalid.

(652137)
• A program with an incorrect non-unique data name specified as a PROCEDURE DIVISION USING

parameter now has normal IDE functionality available.
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02598892 (498059)
• A floating point intrinsic function with an arithmetic expression as an argument now returns the correct

result when run under a mainframe dialect.

02604585 (514001)
• Defining DYNAMIC LENGTH items in the LINKAGE SECTION, to be used as BY REFERENCE

parameters or RETURNING items, is now supported.

(414197)
• The STATIC keyword is now a context-sensitive word under the ENTCOBOL dialect. (STATIC remains a

reserved word under .NET and JVM COBOL.)

(661032)
• In an overlapping perform range, none of the overlapping sections must contain locally declared

variables, nor must they be parameterized. Such scenarios generate a COBCH2024 error during
compilation.

(675020)
• The syntax PERFORM UNTIL EXIT is now accepted under an Enterprise COBOL dialect, to emulate

the latest mainframe version.

02634009 (525097)
• On Linux platforms running Intel processors, when linking with some C++ libraries, using the ,U

qualifier to the cob -z option, an incorrect message could be produced: cob64: Undefined
symbol(s)        _ZNSs4_Rep20_S_empty_rep_storageE.

02664617 (542072)

Data Tools

Back to the list

• UNC paths were not properly resolved when loading data or structure files.

02819143 (673075)
• There was an issue with deleting multiple records of Line Sequential files simultaneously.

02542533 (425037)
• Previously, records located via the Go To action were not selected in the editor. This is now fixed.

02542696 (427048)
• The Data File Tools Structure view displayed incorrect values for binary data items that were explicitly

defined with a number of storage bytes different to the default.

02649377 (536037)
• When inserting new records, the caret was always positioned at the end of the new record. This is now

fixed.

02542581 (427045)
• In overwrite mode (toggled by Insert key) it was impossible to extend the length of text in fields. This

also applied to functions like Find/Replace. This is now fixed.

02596359 (501005)
• The Class Data File Tools help did not open when selected from the Help menu.

(629083)

Debugger

Back to the list

• An issue has been fixed within the Character Animator, where data item names containing DBCS
characters sometimes could not be queried.

Resolved Issues | 39



02811986 (658028)
• Previously, debugging a CICS application multiple times in the same debug session could occasionally

hang.

02721865 (658029)

Documentation

Back to the list

• Searching the help for special registers now returns the main topic on special register usage.

(612069)
• Details of the CP pre-processors COPYINEXEC directive have been added to the documentation. Use

this directive to determine whether CP treats COPY tokens in an EXEC statement as a COBOL COPY
statement or part of the embedded language syntax.

02729687 (623036)
• The product documentation now clearly indicates which library routines are not supported when running

under CHARSETEBCDIC.

(551013)
• The documentation for the READ statement has been corrected for rule 26 in the General Rules for

Formats 1, 3, 4 and 5 (Sequential, Relative, and Indexed Files) section.

(489027)
• Dynamic length items are no longer restricted items to enclose in a JAVA-SHAREABLE block.

(666196)
• A formatting issue in the Usage Clause syntax diagram has been corrected - the THREAD-POINTER

and typedef-name-1 elements are now showing correctly.

(505117)
• The parameters for library routine CBL_SUBSYTEM have been updated in the product Help.

(386097)
• The documented restriction for the F run-time switch usage within .NET COBOL and JVM COBOL has

been removed.

02720237 (613087)
• The Z run-time switch has been removed from the documentation.

(520009)
• The documentation now includes an additional rule for the DECLARE statement to point out that, unless

explicitly initialized to a value, a DECLAREd item is initially undefined.

(667190)
• A number of reserved and context-sensitive words have been added to the product in support of the

latest ENTCOBOL enhancements; see the Reserved Words Table and Context-sensitive Words Table
topics in the product help for full details.

(666134)
• An additional step has been added to the tutorial Example 1 - COBOL Calling Java Static Method, to

ensure that the working directory is located on the CLASSPATH when running the example on UNIX
platforms.

(553009)
• A typo has been corrected in the parameter definitions of the documented

CBL_GET_PROGRAM_INFO routine.

(517025)
• The documentation has been updated to clarify some potentially undefined behavior when the cobtidy()

function is invoked; see the cobtidy() help topic.
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(637112)
• The documented Byte-stream library routines have now moved to a sub-section under the Files and

Filename Routines section.

(610007)
• The documentation for the CALL statement has been corrected with respect to the LENGTH OF clause,

which can now take a literal value when under the MF dialect.

02182932 (218025)
• The File Handling Performance documentation has been updated to reference the DATACOMPRESS

and KEYCOMPRESS options, which can significantly improve performance.

02737405 (639069)
• The SORT documentation has been updated to include the BUILD synonym that is supported within the

OUTFIL and OUTREC control statements.

02707437 (613023)
• The documented definition of MFFTP_PROCESS_TRAILS_ONGET control variable has been

corrected to state it works in conjunction with LOCSITE (and not LOCSTAT).

02772554 (644097)
• Additional optional security features are available for HTTP and MFBINP conversations, for the Web

Services and J2EE, Web, and Remote File Access conversation types. Listeners can be configured to
require user authentication and/or to restrict access to specific types of requests. See Enhanced
Security for HTTP and MFBINP in your produce Help for more information.

(635054)
• The documentation covering the syntax options required for building the container demonstrations has

been updated to include the hotfix option, when building demonstrations built from a patch update
product.

02590001 (488005)
• Information related to adaptations to be made to the AWM configuration for IBM Developer for System z

RSED has been added to the product Help. See Optional: Adaptations to the IBM Developer for System
z RSED installation for more information.

02754539 (645010)
• The product documentation was missing a product name in the instructions for running a native COBOL

application on a network server.

(550040)
• On UNIX platforms for 10.0, coherence is only supported for 64-bit machines.

(675057)
• The documentation now includes information on how to create a Certificate Authority (CA) trust store

and how to set a password.

02767272 (643023)
• The documentation for message JCLCM0199I has been updated to state that a Little-Endian byte order

applies to Open PL/I programs only.

02592712 (516070)
• The JSON Processing tutorial in the documentation has had a few cosmetic updates.

(666207)
• The documentation has been updated to reference the level 78 item, MFU-GET-FILE, available in

mfunit.cpy, that can be used to call the MFUGETF routine.

(9316)
• The documentation for the PROPERTY clause has been updated to explain how a property is exposed

based on the setting of the ILARRAYPROPERTY directive.

00373023 (13206)
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• The definition of the Redis Cluster configuration variable RD_LUA_LOG has been updated in the
product Help.

(520033)
• Due to the updated version of Eclipse used in the current product, the documented tutorial Compiling a

COBOL Program to JVM Byte Code has been updated.

(665214)

Eclipse IDE

Back to the list

• While in the SVN perspective, COBOL programs and copybooks can now be successfully opened in the
COBOL editor.

02517009 (448019)
• The exec block colorization functionality has been restored, and the performance issues that originally

affected it have been addressed.

(489095)
• An issue that may prevent the debugger from connecting to Enterprise Server, when using a remote

Eclipse project with SSH tunneling enabled, has been fixed.

(469002)
• When debugging in Eclipse, the value of an indexed level-88 variable expression is now shown in the

Expressions view.

02614691 (509046)
• An issue where breakpoints in JVM COBOL were not always bound when debugging has been fixed.

02406432 (400036)
• When debugging in Eclipse, you can now set a conditional breakpoint expression using the following

operators: <,<=,>,>=.

02178115 (401141)
• An issue has been fixed where an indexed fields value was incorrect in Variables view if there were

COPY statements in the program when debugging a JVM COBOL program.

02028149 (562040)
• On Linux platforms, an issue in the container helper script has been resolved, which was preventing

multiple .car files from being deployed.

02534654 (477016)
• A fault was discovered where building multi-program source files from the IDE on Windows would not

always generate the expected artifacts (specifically, .obj files). This has been fixed so that all expected
artifacts are now generated.

(536033)
• With default security enabled for a local enterprise server, the sign-on process from Eclipses Server

Explorer has a slight change of behavior: when logging on to a security-enabled server for the first
time, the sign-on dialog box is pre-populated with the default credentials, and it will continue to pre-
populate with these details until they fail or another set of credentials are successfully used.

(674031)
• An issue has been fixed where expressions containing the = operator and indexing variables were not

evaluated correctly when debugging JVM COBOL programs.Additionally, this also fixed an issue when
debugging JVM COBOL programs using logical operators in expressions with COMP variables. Now
their numeric value is used in evaluations instead of their display value. For example, a COMP variable
var1 with a display value 0003+ now uses the value 3 when being evaluated.

(562050)
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• The Variables view now displays all values correctly for indexed fields.

02028149 (344028)
• When debugging and background parsing is disabled, the hover text on index or working storage items

in a copybook for procedural code now works as expected.

02498245 02491752 (401086)
• A memory leak when debugging JVM COBOL was identified and fixed.

02512293 (405108)
• An issue, where the IDE may crash when using remote SAMBA projects that have extraneous /

characters in the file path, has been resolved.

(488090)
• An issue in the background parser that led to the Outline view not showing correctly has been fixed.

02577316 (464041)
• A BMS parser issue was identified where keywords that were split over the end of a line using the

continuation marker were not being correctly handled. This has been resolved.

02624872 (528077)
• When creating an enterprise server region, the 64-bit checkbox is now honored when using a custom

(i.e. non-product-supplied) template.

(615028)
• An issue has been fixed where debug hover in the editor stops working under certain conditions.

(537017)
• If the temporary credentials for the enterprise server security are stored in the vault, they will initially

populate the credentials fields on the Enterprise Server Signon screen.

(664004)
• The following type of message in the build output has been updated to only show when verbose output

is used for linking: [cobollink] Reading additional link objects from:
Program1.objlist

02827465 (665013)
• A potential problem that was generating a null pointer exception during debugging of JVM COBOL has

been fixed.

02498033 (403160)
• The Segment Layout function for IMS databases when using linked location files is now working

correctly.

02694678 (609022)
• A fix has been applied to the editor to ensure that folding block support does not cause exceptions.

(573007)
• When importing an enterprise server region, the run configuration used to perform the import now sets

the CCITCP2_PORT environment variable to the port of the current/selected MFDS.

(487058)
• When creating a new unit test within the IDE, keys and indexes are now correctly created for OCCURS

data items.

(475008)
• A number of code generation errors that occurred when using the Create Unit Test functionality, have

been fixed.

02556886 (452044)
• An issue has been resolved where quick fixes and error squiggles were not getting updated after a

background parse. Also, another issue has been resolved where background parse errors were not
showing a lightbulb icon in the in margin when quick fixes were available.
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(505163)
• When changing a project externally to the IDE, changes to the project settings were not being reloaded.

While it is still not always possible to do this automatically (following a checkout from git for example),
the settings should now be reloaded if the project is manually refreshed (using F5 or the context menu
item on the project).

02574490 (468002)
• An error which was occurring between code refactoring and then a background parse has been fixed.

(545072)
• An issue has been fixed where the wrong number of bytes were shown in the hexadecimal

representation of values for COBOL variables when debugging native COBOL programs.

02802748 (652127)
• When configuring a REST Web service, after moving reusable fields to service interface fields, the

mapping is now validated successfully.

02672664 (551002)
• The horizontal ruler now zooms in and out in conjunction with the editor zoom.

02565757 (484016)
• The wording of the warning dialog message that is shown when debugging a TLS-enabled enterprise

server region fails, has been improved.

02535319 (456002)
• On Linux\UNIX platforms, for PL/I projects that are set to build to a single executable, the Main Program

field is now correctly set (to the built executable file) within the launch configuration.

(150027)
• Labels used in the SSH-only remote connection wizard now render correctly.

(675005)
• Within Server Explorer, the Delete option is only available on the context menu for the following nodes:

ESCWA, MFDS, ES region

(674076)
• The IDE now displays a warning when an existing code coverage file is to be overwritten when

exporting new code coverage data.

(421026)
• The documentation now states the need for superuser privileges if the connection to a development hub

is of type Micro Focus Dev Hub RSE or Micro Focus Dev Hub using SAMBA, NFS, etc. and the
Development Hub has been installed without superuser privileges. For these cases, you must ensure
that the RDO daemon is started with superuser privileges. (The Micro Focus Dev Hub SSH Only and
Micro Focus Dev Hub using SSH connection types are not affected by this; connections made to a
development hub not installed with superuser credentials do not need to supply any additional elevated
credentials.)

(666037)
• The Compile File tool in the Micro Focus Project Function Package has been updated so that it can be

configured to wait for a build to finish before returning control.

00726140 00729304 02475372 (74014)
• Changes to the strict IDY debug behavior (require program symbols (.idy) to match the program option

in a launch configuration), introduced in 9.0, could stop core dump debugging from working correctly if
the .idy file did not match the core file. The option to enable or disable this behavior has been added
to the COBOL Core Dump launch configuration, so that this can be controlled in the same way as for
other launch types.

(549005)

44 | Resolved Issues



• The prompt for ESMAC credentials for an enterprise server region now continues to prompt if you enter
invalid credentials. If you are unable to provide valid credentials, an additional check box (Do not
prompt again until credentials are cleared) has been added to clear the invalid credentials.

02764333 (637100)
• Within Eclipse, when importing an enterprise server region from an XML file, you will be prompted to

select a working directory if the TMP environment variable is not set.

(487059)
• The interface for the COBOL Enterprise Server debug configuration has been redesigned to be more

intuitive. (Its functionality remains unchanged.)

(413169)
• The Get ESCWA Servers function within the Application Workflow Manager now has an additional

(optional) parameter to indicate whether TLS encryption is enabled on a server.

(564010)
• The context-sensitive help links (F1) around managing the CICS resources within Eclipse have been

updated.

(632039)
• When starting or stopping local regions, the stored credentials are verified, and if invalid, you are

prompted to supply a valid set of credentials before the operation will continue.

(658032)
• The Server Explorer view is empty by default for new workspaces. To connect to an ESCWA instance

(including the default one), use the Create new connection option displayed at the top of the view.

(665061)
• Additional context-sensitive (F1) help links have been added throughout the Eclipse IDE.

(636048)

Enterprise Server

Back to the list

• The Mfsecrets AES provider now uses umask when creating directories.

(469050)
• Mfsecrets AES provider will now follow the umask when creating files

(464065)
• mfsecconv no longer returns 115 on UNIX when LANG is incorrectly set.

(645020)
• Micro Focus Common Client connections to MFDS could leak a UDP socket.

(667038)
• The MF Directory Server port value was not being appended to the reported MF Directory Server

address when MFDS_DNS_RESOLVE=Y was set.

02674657 (612044)
• The Privacy Enhanced Mail file CARootCerts.pem has been updated.

(244065)
• On Ubuntu, running CreateDemoCA.sh, CreateNewUserCerts.sh, or RevokeCertificate.sh

would not produce the required certificates and would fail with a script syntax issue.

(468007)
• In ESCWA, when applying changes to JES and CICS pages for enterprise server regions that used

non-default charsets such as Shift-JIS, would result in corrupted text.

02592929 (489047)
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• In ESCWA, JES Catalog datasets with expiration dates where intermittently hidden if the expiration date
was not specified in the filter. This is now fixed.

02694872 (569010)
• ESCWA interactive API library request body documentation has been corrected for pipeline related

endpoints.

(485045)
• Success message from CAS is now checked to return a success. Any message different to the

successful cancel will now be interpreted as an error and ESCWA will notify as such.

(567043)
• ESCWA would crash when deleting a package or handler along with its associated service.

02594214 (489082)
• In ESCWA, the back button on the Spool DD display and edit pages will now open the DD Entries tab

instead of the General page.

02720808 (619001)
• ESCWA now accepts fully qualified domain names for its bind address.

02493351 (450067)
• ESCWA will now return a unique message if the user if user has been revoked.

02808236 02862909 (651201)
• In ESCWA, on the Services page you can now delete parent services and associated packages in a

single action.

02591547 (489045)
• In ESCWA and version 2 of its API, the DCT recoverable fields did perform correctly.

(561042)
• In ESCWA, an error would occur if non-ASCII characters were sent to ESMAC.

02729629 (625030)
• In ESCWA, the PO/PDS datasets were not loading.

02819576 (658003)
• In ESCWA, the SEPs logs were not displaying.

(652129)
• ESCWA interactive API V2 endpoints failed to operate correctly, including tracing and tn3270Screen.

These have been fixed.

(485029)
• The ESCWA XA Resource page no longer has a notice that it is a technology preview feature.

02534474 (415107)
• ESCWA now allows Catalog Entries with DS Org set to GDG to have empty string to be submitted for

Record Format through the API and it has been hidden by the API

(653208)
• In ESCWA, the documentation for the Web API contained errors that prevented client generation using

OpenAPI. In addition, fields that were missing have been added and security and resource keys have
been removed from version 2 of the API.

Attention: Micro Focus strongly recommends that you no longer use security and resource keys.

 

(453029)
• In ESCWA, jobs on the Spool page can now be opened in a new tab.

02720802 (623006)
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• In ESCWA, returning to a spool job now takes you back to the same tab.

02789771 (649013)
• ESCWA now uses the full vertical height for tables on the JES Catalog, Spool and Job details views.

02720795 (624002)
• In ESCWA, the Spool and Catalog pages both use the List button consistently with the filter options

selected.

02720796 (618001)
• Additional warning messages will occur if a Directory Server only has SOA or an MTO license.

02852965 (684037)
• In ESCWA, the comparison of PAC strings were treated as case sensitive.

02761061 (638085)
• A problem that caused memory for escwa.exe processes to grow without falling back to normal levels

has been fixed.

02735194 (629100)
• In the ESCWA API, /native/v1/regions/{host}/{port} would incorrectly return the

mfCASIMSEnabled property twice.

02785649 (644117)
• In ESCWA, validation has been added to multi-line file path inputs to ensure they do not contain leading

or tailing white space characters.

02513150 (515022)
• The CICS, Sys62, Fully Qualified Partner field length restriction was one character too short.

02642137 (528104)
• In ESCWA, user token fields were treated as invalid if the stored value contained inconsistent

capitalization.

02634935 (545054)
• In ESCWA, you can now remove locks if necessary. Contact Micro Focus Customer Support for more

information and guidance on removing locks. See Locks in your product Help for more information. The
casstop resource entity is checked as part of the OPERCMDS resource class. A user must have Alter
permissions to do this, which are the same permissions required to stop a region.

(651022)
• User authorization is no longer logged by default and can be enabled in the ESCWA interface.

(682002)
• You can now configure ESCWA to audit request bodies. To enable this auditing, check Audit Request

Bodies in Tracing and Logging Settings. This information is recorded in audit event code 5 10. See
Tracing and Logging Settings and Audit Event Codes in your product Help for more information.

02605389 (525006)
• In ESCWA, the Catalog page now provides enhanced filtering and list pagination. See Catalog List in

your product Help for more information.

02616605 (530007)
• esfadmin calls to change the password on VSAM ESM no longer displays an error when it succeeds.

(661094)
• The VSAM ESM Module now correctly handles the case where a class directory exists but does not

contain the Rules.dat and/or ACEs.dat files. If the directory for the class (for example, PHYSFILE)
exists but neither .dat file exists, the class is treated as undefined. If only one of the two .dat files
exists, the request fails with a database error.

(667018)
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• The VSAM ESM Module sometimes incorrectly denied access to resources when it should have
returned an unknown resource condition. This might then result in access being denied when it should
have been granted by another security manager, or left undecided and then denied or allowed by
default.

(651109)
• In earlier releases, the sample LDIF security definitions had incorrect definitions for the DOC*, TCP*,

and URI* resources in the MFESMAC class. This resulted in access failures when attempting to view or
modify those resource types in ESCWA for some administrative users when LDAP-based security was
used and security rules were specified using one of the sample configurations.

(651189)
• The mldap_esm security manager will now load the appropriate threaded/non-threaded version of

libmldap which will result in the correct threaded/non-threaded LDAP library to be loaded.

(273023)
• On AIX, when using VSAM ESM and performing an ESF list resource action against an empty resource

you will no longer receive an error.

(665081)
• When using mfsecconv to export users, the Audit property was not exported correctly. In addition,

when using mfsecconv to convert LDIF to YAML the case of the Mto property for a user was not
correct. These have been fixed.

(665201)
• The name of the default directory for security data used by the Enterprise Server VSAM ESM Module

has changed from es_esm_file_directory to vsam_esm.

(638114)
• The esfadmin command-line utility will now accept an ESM server URL of up to 256 characters in

length. Previously this was limited to 80 characters.

(484061)
• The mfsecconv utility now sets a non-zero exit code if it encounters any serious errors, messages of

error or severe error level are reported. If the new --exit-codes command-line option is specified, it
sets exit code 3 if any severe errors are reported, 2 if any errors are reported, 1 if warnings are
reported, and 0 if only informational messages are generated. This feature will assist in determining
success or failure when running the utility in a script.

(653180)
• The mfsecconv export was creating incorrect YAML.

(652164)
• A number of modifications have been made to diagnostic messages to improve accuracy and relevance

when users attempted to change their passwords under Enterprise Server, when the MLDAP ESM
Module was used with bind-mode authentication.

02547852 (505042)
• An issue existed with the map CN configuration option for the DCAS conversation type.

02528628 (414079)
• If the configuration for a Security Manager using the MLDAP ESM Module explicitly disables Version 1

Authentication (the default behavior), this no longer incorrectly forces DSS wildcard processing to
compatible mode.

02637403 (529091)
• Performing an mfsecconv import of a YAML file containing users with non-literal password verifiers will

no longer cause those users to have an incorrect password.

(666125)
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• In the Early Adopter Program (EAP) release of the VSAM ESM security module, the All-Groups mode
was being ignored under specific federated configurations.

02578575 (517044)
• Enterprise Servers MLDAP ESM Module can now detect the failure to contact an LDAP server for more

types of network failures. Configure the connect timeout setting to permit the module to abandon
hanging connection attempts after a specified time. If the redundant option is enabled for an enterprise
server region (or ESCWA or MFDS) security, a connection timeout will let ESF fail over to another
Security Manager; otherwise, it will let ESF fail the security request after the timeout expires, rather than
hanging indefinitely.

Note: With this change, if a timeout is not configured the module will timeout a connection attempt
after 2147483 seconds, a bit less than 25 days.

02004184 (193042)
• VSAM ESM custom configuration items were not being parsed correctly.

02579768 (473035)
• Under certain configurations the MLDAP ESM Module could fail to authenticate user credentials

correctly, allowing users to sign onto Enterprise Server with incorrect passwords.

02652865 (537022)
• In ESCWA and ESMAC, the ALIAS datasets were not being displayed in the catalog view.

02777645 (644001)
• For security and SYSLOG AUDIT enabled enterprise server region, mfdatatools2 no longer leaves

File Descriptors with Syslog AUDIT permanently opened.

02792367 02806218 02882401 (652220)
• AIX files based on an ESDS file could not be viewed in ESMAC, ESCWA, or CFLE.

02580365 (486019)
• If a Distributed Program Link (DPL) targeting TXSeries resulted in a backout, this was not being

signaled through EIBRESP.

02639307 (628005)
• When attempting to emit the message CASKC0001E Transaction trn abend abcode. Backout

Successful. the CASSI process could trap with an RTS114 error.

02625044 (576015)
• When a distributed program link (DPL) originator executed a SYNCPOINT ROLLBACK the end of task

processing would report an AEXJ abend.

02725418 (633017)
• In a PAC, concurrent operations to close an FCT (via casfile or SET FILE CLOSED) or to install a

NEWCOPY of a CICS program could result in these operations becoming deadlocked due to these
operations waiting for the others to complete.

02674657 02685119 02870114 (588004)
• Previously if an EXEC CICS RECEIVE SET was used and no data was entered on the screen, the

returned pointer was null. This did not match the mainframe behavior. This has been modified to
replicate the mainframe and return a pointer and a length of 0.

02683642 (614118)
• The matching string was incorrectly built.

(297001)
• When casgate processed large volumes of concurrent work, the TCA control block could be left in an

invalid state, resulting in the TCA being disconnected. 

02609989 02612420 02618756 (509036)
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• When performing a caspac -aDump or -aDumpall and the PAC uses a Redis Scale-Out Repository,
the dump file will now include the semaphore data stored under the CasBSI.Sem hash.

02653594 (551001)
• CASOUT requests can hang in server when SEPs are too busy.

02620485 (522007)
• JCL File support for HSF no longer produces message CASTR0001W or system dumps when

processing BMP jobs.

02839752 (669079)
• When a 403 Forbidden was issued, the Web error program DFHWBEP was not called. This has been

fixed

02833723 (665237)
• When using ES_XA_RECONNECT the current transaction was not passed to ES_MQMONEX.

02842758 (674052)
• If an application was compiled with EBCDIC and issued a CICS ENQ on the name of a TD Queue prior

to issuing a SET TDQUEUE, the enterprise server region would take 2 ENQs one in EBCDIC and one
in ASCII.

(609003)
• If an application used BMS paging across an ISC link and the SEND PAGE specified TRANSID, the

target transaction was not being invoked.

02826158 02832686 (665199)
• On a busy system, when multiple ITRs where created the KEY could sometimes be a duplicate,

resulting in loss of an ITR. A unique key is now always created.

02615912 (517014)
• When using DISPLAY upon console, the buffer was truncated on the first x00 value.

02793186 (653054)
• The CICSECM compiler directive would throw an error when using RECEIVE MAP SET.

02693743 (607026)
• Concurrent SET FILE requests were resulting in SEP and enterprise server region crashes.

02629317 (528008)
• When no path was specified for JES or CICS in a Performance and Availability Cluster (PAC)

configuration, then starting an enterprise sever region could result in a crash.

02764245 (638103)
• After a distributed program link had been executed a subsequent TS queue operation could result in a

SYSIDERR.

02826408 (663078)
• The DFHWS-OPERATION container was marked as EBCDIC when the data was ASCII. This occurred

only in a CWS requester application.

02622267 (543059)
• When an enterprise server region was starting in a PAC, it could sometimes rollback an inflight

transaction executing in another region.

02809622 02856124 (657012)
• Whenever trace flags are modified via ESCWA or casutl, a console message is now written to

indicate the trace flags that are currently active.

(499017)
• If a pool thread in the casras process failed to access a record in the PSOR due to an error scenario

that required the thread to reconnect, the thread did not retry to connect. The thread now retries the
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connection 10 times. This can be modified by setting ES_SOR_RETRIES to the required number of
attempts. If the thread still fails to connect then a CASRS2107E console message will be generated.

02815996 02819419 02791959 02870114 (665003)
• The casrdo modules were initializing or handling the cascookie browser cookie incorrectly.

02713518 (589017)
• The QUERY SECURITY API now honors the ES_CLASS_XPCT environment variable.

02585750 02733911 02763327 (505052)
• The ERASE option on a SEND MAP MAPPINGDEV command, issued on the mainframe, was not

honored when the resulting mapped data was used on a SEND TEXT MAPPED command on
Enterprise Server.

02758850 (640111)
• EXCI LINK failed to complete transactions when the timeout was reached.

(506103)
• The FLENGTH operand is now initialized to 0 if the container no longer exists. 

02794254 (652175)
• The ERASE option in the SEND MAP MAPPINGDEV command did not work.

02617389 (529019)
• In an EBCDIC application, the buffer containing a screen generated by SEND MAP MAPPINGDEV was

in ASCII. When the buffer was sent to a terminal using SEND TEXT MAPPED, the screen was
unreadable because SEND TEXT MAPPED assumed the buffer was in EBCDIC and converted it to
ASCII, resulting in data corruption. This has been fixed so that the buffer is generated in the codeset of
the application.

02609390 (519059)
• Files with more than 8 indexes were not being displayed in ESMAC.

(484021)
• When an EXEC CICS GETMAIN was used, the allocated memory was not rounded up to a 16-byte

multiple, as is implemented on the mainframe.

02760574 (637094)
• The Historical Statistical Facility (HSF) CASA_ECI_Function now records the program name when a

PGMIDERR abend occurs.

02406172 (362003)
• New ESMAC sessions did not redirect to the System Sign On page when the default user sign on was

disabled on a secure enterprise server region.

02518847 (415043)
• Intermittent APPC CICS RECEIVE hangs over SYSC Connection when multiple conversations were

started in parallel. This has now been fixed.Use the new environment variable
ES_APPC_RECEIVE_WAIT_FREE_SESSION_TIME to set the number of seconds between 1 and 5 to
wait for the APPC session to be free before been reused.

02492016 02492583 (401124)
• A trap could occur in casmgr depending on the memory layout, because the memory type was not

checked when processing a chain. This has been fixed

02835014 (665257)
• Attempting to set the Group List for an older Enterprise Server SIT (that is, a SIT last modified by a

product older than 7.0 PU10 and 8.0 PU1) resource through ESCWA or legacy ESMAC interface would
not apply and clear the Startup List property.

02682769 (562059)
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• When a job is submitted to an enterprise server region which does not have any initiators configured,
the information is now issued to Redis which prompts other regions (using casmgr) in a Performance
and Availability Cluster (PAC) to pick up the job, if possible.

02573862 (489051)
• Jobs became stuck in the dispatch queue following the initiator being stopped.

02456381 (504075)
• Redis connections could be left open if connections were made from several threads simultaneously.

02615200 02666251 (529104)
• When a process died before responding to the process that issued an RPC wait, the recovery failed to

dispatch the waiting process, resulting in a process hanging.

02671714 (561035)
• Compiling a PL/I CICS GETMAIN statement using INITIMG with a literal would result in an error.

02700510 (590001)
• Invocation of a Tuxedo -hosted program using DPL and specifying a transaction ID was not working.

02538521 02644110 (419027)
• CICS NEWCOPY could fail intermittently depending on the number of enterprise server regions in the

PAC.

02684415 (559060)
• Threshold was not being propagated to the alias transaction when using CWI or CWS.

02780629 (644052)
• The terminator for custom field entries has been changed from # to x00. This is to prevent field entries

from being truncated at #.

02737028 (629069)
• The CASSI1452E console message now correctly reports runtime errors that caused casmfdbfh

initialization to fail.

02703834 (614008)
• On a CICS ENQ command, the ENQBUSY condition resulted in a transaction ABEND. This condition

no longer results in an ABEND, in accordance with the mainframe behavior.

02595856 (495011)
• The Internal Reader queue will now be installed in all enterprise server regions in a PAC, and not only

on the first region starting the PAC.

02669519 02678257 (545089)
• Every time casmgr hard killed a process that was stuck after the threshold issued a kill, a dump was

taken. If someone was formatting the dump at the same time, casmgr would be blocked trying to
access the dump file for up to 10 seconds. A kill is now issued for all the stuck processes and only
perform a single dump at the end.

02814032 (666034)
• If a USERIDERR occurred then the partner did not receive the error message.

02744133 (628170)
• When using CICS START with FROM and _FROM in a PAC enterprise server region, the REQID

generator could result in duplication.

02814032 (656054)
• When a USERIDERR occurred on a start transaction the socket failed to close. This has been fixed

02739278 (629094)
• When the ENOMEM error was reached after the maximum number of sockets were in use, the listener

would not issue the ACCEPT call, resulting in a blocked listener.
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02667973 (613088)
• When creating a resource the name was not being trimmed.

02667449 (542093)
• When sharing the spool between either enterprise server regions in a PAC or outside a PAC, if a JOB

was cancelled in ESCWA from a region that was not running the job then it could result in a spool
deletion of the job but the process running it would not be cancelled.

02690589 (567034)
• Using the SET TRANSACTION API did not publish changes to other enterprise server regions in the

PAC.

02634669 02674657 02712535 (528029)
• A shared memory leak could occur during castrc recovery processing.

02568907 (474022)
• When a shared memory lock produces a dump, the lock is released before opening the dump file, and

the lock is acquired afterwards.

02867469 (683131)
• A deadlock could occur when a job was killed.

02780469 (643040)
• An enterprise server region would fail to start if FUTEX was enabled.

02782113 (643047)
• The casclsec utility failed to receive the userid.

02636579 (526099)
• When a distributed program link passed a large channel, the receiving enterprise server regions buffer

could overflow causing unpredictable behavior.

02600111 (517086)
• HTTP requests exceeding 32 headers to a Web Services and J2EE listener can cause a runtime error

in MFRHCGI. This has been fixed. HTTP requests exceeding 64 headers to a Web Services and J2EE
listener might be rejected with a 400 HTTP response status code with Too many request headers. in the
response body.

02789436 (651069)
• A delay in transaction routing and DPL introduced by the fix for defect 401124 has been fixed.

02656673 02656960 (543009)
• Responses for CICS Web Services where the COBOL structure contained an item defined with the

SEPARATE CHARACTER phrase on the SIGN clause failed with an INVALID_ZONED_DEC conversion
error.

02737879 (636045)
• On Linux platforms, the folder # will no longer be created under /var/mfcobol/es/.

(669063)
• DPL interactions with a Tuxedo CRM server would trap during SL2 exchanges.

02667227 (543087)
• When using RECEIVE SET and the length of the returned area was not > 0, the returned area was not

initialized to low-values as on the mainframe.

02810680 (685039)
• Issuing a program cancel with the no wait option in a PAC, left an orphaned record in the PSOR. This

record is now cleaned up at the end of the command.

02674657 (615074)
• The FILE API response codes were not being propagated back to the remote system.
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02785730 (648026)
• Incorrect auth calls were being made while using the DFED.

02628702 (529011)
• Alter or update privileges for a user are only checked when a user is performing an update action.

02619324 (515072)
• Improved performance when retrieving spool list with casrdja3 and pagination and additional sorting

issue was resolved.

02812222 02814188 02828802 02832820 (658036)
• The code that matches TS queue instances with TSMODEL prefixes did not always return the closest

matching prefix.

(540013)
• An RTS 114 could occur in cascd or casmgr when the connection to the database used by MFDBFH

was lost.

02575775 (486054)
• When using TCP USER protocol, the state of the PCT was not checked.

02749238 (636061)
• The copybook dfhcbtct.cpy has been updated to the latest version.

02821444 (667228)
• The 64-bit Dump Formatter incorrectly formatting trace point 4084 from dfheserv.

02599370 (506047)
• An additional field, advancedFilterEnabled, has been added to the catalog filter API requests to indicate

that the new filtering and pagination capabilities are present.

(529090)
• Improvements have been made to the checks for jobs waiting to be dispatched in an enterprise server

region.

02596825 (503030)
• The console message CASSI9051I was not displayed correctly.

(472003)
• Support for multiple system procedure libraries has been added.

02762877 (639081)
• LRECL was truncated when displaying the catalog dataset properties.

02632597 (528027)
• The referencedFrom and ReferencedTo parameters for the ESCWA catalog filter API were not being

honored.

02660352 (543063)
• A delay in transaction routing and DPL introduced by the fix for defect 401124 has been fixed.

02645065 (526115)
• A double EBCDIC conversion of the DFHEIBLK block occurred when using CICS Web Services and

linking to EBCDIC programs.

02594321 (498031)
• In ESCWA, an error caused uninitialized data to be entered into the file size in some cases where 0

should have been displayed.

02527126 02616594 (509029)
• The number of connected SEPs was truncated when the value was higher than 255.

02640448 (528100)
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• An incorrect warning generated by the EXEC CICS GET CONTAINER API has been fixed, and the rule
file for the FLENGTH parameter has been corrected.

02752469 (638009)
• When using the provided TCPIPSERVICE(HTTPNSSL) from GROUP(DFHWEB), CWBXN would try to

link to a program name only containing spaces as the TCPIPSERVICE had no URM defined.

(645127)
• An application running in transaction routing mode attempting an EXEC CICS INQUIRE TERMINAL

would get a response of TERMIDERR. This has been fixed and the REMOTESYSTEM parameter is
now populated for transaction routed terminals.

02600302 (516027)
• New traces have been added to differentiate between GLM, PAC, or LOCKDB locks.

(651046)
• An RTS 173 could occur in the casverify command-line utility during verification for the ESMQXA XA

switch module.

(662068)
• In ESCWA, the Spool page failed to display jobs when filtered using an asterisk combined with other

characters.

02700563 (588010)
• If a network error occurred in one of the CASRAS threads but not in the PING thread, then the threads

that contained the error would stop processing work.

02653594 02792419 (649048)
• Viewing the system trace table from ESCWA (by selecting Trace X) displayed invalid timestamps in all

trace entries.

(566040)
• When using ES_TN3270_FORCE_ALT, the autoinstall DFHZAI was not using the correct terminal size

values.

02647572 (537044)
• EXEC CIC INVOKING PGM now ignores all programs using call and only considers LINK and XCTL in

the STACK.

02820735 (663046)
• The find option in CEBR did not work correctly. This has been fixed

02803455 (657011)
• If an application performed a READ FILE ... UPDATE and then invoked a DELETE with RIDFLD() where

the RIDFLD was different from that used in the READ, this would fail with an INVREQ.

02806458 (663049)
• When using CRTE, if the executed transaction was creating a channel, that channel was lost after the

CICS return transid.

02580053 (485062)
• If the buffer to display contained an x 00 then the text was truncated.

02861717 (683119)
• When a user not accessible in the OS user database attempted to start an enterprise server region, a

runtime error would occur in cascfg.

02659924 02782387 (543066)
• A memory corruption would occur if a RECEIVE MAP used a buffer, created on a previously RECEIVE

SET API, that was too short. The mainframe obfuscated this issue.

02724286 (629096)
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• Previously, if a Configuration Manager property fails validation, the enterprise server region initialization
would fail with a corresponding CASCF0070E console log error message. Now, in some situations the
property value will be limited and identified by a CASCF0071W console log warning message.

02662199 (622019)
• When using CICS LOAD in the same transaction more than 255 times an abend AEI0 PGMIDERR

would occur. This has been fixed

02810787 (658048)
• When a BMS PAGING transaction, executed remotely, issued a RETURN TRANSID(...), then the

supplied transaction was not invoked.

02826158 02832686 (673120)
• During execution of a remote transaction over an ISC link where the output was paged BMS and

TRANSID was specified on the SEND PAGE RELEASE, the target transaction would not be invoked on
the originator enterprise server region.

02826158 (662074)
• When executing a transaction which used BMS paging the CLEAR key would not terminate the page

browse and would hang processing for the active terminal.

02850987 (680015)
• DPL requests that interacted with Tuxedo CRM would result in a trap in the target during SyncPoint

processing.

02690834 (600001)
• During an INVOKE SERVICE command, the name of the current channel might be incorrectly modified

that is a GET CONTAINER with the CHANNEL option would return CHANNELERR.

02837778 (674022)
• ENDDATA was incorrectly sent when a client using http was disconnected.

02526457 (473050)
• On a busy system with active TRANCLASS, SEPs could hang if they did not receive a response to a

request if some SEPs had died.

02646979 02671418 02751632 02680443 02894969 (547001)
• When an EZASOKET blocking call was made, ITRs where not processed until the EZASOKET call had

returned.

02593074 02596733 (506040)
• In ESMAC, user access to the Server Information page can be restricted using the TABLE* resource

under MFESMAC in LDAP.

00368580 (13547)
• The performance has been improved when checking for FCTs status when first opened.

02660694 (543064)
• When running in a PAC, a RETRIEVE could incorrectly return an IOERR. This would occur if the

transaction was initiated via a START using the TERMID and FROM options and the terminal was
connected to an enterprise server region different to the one processing the transaction executing the
START.

(477002)
• If the dataset was specified in the usercatalog, CAS did not treat the FCT as being accessed correctly.

02764529 (643016)
• A PACs internal reader jobs were not dispatched when using disposition MOD.

02669519 (561052)
• Resource prefixing did not occur for non-default CICS resource classes when the ES_ESM_SECPRFX

environment variable was enabled.
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02674614 (551015)
• The EZASOKET listener was not closing the socket when detecting that the transaction to start was

disabled. This is now fixed.

02728676 (624027)
• The EIBRESP from the remote enterprise server region was not being propagated to the requester

region.

(567053)
• Applications compiled for AMODE issuing GET CONTAINER with SET on containers created by CICS

(typically during CICS Web Services processing) could encounter RTS 205 and/or 203 errors. This was
a result of the address returned to the application on the SET option not being deregistered with the
mainframe pointer manager (MFPM) when the memory was freed. If a later attempt was made to
convert this same address from native to mainframe then MFPM could return an invalid address
resulting in undefined behavior. This has been fixed by ensuring that the address is deregistered.

02625440 (658095)
• When a SEP is killed before it can pick up work, the terminal was not notified resulting in a hung state.

02552505 (464090)
• The SET-TERMINAL performance has been improved. Shared memory is now used for an ENQ from a

LOCKDB enterprise server region instead of using MFDBFH.

02797529 (651059)
• When using an enterprise server region in a PAC, the PPT values for a program were sometimes

corrupted in Redis.

02815591 (663009)
• After closing an FCT, the resource could be in an inconsistent state enterprise server regions in a PAC

because some state changes were not published.

02674657 (628038)
• Authentication checks would fail when the ES_ESM_SECPRFX environment variable was enabled.

02628811 (527015)
• Viewing active Interval Control Elements (ICE) from ESCWA or ESMAC for a TRANCLASS enabled

enterprise server region could unexpectedly fail, or result in a memory access violation in castsc if the
Temporary Storage, Channels and Containers Control (TSC) trace flag was set.

02569568 (508026)
• If a SEP was terminated in the middle of writing to a TS queue, then an infinite loop could be

encountered on all subsequent writes to that queue. This is a result of the queue control record not
being updated. If this does occurs then the first write will retry for a period before returning TIMEDOUT.
All subsequent writes will function as normal.

02625902 (521033)
• In CICS Web Services, where CHAR-VARYING=NO was specified on the generation of the wsbind file,

mapping a string from COBOL with a value of space followed by low-values would produce a SOAP
value filled with spaces. This is inconsistent with the mainframe. The SOAP value will now contain a
single space.

02794739 (653087)
• Stage descriptions and step names in the casverify command-line utility have been updated to be

more consistent and informative.

(662031)
• On the mainframe, IBM inserts the cursor at the top-left corner if a send text does not specify the cursor.

OpenText now implements the same behavior.

02650523 (536031)
• User and group information is now written to Redis after a sign-on and removed after a sign-off. This

enables the user and group ID to be displayed in ESCWA and ESMAC PAC clients.
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(488036)
• On UNIX, Enterprise Server stderr is redirected to /dev/null by default. If you want to redirect it to a

file, set the ES_KEEP_STDERR environment variable to any value. This will create the stderr.PID
file in the workarea.

02855699 (684081)
• When ES_CLASS_XFCT=NO then the security on open files was not checked.

02821126 (661046)
• The CICS Sockets option SMSGSUP=YES suppressed console messages but these were still written to

the defined TD queue. This option now suppresses TD queue messages as well.

02584552 (489091)
• An RTS 173 occurred during the casverify CICS configuration verification when using a database

hosted resource definition folder.

(542074)
• Users were not able to view the list of datasets associated with an enterprise server region.

02813353 02814600 02832796 02832194 (656087)
• If the close of an FCT entry caused more than one FCT to be marked as closed, (that is, there was at

least one alternate index open) an attempt was made to remove the same piece of shared memory
twice, in quick succession. If after the first free, another process was allocated shared memory at the
same address, then the second free would incorrectly de-allocate it.

(651010)
• If a process that was issuing an FCT CLOSE command (via casfile or EXEC CICS SET FILE) were

to exit prior to all SEPs having acknowledged that they had processed the request, the FCT entry would
be left in a CLOSING state. Recovery of the process now ensures that the state of the FCT is rolled
back to OPEN because we cannot guarantee that all SEPs have physically closed the file. In this case,
a new close command needs to be issued to have the FCT marked as CLOSED.

02752016 (578002)
• Paths containing spaces were not correctly handled in enterprise server region configuration when

using the casverify utility.

(550021)
• When calling the GLUE exits XZCOUT, Enterprise Server will now always pass the DFHEIBLK block in

ASCII independent of how the application charset is used when compiled.

02700952 (613085)
• The token creation for the BROWSE CONTAINER commands (STARTBROWSE, GETNEXT, and

ENDBROWSE) did not operate correctly.

(685021)
• A problem that occurred when stopping a region and simultaneously submitting a job caused

MFBSIJCL hang in a loop.

02612304 (536034)
• A CFLE transaction incorrectly set the file to DISABLED when CLOSING.

02852107 (681023)
• Attempting to perform a DPL from TXSeries would fail due to unexpected PIP data included with the

ATTACH.

02622825 02703317 (577002)
• The wait calculation in CICS commands that require acknowledgement from all SEPs in a PAC (FILE

CLOSE, NEWCOPY) could result in large delays between checks on the ITR record in the PSOR. This
has been modified so that the wait time between checks will not exceed 5 seconds.

02752016 (636051)
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• An issue preventing Japanese localization from being displayed on the ESCWA Advanced Region
Properties page has been fixed.

(389049)
• An error is now returned if a castran /v is attempted on a program that has a PPT specified.

(517043)
• Under certain circumstances EXEC CICS RELEASE was not working correctly.

02602571 (528079)
• When using the EXEC CICS INQUIRE TERMINAL API, the userarea and userarea len were not being

returned correctly.

02767317 (644145)
• Displaying fixed record length files with deleted records on ESCWA and legacy ESMAC interface could

have issues with paging and report an incorrect total record count.

(685076)
• The import and export of TST resources now supports Process Local and Exclusive queue types.

02757840 (640174)
• IMS BMPs that exceed their timeout will no longer hang their enterprise server region.

02726493 (624023)
• When using EXEC CICS LINK to a remote enterprise server region with channel, if the channel was

bigger than 32k, the ISC link would fail.

02569844 (485061)
• Transactions were returned in the incorrect charset after an EXEC CICS LINK to a remote program.

02569850 (485060)
• The casverify CICS configuration stage now also checks the developer group for a SITs startup list.

(665230)
• The incorrect length was used on query security when RESTYPE was used.

02852945 (679030)
• Starting a cobesdebug session with type=J2EE would result in a communications timeout error.

02594045 (504155)
• Attempting to dynamically update an XA Resource without a close string could result in an RTS114

within the CASA_Update_XRM service.

(653074)
• In a PAC environment, if a transaction had performed an XA prepare and not performed an XA commit

or XA rollback while a new enterprise server region was starting, the recovery transaction started at the
region start could result in an incorrect recovery of an inflight transaction. The process now checks that
it is a true indoubt transaction rather than an inflight transaction.

02575529 (477030)
• Any nameless steps in preflight modules have now been titled appropriately.

(674050)
• The ESCWA v2 dynamic-config API produced a JSON error when a HTTP PUT request succeeds with

further messages.

(653051)
• SYSIDNT was not retrieved correctly when added to the configuration manager.

02635287 (683088)
• Added option for regular JSON output to the casverify command line utility. See casverify in the

product Help for more information.

(658063)
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• Previously, the environment variable ES_ESM_SECPRFX applied a prefix to all classes. It now only
applies a prefix to CICS classes.

02577210 (469066)
• The embedded template command #INCLUDE is now supported in DOCUMENT APIs.

02728038 (651024)
• When XAID is specified, ISOLEVEL is now set for the dynamic Oracle and DB2 switches.

(472008)
• If the ESXAEXTCFG exit module fails to load when ESLOGGING is enabled in the XA open string, then

a CASKC0025I message will be displayed in the console log.

02725011 (623009)
• The PostgreSQL XA switch module now uses a valid SQL statement to test the current connection.

02721671 (618025)
• The XA recovery transaction failed when using ES_XA_RECONNECT and the connection to the

Resource Module (RM) was lost, the transaction was started too many times which flooded the system.

02532560 (415184)
• XA resource without customization in the XA open string continues to open connection as-is when

Micro Focus Vault support is enabled for other XA resources.

02671497 02675636 02819649 (547042)
• A change has been implemented to exclude testware on the IBM390 architecture in certain scenarios.

(628167)
• CICS Web Service response messages would fail when the response structure contained an Occurs

Depending Item with 0 instances.

02782873 (644122)
• If a container that should have been created by the application was not found, then the error in

DFHJSON-ERROR and DFHJSON-ERRORMSG failed to be returned. This is now fixed.

02801082 (652110)
• mfsecrets no longer displays unhelpful warning about config items not being found in ESCWA logs. 

02543385 (425051)
• If mfsecrets fails to load the config file it now displays a more explicit error.

(662041)
• After performing a successful migrate, mfsecretsadmin will no longer produce an error message

indicating it failed.

(661078)
• In ESCWA, previously the transaction count on the Live Properties page and API was incorrectly tied

to the task number, which would reset when reaching 99999.

(683114)

Enterprise Server Auditing

Back to the list

• An issue occurred at shutdown when using TLS, this could result in socket closure before the peer had
time to complete receiving.

(272016)

File Handling

Back to the list
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• When using FileShare, a warning message is no longer displayed when disconnecting from a telnet
session.

02771996 (638125)
• During a SORT operation, fields are no longer converted to EBCDIC when SORT-EBCDIC is used.

02620554 (519014)
• SYMNAMES defined in a sort card under ICETOOL emulation is now supported.

02636502 (645041)
• During a SORT operation, ZDPRINT now converts positive SIGN-EBCDIC values to printable

characters.

02626521 (521026)
• INCLUDE processing within OUTFIL when using SORT/SIGN EBCDIC has been fixed so that it works

after performing an OUTREC.

02831788 (667043)
• Support for an additional format to use when a symbol is supplied has been added. The new format

overwrites the format used within the symbol.

02636502 (627083)
• A SORT issue has been fixed where a COBRT114 error would sometimes occur when calling SORT

with MJRM CTF tracing enabled.

(629055)
• SORT: E15 exit programs now successfully perform record insertions when paired with SORT

FIELDS=COPY or OPTION COPY statements. Previously, the behavior for E15 record insertion, when
paired with SORT FIELDS=COPY or OPTION COPY statements, was undefined and caused an
RTS114 to occur.

02641771 (526102)
• The 9/139 (Header mismatch) error for cases not previously addressed when using the FTOV field has

been resolved.

02624011 (532030)
• A 9/139 file status no longer occurs when submitting a SORT job with an OUTFIL statement containing

FTOV and HEADER1 parameters.

02522665 (411123)
• ICETOOL data now displays correctly in an enterprise server region set to EBCDIC.

02670585 (542110)
• An issue within a SORT operation, where a COBRT173 error would be displayed when initializing data,

has been fixed.

(640072)
• During a SORT operation, an issue involving SYMNAMES in the INREC/OUTREC processing has been

corrected.

02617277 (504131)
• During a SORT operation, an INCLUDE with PARM=SIGN-EBCDIC now works with non-zero Zoned

Decimal values.

02650386 (539003)
• A problem that caused the return code from MFJTOOL COUNT to be incorrectly overwritten has been

fixed.

02769130 02778992 02779239 (637120)
• For SORT operations, an issue with the ICETOOL RESIZE operator, which caused it to erroneously fail

before resizing occurred, has been fixed.

(651068)
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• SORTCOMPRESS=5 will now correctly compress records that are multiples of the compression limit.

02771702 (644012)
• MFJSORT now works correctly when the SORTIN used is SORTIN02.

02768946 (640183)
• A new environment variable, MFJSDCBOUTFIL, has been introduced. It determines if the LRECL

specified in the DCB for an OUTFIL file is honored during MFJSORT. See MFJSDCBOUTFIL in your
product Help for more information.

02683475 (565003)
• A new index has been added to the RecordLocks tables, to improve performance when accessing busy

files.

02501734 (467002)
• When submitting JCL jobs to a spooler hosted in MFDBFH, a problem where two jobs could be issued

the same job number when the system was under heavy load, has been fixed.

02570363 02599513 (469065)
• When searching on wildcards in a catalog hosted in MFDBFH, sometimes not all matching records

would be returned. This has now been resolved.

02647090 (534024)
• A segmentation fault has been fixed when uploading indexed and sequential files to an SQL Server via

MFDBFH.

02399653 02593176 (364088)
• Handling of stranded locks on region recovery has been improved.

02520632 (409110)
• A number of performance improvements have been made relating to Oracle DBs use of applocks.

02709174 (613045)
• An issue where the MFDBFH cross-region installation scripts would fail to run due to incorrectly

generated statements has been resolved

(645036)
• An issue with deadlocks in MFDBFH has been resolved where we would mistakenly cause a full table

scan, which resulted in TABLOCKs being taken. Indexes have been added to the Filename and Folder
columns of the $DataStore$ table to help prevent this.

02618882 (518002)
• There was an issue where warnings from SQL code execution were reporting a bad file status

incorrectly. This is now fixed.

(526092)
• The fileID has been added as part of an index name, to keep it unique, as previously duplicate index

names were being generated.

(528097)
• The dbfhview utility will now convert ASCII numeric data (that is not of type COMP), that is stored in

Postgres or SQL Server, to human readable values.

02488484 (399076)
• When using MFDBFH with Oracle databases, all required Oracle functions are now installed, if not

already detected.

02687277 (549030)
• When opening a file hosted in MFDBFH that didnt exist but was marked as optional, it was possible for

a deadlock to occur within the Oracle Openfile procedure. This procedure has now been modified to
remove that possibility.

02684956 (567017)
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• If a stored procedure for MSSQL was missing, it would be dynamically installed, but would sometimes
still report an error that it was missing. This error no longer appears.

(559039)
• During a READ operation, the read closest op code now finds the next complete record from the relative

byte address provided.

(387018)
• Invoking an IDCAMS VERIFY on a VSAM ALTERNATEINDEX no longer fails with IO Status 3/9.

02795500 (651032)
• An error displayed in the IDE stating that a project Could not load assembly

MicroFocus.COBOL.FHRedir.dll has been fixed.

(515058)
• The Spool queue is now available to view from ESCWA while it is being written to. (Previously, this was

not possible, as it was locked.)

02633109 (529026)
• A performance enhancement has been made when writing to spool files.

02625933 (499048)
• An issue, where programs that included the following copybooks failed to compile when using the

sourceformat(free) directive, has been fixed:
fsdatab.cpyfsdatabv2.cpyfsviewop.cpyfsviewopv2.cpyxfhfcd3.cpy

(403045)
• An issue has been fixed when initializing File Handling tracing when the mfdas32 command is run.

(675076)

Host Access for the Cloud

Back to the list

• The Windows start script which starts the HACloud session server could fail with a
classNotFoundException.

(544123)

IBM Language Environment for OS/390 & VM Support

Back to the list

• The CEE3PR2 LE mainframe callable service is now supported.

02612970 (550007)

IMS Support

Back to the list

• A stop command for an MPR from ESCWA or casout /t{pid} now commands any scheduled MPP
to exit normally, and stops the MPR. In addition, casout /-{pid} now commands a scheduled MPR
to exit normally, stops the MPR, and starts a new MPR with the same name that services the same
classes.

(389052)
• The default value returned for IMS Connect MOD-name requests is now spaces instead of DFSMO2.

02558109 (451054)
• The /DIS TRAN command output no longer shows a negative ENQCT value in certain situations.

02579450 (473021)
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• A problem that caused an MPR to hang when there was an XA COMMIT failure has been fixed.

02633119 (525043)
• A problem that sometimes caused batch jobs to erroneously remain in active queue after an application

abend has been fixed.

02562178 (479006)
• Response mode transactions that were not the first or only transaction in a chain, did not chain to

another transaction, and did not send a response to the client sometimes caused an abnormal
termination.

02507916 (628060)
• A problem that caused IMS-TM to hang when repairing message-queue corruption has been fixed.

02764276 (651001)
• A problem that prevented the ADDREPL parameter from adding new records and from updating existing

records has been fixed.

02624728 (522049)

Interface Mapping Toolkit

Back to the list

• Web services using very large SOAP messages no longer throw a 153 (subscript out of range) runtime
error.

02778746 (645015)
• COBOL client generation no longer fails due to the presence of escaped XML characters.

02730776 (629048)
• CICS Web Service requestor SOAP messages no longer contain extraneous namespace declarations.

02771747 (644034)
• Top-down generated CICS Web services now correctly handle mixed-content SOAP elements.

02809925 (651214)
• The occurs attribute is now unbounded on service interface fields for COBOL items that have an ODO

clause and that are mapped using default mapping.

02614317 (519020)
• The presence of escaped XML characters sometimes caused COBOL client generation to fail.

02662184 (544055)

JCL Support

Back to the list

• The JCL referback syntax sometimes failed to locate a ddname given a valid *.stepname.ddname
reference. This has been resolved.

02636141 (525058)
• SSTM SEPs share information about the SSTM job for a region. In previous releases, this information

was protected via a lock that was globally visible across a PAC. That lock is now local to the region,
preventing contention with other regions in the PAC.

02782564 (415078)
• The process by which the JES engine accesses the job number of a JCL submission has been updated

to provide a new option that enables enqueuing, which can increase throughput, reduce latency, and
reduce disk/file access. Use the new MF_SPLJNO_LOCK environment variable to enable this
functionality. For details, see MF_SPLJNO_LOCK in your product Help.

02725244 02732144 (623029)
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• Jobs submitted with CLASS identifiers but without an available initiator sometimes blocked jobs that did
have an available initiator. This is now resolved.

02719961 02722059 (619002)
• The TSO LISTCAT processing failed to terminate catalog GN processing when the DSN name differed

from the LISTC entry. This caused LISTC processing to read the entire CATALOG which caused a
performance issue.

02841977 (673016)
• An ERROR 500 - Internal server error sometimes resulted when running JES jobs with CTF

enabled. This is now resolved.

02441415 (380039)
• In the case of a JCLCM0159U error, the file status code will also be displayed.

02684956 (564003)
• The MFCATMNT catalog maintenance utility sometimes erroneously removed datasets with an expiry

date of 000. This is now resolved.

02655445 02671859 (542016)
• A problem that sometimes caused JCLF STAT show the incorrect number of records in the read/write

counts for SORT has been fixed.

02603945 (504093)
• Running LISTC via a TSO operation such as REXX sometimes failed to return the correct records. This

is now resolved.

02704865 (609014)
• When the mfsplcnv utility failed to convert a spool file, no file status or return code was generated.

This has been corrected.

02831037 (665208)
• The IF/THEN/ELSE control within the IDCAMS processing could, in rare circumstances, behave

incorrectly.

02831028 (666041)
• The MFCATNML utility has been updated with a new option, -d, which excludes the processing of on-

disk cataloged spool files.

02811165 (684064)
• A problem related to the allocation of concatenated datasets using the ALLOC statement has been

rectified.

02673460 02676017 (551006)
• A REXX command that writes to a SYSOUT when run in a JCL job would, by default, set a SYSOUT

with 133 characters. If a DD was defined with more than 133 characters, the default sometimes
overrode the length specified within the JES job DD. This is now rectified.

02599095 (517009)
• Multiple SSTM SEPs could be queued to write records to the JOBLOG, potentially blocking the SEPs.

(533054)
• MFFTP was erroneously leaving the enque on a dataset until the end of the job, causing issues when

the FTP was invoked using a REXX script because the PUT command dynamically allocated a file with
the same DDNAME. To correct this, MFFTP now checks whether the DDNAME is already in use, and if
so, generates a new DDNAME. This continues until an unused DDNAME is generated, at which time it
is allocated.

02627598 (529037)
• In this release, alternate indices are correctly added for IDXFORMAT=12 VSAM files.

02756828 (643084)
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• A problem that prevented steps named using an @ character from restarting has been fixed.

02813435 (656053)
• The MF_LEX_API environment variable has been added to allow single or multiple LEX files. For

details, see the MF_LEX_API entry in the Environment variables in alphabetical order topic in your
product Help.

(653230)

Mainframe Access

Back to the list

• Only *.extension is currently supported for MFDAS IMPORT QSAM.

Note: *.* is not supported.

(258147)
• Performing an mfdas delete on a UNIX platform did not perform correctly. This has been fixed: mfdas

delete jes cancels the job. mfdas delete jes purge - cancels the job and deletes the output.

(466001)
• MFDAS PDS FILTER downloads now honor the NOSTRIP flag.

(538009)
• If MFDAS downloaded more than 9K members it would fail because it would run out of handles.

02823515 (681007)
• A regression test failed, resulting in MFDAS Load and Unload functions returning bad xmit.

(306032)
• On UNIX platforms, the MFDAS command FINDMEM failed to return multi-part forms.

(274001)
• The mfdas preserve trailing space option (NOSTRIP) failed to work in all cases.

(532047)
• On UNIX platforms, MFDAS now supports mfsecrets vault credentials using mfsecrets: eyecatcher.

(662012)
• Corrupt PDS directory entries will no longer result in an abend 0C7.

02550202 (499001)
• Support for escaped characters (%nn) was not correctly implemented. This has been fixed and session

data (data set and member names) is now translated to a user code page if specified.

(498001)
• 100-byte passphrases were being truncated when used with MFDAS and Web routes.

Note: Shorter passphrases were not affected.

(487067)
• MFA no longer leaves user data sets allocated after an IEC131I message is issued.

02823515 (674089)
• Mainframe Access (MFA) has been modified to cancel timers for hung sessions.

(638119)
• Occasional abends 0C4 occurring in the Web task after a user LOGOFF will now no longer occur.

(500001)
• Mainframe Access (MFA) will no longer abend 0C4 when a large number of members are imported

using Bulk Member Import(BMI) using the MFA REST API.
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(630091)
• A new member created by the Application Workflow Module will now have ISPF statistics correctly

stored.

02602363 (505061)
• Mainframe Access (MFA) member renames and deletes will now check for RACF UPDATE access, not

ALTER.

02598903 (499055)
• MFA/REST processing has been updated to always clear the member name before writing a HTML

form header.

(479028)
• After a successful IDCAMS function the SYSPRINT output will be wrapped in JSON:{ message:

<IDCAMS SYSTEM... }

(264093)
• The CODEPAGE will no longer be interpreted as a member name.

(525117)
• If the ISPTLIB DD statement in MFATSO needs to be updated the change must be made in the

IVPINIT1 exec. This is because this exec reallocates ISPTLIB and JCL changes will be lost.

02708726 (620014)
• The strupr() function was occasionally abending when the text to be folded was in the last allocated

page.

(468028)
• If maximumRecordCount and inputDataset are both specified it will no longer result in extra records

being sent when importing a job.

(499049)
• Importing an empty VSAM cluster would result in the KeyLength and KeyOffset attributes being

interchanged.

(488063)
• Changeman history requests will no longer result in an 0C4 if using CMN V8R1M0 and the package

does not exist.

(559003)

MFUnit Testing Framework

Back to the list

• An issue with COBOL Language Server failing to locate MFUPD_ and MFUWS_ prefixed files when
compiling with the MFUnit Pre-Processor (mfupp) has been fixed.

(530030)

Micro Focus Batch Scheduler Integration

Back to the list

• MFBSI Control-M has been corrected to no longer truncate * in set statements.

02609269 02625900 02644866 (509037)
• The MFBSI MFBSISEC parameter has been corrected to preserve the original case of the directory.

02601519 (505054)
• Characters \ and ( were not being accepted on the Linux command line for mfbsijcl. This has been

corrected.

(526073)
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• Message JCLSI0100E has been updated to identify just the root cause of the if/else error, giving either
%%IF with the first or second operand missing or null, or %%IF without a valid operator.

02638570 (604002)
• MFBSIEMX has been updated to have a more specific filter for JES File events, reducing the load on

CASTRC.

02576304 02528720 (484001)
• A problem that caused nested %IF-%ELSE in JCL to be processed incorrectly has been fixed.

02638570 (529082)
• The %%IF operand now works correctly with the %%BLANK AutoEdit variable and variables set to %

%BLANK.

02789010 (647015)
• MFBSICTM now correctly ignores values beyond column 71.

02615383 (516011)
• MFBSI Control-M has been corrected to no longer truncate * (asterisk) in set statements.

02609269 (541005)
• Lines skipped by a %%GOTO are now checked for %%IF and %%ENDIF so that the IF level can be

correctly adjusted.

(629074)
• REDIS_TLS has been added as a valid PSOR connection type.

02708712 (614037)

Micro Focus Directory Server

Back to the list

• Creating a new Communications Process could result in a duplication of an existing Communications
Process instance value. This has been fixed. In addition, improvements have been made to enterprise
server region Validate feature which now checks for and fixes duplicate instance values and
Communications Process names that do not match the parent Enterprise Server name.

02627797 (528031)
• The Micro Focus Directory Server (MFDS) could sometimes crash when adding an External Security

Manager (ESM) if no password was supplied.

(446038)
• A TLS-enabled Micro Focus Directory Server (MFDS) would become unresponsive when receiving

requests from MRPI clients.

02552647 (465007)
• Setting Default Process UserID value as a UID rather than userid value caused the MFDS process to

abend when using ESCWA to view enterprise server region data.

02604940 (515077)
• MF Directory Server would fail to start if mfdsacfg.xml options file bind_address value was

numeric rather than containing a valid hostname or IP address in standard format. Older versions of this
file could contain either 127.0.0.1 represented as a 32-bit integer or 0 which represented listen on all
available network adapters. MFDS now accepts either of these numeric address values.

02639711 (529085)
• When creating a Communications Process using the ESCWA API, any input hostname address value

would always be set to *.

02670494 (547019)
• Fileshare server registrations in the MF Directory Server were not being preserved after the Directory

Server was restarted and the Save legacy Micro Focus Servers option was checked.
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02597483 (504062)
• In ESCWA, MFDS did not correctly support a shared memory (smem) listener configuration.

(677003)
• When starting enterprise server regions with ISC listeners, transient internal CCI servers with an

MFNAME: prefix can appear in the MFDS or ESCWA user interface server list. To display these server
types you must check the Show System Server Types option.

(484006)
• Fix issue with security configuration rollback if there was an issue verifying proposed configuration for

MF Directory Server using ESCWA.

(665224)
• For Windows x64-only products, the Micro Focus Directory Server was not determining the correct

directory for Visual COBOL binaries.

(657093)
• XRM openstring values were not saved to the configured vault when importing from a repository into the

MF Directory Server.

(683175)
• In some circumstances, when importing legacy MF Directory Server configuration data the External

Security Manager (ESM) password was not migrated to the Micro Focus Vault Facility correctly.

02574313 (525025)
• The mfActualEndpoint addresses for enterprise server listeners were not being updated or written to

when using an XML file repository.

(495017)

Micro Focus License Administration

Back to the list

• An issue causing the CES daemon to crash has been resolved.

02816509 (617028)

PL/I Support

Back to the list

• A problem with erroneous diagnostics to non-BASED variables referenced with a locator qualifier has
been fixed.

00368488 (12295)
• A problem with initialization of pointer variables to automatic variables of non-constant size in an

INITIAL clause has been fixed.

02750250 (632058)
• A problem that caused a MFPLI00137S: A subscript is out-of-range in this statement message has

been fixed.

02649721 (533057)
• The compiler has been updated to use the noframe_check directive as the default setting rather than

the frame_check directive.

02645530 (531001)
• The PL/I macro preprocessor now correctly handles mismatched quotations while editing with BGP

enabled.

02683112 (618028)
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• A problem that caused the compiler to issue warning MPLI00145W when declaring an SQL BLOB as a
parameter using LIKE has been fixed.

02726759 (624013)
• Passing an aggregate expression to a scalar parameter sometimes incorrectly caused diagnostic

MFPLI2000A (compiler abort). This has been corrected to now produce diagnostic MFPLI00561S.

02606115 (506108)
• A problem caused by the STRING pseudo-variable of a PICTURED item has been fixed.

02683569 (597003)
• A problem that resulted in a Variable may not be initialized when first used warning message has been

fixed.

02846390 (675098)
• A problem passing a STRING built-in as an argument to a CHAR parameter has been fixed.

02804915 (652146)
• The PL/I PLIDUMP report has been extended to support decorated external symbols and variable

names when running under Windows. The variable name, type, and value (if known) are now displayed
for these decorated external types.

Note: If the external variable is not currently being used or accessed in the program that generates
the PLIDUMP report, its type and value is not identified as that information is not not present in the
programs PDB file. The error message displayed for a variable in this category has been amended
to suggest that this is the issue.

02557839 (441078)
• ORDINAL types are now supported with the QUICKSORT built-in function.

(665055)
• In this release, the BIGENDIAN and NONNATIVE attributes are not supported on ORDINAL data items.

(5827)
• The repeat factor is now available for a group of initializers.

02048455 (166052)
• A problem that prevented programs containing label arrays and nested on-units from compiling correctly

has been fixed.

02849276 (680009)
• A problem that occurred when PUT DATA was used for a named constant has been fixed.

02535630 (414124)
• The one-byte limitation on the WIDTH FACTOR for the FORMAT statement has been eliminated.

(543110)
• A problem related to GET DATA of a pictured item has been fixed.

02489694 (399063)
• A problem at compile time with evaluating expressions involving the LENGTH and MAXLENGTH built-in

functions has been fixed.

02453457 02453465 02453476 02453510 (385057)
• An internal error related to a FETCH statement has been fixed.

02758019 (639041)
• When a PAGESIZE for a STREAM PRINT file was exceeded, it triggered the ENDPAGE CONDITION

but did not do a PUT PAGE. This further triggered the ENDPAGE within the ON unit for each
subsequent line write.

02624746 (519021)
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• A problem linking with the cob command on Linux platforms has been fixed.

(540003)
• A problem that stopped the Open PL/I PLISAXA parser from parsing when the

UNKNOWN_CONTENT_REFERENCE event was driven, and which then triggered an EXECEPTION
event with a code of 26 has been corrected.

02552959 (441034)
• A problem passing a STRING built-in as an argument to a CHAR parameter has been fixed.

02818201 (658117)
• When attempting to do a REWRITE of a VSAM record using a BIGENDIAN CHAR VARYING scalar as

the argument to the FROM option, a RECORD condition was sometimes erroneously raised. This has
been corrected.

02544322 (429073)
• MFPLI2000A using an OPEN statement on a non-FILE data type sometimes caused the compiler to

abort.

02633009 (528021)
• A problem that caused excessive slowdown of an enterprise servrer region when SUBSCRIPTRANGE

was set in PL/1 has been corrected.

02669491 (542096)
• A KEY condition was raised erroneously when using a PICTURE variable as an argument to the KEY

option of a READ statement and the PICTURE variable had significant leading zeros. This has been
corrected.

02570726 (459007)
• Correct variable values are now assigned to the outer procedure in a nested procedure that is called

from another nested procedure that is called through an entry variable.

02617285 02619609 (517035)
• A compiler error that was thrown when PL/I array fill assignments ( e.g. x(*) = 0 ) was specified has

been fixed.

02631023 (526010)
• libxml2 shared objects have been removed from the product.

02839971 (670057)
• A problem with initialization of slices of array structure to zero not working has been fixed.

02681309 (561033)
• The 32-bit _MFP_CMP_I8U8R32 runtime routine, used to compare a FIXED BIN(63) with a FIXED

BIN(64) UNSIGNED, was misnamed. It has been properly renamed in this release.

02854695 (680031)
• An erroneous severe MFPLI00092S diagnostic related to a missing locator has been fixed.

00368488 (415071)
• A problem related to the SUBSTR pseudo variable assignment with a structure member has been fixed.

02512156 (405095)
• To resolve discrepancies with mainframe FLOAT BIN behavior, the PL/I compiler has been updated with

the new -roundtozero option. For details, see PL/I Compiler Options in your product Help.

02590012 (506148)
• A problem moving a character string to a picture numeric field using the STRING pseudo-variable has

been fixed.

02818649 (663063)
• Execution of a non-local GOTO to a procedure with variable-size automatics sometimes caused a

memory corruption.
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02802813 (652171)
• A problem that caused zeros to be incorrectly suppressed when a PICTURE variable used zero

suppression format characters and trailing blank (B) format characters has been fixed.

02672076 (547003)
• A problem that caused PL/I JSON built-ins to produce incorrect results for BIT members when the

BITSLTR option was in effect has been fixed.

02667725 (542092)
• An unrecoverable error sometimes occurred when compiling the PL/I EXEC preprocessor-generated

%ENDFILE with the -exp option.

02565415 (454021)
• Non-computational structure members are now omitted in PUT LIST structure I/O with an appropriate

W-level warning diagnostic at compilation time.

02842789 (674100)
• A problem that caused the compiler to issue warning MPLI00145W when declaring an SQL BLOB as a

parameter has been fixed.

02710097 02726759 (614057)
• A problem with running applications compiled using absolute paths that were subsequently changed

prevented the debugger from finding source and relative .dcf files, ultimately causing debugger to
crash. This has been corrected in that this no longer causes the debugger to crash; however, it is still
unable to find relative .dcf files.

(667034)
• A design flaw that specified use of the wrong thread to drive low-level PL/I code when querying break-

point properties has been fixed.

(629011)
• To correct a problem with showing three-dimensional array elements, the method used to send

information about multi-dimensional arrays back to the IDE has been updated.

(657037)
• A problem that caused the debugger to crash when APIs not designed for querying information about

data breakpoints, signals, and/or conditions were being erroneously called has been fixed by adding
defensive code around those calls.

(629080)
• The PL/I EXEC preprocessor now emits the appropriate number of %ENDFILE statements.

02694010 (564071)
• A SIGSEGV sometimes occurred when attempting to call a label variable in a controlled array.

02645530 (531026)

Run-Time System

Back to the list

• Some native COBOL programs invoked via the cobrun trigger could display their command line
parameters incorrectly.

02695958 (607020)
• Previously, the window position of COBOL programs executed with runw/runmw would not get restored

correctly.

02560848 (453001)
• If some PL/I code uses a non-local GOTO to exit from an ON ERROR unit, that was triggered by a

signal, then a subsequent signal or error in another thread could cause a deadlock. This has now been
resolved.
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(549021)
• The RANDOM intrinsic function, when called from native COBOL programs, could sometimes return

negative values when using large seed values.

02687376 (615064)
• Previously, accessing files on SMB Azure file shares could result in a COBRT181 error unless the

remote_64bit_access tunable was set.

02745899 (633033)
• Previously, the setupenv.bat script used the built-in RANDOM environment variable to generated

unique temporary filenames. This has now been changed to use a PowerShell command to generate a
UUID, and then uses that in the generated temporary filenames instead.

02787305 (647052)
• Display issues when mixing COBOL ADIS displays with displays of a different type have been resolved.

02581162 (477021)
• Display issues, when mixing COBOL ADIS displays with displays of a different type, have been

resolved.

02581162 (520022)
• Tab characters have been removed from one of the supplied copybooks: cbltypes.cpy.

02783984 (643089)
• Previously, running a COBOL program would erroneously fail with the COBRT253 Cannot load file

- unsupported format (Fatal) error if COBPATH was explicitly set to not include the directory
where the program was located. This has now been changed to return the COBRT173 Called
program file not found in drive/directory error.

(588003)
• Previously, the Run-time System would always create an alias for a subprogram when the entry point

name cannot be found in the subprogram, in order to emulate the alias function of an IBM mainframe
linkage editor, which redirects the system to execute a program accessed via an alias name. There is
now a new tunable, entry_point_mapper_disable_auto_aliasing, which if set, disables such automatic
alias creation.

02675028 (559032)
• The tutorial instructions for COBOL calling Java static method (COBOL/Java Interoperability project)

have been updated to specify the setting of the COBSW environment variable; this variable is required
to address a display issue with the program output.

(567033)
• A new tunable - entry_point_mapper_invalid_path_error - which is off by default, has been added to

control whether the COBOL Run-Time System should report an error if the ENTRYNAMEMAP
environment variable refers to invalid/non-existent filename and directory paths.

(589018)

SQL: COBSQL

Back to the list

• COBSQL now correctly handles host variable arrays that require COMP/COMP5 conversion.

02668849 (543111)
• COBSQL has been updated to correctly handle an END-PERFORM problem caused by the new swap

byte logic.

02668849 (562025)
• COBSQL has been updated to support sign conversion of CHARSET ASCII + SIGN EBCDIC.

02683191 (573002)
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• COBSQL has been modified such that it no longer inserts group information in the EBCDIC conversion
statement when the group variable is a FILLER.

02555993 (442071)
• COBSQL was updated to correctly handle EBCDIC conversion of EXEC SQL OPEN USING

statements.

02804887 (651165)
• COBSQL has been updated to handle EBCDIC conversion of numerical values contained within

redefined group variables.

02584237 (481010)
• COBSQL has been updated to fix compilation issues related to ALPHA-LIT-CONT directive support.

02594669 (489083)
• To correct a compile problem caused by redefined variables, COBSQL has been updated to closely

track group variable information while determining which variables to convert. 

02570841 (464033)
• COBSQL now properly handles the EBCDIC conversion of FETCH FIRST/NEXT statements.

(649057)
• COBSQL has been updated to fix a swap-byte conversion issue that occurred because an

SQLCODE=100 was returned after a multi-row FETCH.

02702058 (596010)
• COBSQL has been modified in this release to handle EBCDIC conversion of FETCH ROWSET

statements.

02687410 (637117)
• COBSQL has been updated to properly terminate EXEC SQL statements that are replaced by dummy

lines during SYBASE precompilation.

02722549 (625013)
• COBSQL now correctly handles EBCDIC conversion of EXEC SQL statements that contain group items

as host variables.

02791368 (649037)
• COBSQL now recognizes the NOAMODE directive and handles it correctly at run time.

02592714 (516075)
• COBSQL now correctly handles source lines that contain a comma in column 8 immediately followed by

a COMP host variable.

02675814 (547024)
• COBSQL was updated to support ENTRY statements broken into multiple lines.

02426309 (374014)
• COBSQL was updated to use heap instead of an array to handle redefined variables.

02666211 (71231)
• COBSQL has been modified to handle periods in column 72 when the next line is empty.

02485117 (414080)
• COBSQL was updated to handle inline comments after END-EXEC token.

02624353 (520008)
• COBSQL now generates run-time logic correctly for signed numeric data items.

02811569 (658027)
• COBSQL now correctly handles signed numeric data items in a group.

02811569 (656026)
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SQL: SQL for DB2 LUW

Back to the list

• DB2ECM now correctly performs EBCDIC and ASCII conversions on large character data items.

02819706 (658145)
• The DB2 STOPROC compiler directive option now functions properly, allowing DB2 COBOL Stored

Procedures to be compiled in EBCDIC.

02807819 (653200)
• A problem that caused SQLCA corruption during EBCDIC conversion has been fixed.

02750476 (635058)
• A problem that occurred when compiling a program using the DB2 ECM caused a -1309 SQLCODE

compiler error instead of a connection pop-up dialog.

02354465 (503026)
• A problem using an mfdaemon resource for connection credentials compiling a program using the DB2

ECM has been fixed.

02354465 (643020)
• PL/I DB2 implicit generated COMMIT statements (COMMIT=<2,3>) are now processed correctly.

02735490 (628092)
• DB2ECM now compiles without problem when the HOSTVAR directive is used.

02686034 (564020)
• The DB2 ECM produced a connection dialog box instead of automatically connecting when the

mfdaemon was not started and mfaclient.ini contained valid database connection credentials. This
has been resolved.

02354465 (644030)

SQL: Mainframe Batch Database Tools

Back to the list

• A problem that prevented SQLUTB from generating a correct COND CODE when one job step
contained multiple commands has been fixed.

02626837 (519044)
• A problem with reading wrongly cataloged datasets with incorrect LRECL has been fixed.

02565909 (489096)
• SQLUTB has been updated to support constant field specifications.

02596145 (499004)
• A problem that sometimes occurred when using the SYSPUNCH generated by SQLTUL for SQLUTB

LOAD has been fixed.

(504040)
• A problem loading and unloading Zoned DECIMAL data using SQLUTB has been fixed. The NULLIF

defined on column (name) is supported in this release for SQLUTB LOAD.

02348281 (319036)
• MINVALUE and MAXVALUE in the partition definition of a table in DB2 LUW are now supported.

02552457 (442029)
• A problem that occurred when converting between IEE754 format and IBM370 format for float data

types on Linux has been corrected so that MBDT LOAD and UNLOAD work correctly for FLOAT data
types.

02848184 (673083)
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• A problem conforming the mainframe COND CODEs for SELECT * and SELECT individual columns
has been fixed.

02608857 02564044 02766263 (504179)
• A problem that occurred when executing SQLTUL to unload data in any sequence of jobs with and

without PARMS(SQL) has been fixed.

02708425 (619015)
• A problem with using STATISTICS TABLE(ALL) INDEX(ALL) syntax in SQLUTB load has been fixed. 

02630363 (529003)
• A problem with SQTUL/DSNTIAUL that sometimes occurred when changing a dataset from

SYSPUNCH to DUMMY has been fixed. 

02563262 (455025)
• The MBDTConfig message file is now shipped with Enterprise Server and COBOL Server.

02861596 (683077)
• A problem with SQLUTB UNLOAD using SQL 2 operators in one logical expression in the WHEN

clause has been fixed.

02585747 (482004)
• When DB2 LUW detects an invalid datetime format with SQLCODE: -99999, SQLSTATE: 22008 -

CLI0113E SQLSTATE 22007, error rows are now properly discarded. Processing continues and the
COND CODE is set to 04.

02565241 (458002)
• A problem with SQLTUL that caused an error when using UTF-8 encoding and unloading a CHAR()

column containing PostgreSQL DBCS characters has been fixed.

(515069)
• A problem with the MBDT Configuration utility that caused issues when setting the -t option on UNIX

has been corrected by updating MBDT with the new -g option, used to create and access the
OpenESQLConfig.ini in the $COBDIR/etc directory on UNIX platforms only.

(542087)
• A problem that occurred when executing SQLUTB jobs against DB2 for z/OS has been fixed.

02627157 (644114)

SQL: OpenESQL

Back to the list

• The native SQL runtime sometimes hung when it encountered the EXEC SQL ROLLBACK TO
SAVEPOINT command. This has been resolved.

02565661 (469019)
• A problem that caused an unwarranted rollback when the last SQL statement issued was a commit or

rollback, and the next SQL statement was a disconnect has been resolved.

02731137 (628044)
• OpenESQL now handles EBCDIC application correctly when the AMODE(31) directive is used in a 64-

bit environment.

02541041 (454020)
• DSNREXX now handles multiple SQL Statements correctly and without corrupting memory.

02599095 (504116)
• A problem that prevented the OpenESQL runtime from releasing all pinned .NET objects for

MFSQLMESSAGETXT has been fixed.

02690852 (612080)
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• OpenESQL has been updated to support user IDs containing a dot.

02637077 (525103)
• A problem with incorrectly cleaning up the ODBC environment sometimes caused OpenESQL to throw

a memory access violation error. In this release, the ODBC environment is cleaned up such that this
error no longer occurs.

02742293 (630097)
• WITH RETURN cursors are now opened as KEYSET type instead of DYNAMIC type.

02541903 (461001)
• A problem that sometimes caused the OpenESQL Assistant to crash in Eclipse has been fixed.

02642239 (534012)
• A compiler error that was caused when using the SQL(GEN-SQLCA) directive without separately

defining SQLSTATE in program code has been fixed.

02743040 02794285 (629124)
• The ODBC ECM error code 12 was sometimes returned during a compile with SQL directives when

processing an interface.

02543269 (425092)
• A problem that sometimes caused the OpenESQL runtime to leak memory when handling threads has

been fixed.

02646010 (531005)
• The THREAD=ISOLATE SQL compiler directive option now works correctly when a native connection is

used by a managed program running in the same thread.

02670859 (625018)
• The Oracle RM switch module now supports Oracle Client version 21c.

02850631 (673121)

SQL Option for DB2

Back to the list

• An issue with the XDB ODBC Driver failing to get output arguments returned from a stored procedure
due to the setting of null indicators has been resolved.

02420241 (377058)
• When using the Optimizer, an incorrect set of prequalified row IDs resulted due to an incorrect data type

from the expression evaluation code. This has been corrected.

02080612 (185011)
• To correct a problem with XDB engines caused by the mandatory inclusion of the correlation clause on

a nested table expression has been fixed such that the correlation clause is no longer mandatory.

02741300 (627096)
• Timestamps can now be added and subtracted by microseconds.

02353324 (350013)

SQL: HCO for SQL Server

Back to the list

• Entcobol dialect processing has been updated to identify the first character of a VARGRAPHIC column
as big endian.

02640903 (531069)
• A problem with the HCOSS tree mode UI that caused all child tables to be excluded from HCOSS

Define Lists entries has been fixed.
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02544930 (635026)
• A problem that prevented the DBMAN, TARGETDB, BEHAVIOR, and DIALECT SQL directives from

being reset by the compiler before recompiling a new source file has been fixed.

02552997 (451040)
• The mf_char2 function has been fixed to return the microseconds with leading zeros.

02588814 (487072)
• An HCOSS program with the SQL DB2 statement EXEC SQL SET :HV = CURRENT SQLID END-

EXEC now uses the value specified in the HCOSS Customize SQL Name Mappings for the current
SQLID.

02606922 (542058)
• The mf_char_dt function can now return NULL when date/first parameter is NULL.

02588830 (504154)

XML Support

Back to the list

• XMLPARSE now correctly handles small XML instance documents on the AIX platform.

02799668 (652088)
• XML PARSE has been updated to properly handle XML instance documents with a large number of

content characters within tags.

02575649 (472007)
• The XMLPARSE feature is now available in the Enterprise Server for Stored Procedures product.

02822761 (663037)
• XML READ now performs much faster when a big OCCURS value is used in the XML data-item.

02630023 (525082)
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Other Issues Resolved in This Release
The numbers listed are the Support Incident Numbers followed by the Issue number (in parentheses).

• 02556886 (468003)
• (662117)
• 02537488 (453046)
• 02624110 (520012)
• 02723517 (618034)
• 00363234 (28048)
• 00477923 (61180)
• 02822038 (508052)
• 02394824 02778550 (351052)
• 00373450 02406104 (11527)
• (61096)
• (442036)
• 02823160 (675050)
• 02725405 (628033)
• 02780781 (647035)
• 02743825 (629142)
• 02686079 02733133 (629006)
• 02600111 (597005)
• 02583111 (485001)
• 02783874 (648018)
• 02646617 (540015)
• (513014)
• (568005)
• 02677554 (560014)
• 02730120 (628029)
• (649040)
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Unsupported or Deprecated Functionality
This section includes information about features or functionality that are not supported.

• The SafeNet Sentinel licensing system has been deprecated. This product uses the Micro Focus
AutoPass licensing technology. Contact your account manager to replace your existing SafeNet Sentinel
with AutoPass licenses. Also, see Advanced Installation Tasks > Licensing Coexistence when
Upgrading to Release 10.0 in the Installation section in your product Help.

• The HOSTSIGNS Compiler directive is no longer supported. Micro Focus recommends that you use the
following Compiler directives instead: SIGN-FIXUP, HOST-NUMMOVE, and HOST-NUMCOMPARE.
This is a change since version 3.0 of this product.
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Additional Software Requirements
To ensure full functionality for some Enterprise Developer features, you might be required to obtain and
install additional third-party software.

Click here to see this information in the product Help for Enterprise Developer for Eclipse (Windows) on the
Product Documentation pages on OpenText Support for Micro Focus Products.

Click here to see this information in the product Help for Enterprise Developer for Eclipse (UNIX) on the
Product Documentation pages on OpenText Support for Micro Focus Products.
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Installation

Installing Enterprise Developer for Eclipse (Windows)

Before Installing

Downloading the Product
1. Log into the Software Licenses and Downloads (SLD) site at https://sld.microfocus.com/mysoftware/

download/downloadCenter.
2. Select your account and click Entitlements.
3. Search for the product by using any of the available search parameters.
4. Click Show all entitlements.
5. Click Get Software in the Action column for the product you want to download or update.

In the File Type column, you see entries for "Software" for any GA products, and "Patch" for any patch
updates.

6. Click Download on the relevant row.

On Windows

System Requirements

Hardware Requirements

Enterprise Developer has the following requirements in addition to the requirements of Eclipse. See the
Eclipse documentation for details of its requirements.

In general, most modern machines will have the required processor and available RAM to run the Micro
Focus products under Windows effectively. For planning purposes, you should consider having a minimum
of 2GB of RAM though Micro Focus recommends at least 4GB of RAM for optimal performance.

The disk space requirements for Windows are, approximately:

Enterprise Developer

3.5GB

Note: The disk space requirements include the size of the Eclipse IDE and the version of Java and
the .NET Framework provided with the Enterprise Developer setup file. This includes the space
needed to cache information locally so that you can modify the installation without the original source
media.

Operating Systems Supported

For a list of supported operating systems, see Supported Operating Systems and Third-party Software in
your product documentation.

Also note the following:

• A 64-bit Windows is required. 32-bit Windows is not supported. See Installation in Known Issues and
Restrictions.
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You can produce both 64-bit and 32-bit applications with Enterprise Developer on 64-bit operating
systems.

• The Server Core form of Windows Server 2019 is not supported.

Software requirements

Note: This product includes OpenSSL version 3.0.8.

The setup file will check your machine for whether the prerequisite software is installed and will install any
missing prerequisites and the product components.

Requirements for the setup file

• A 64-bit Windows is required. 32-bit Windows is not supported. See Installation in Known Issues and
Restrictions.

• The setup file installs Enterprise Developer and the 64-bit version of Eclipse 4.28 (2023-06).

Enterprise Developer only supports the 64-bit version of Eclipse. You can use the 64-bit Eclipse to
create both 32-bit and 64-bit applications.

• The setup file installs Adoptium's OpenJDK Temurin 17 (LTS) with HotSpot.
• The setup file also installs Microsoft's Visual C++ 2012 and 2015-2022 Redistributables.

Requirements for running the product on Windows

• Java 17 (64-bit) or 21 is required to run the Eclipse IDE. The recommended version is Adoptium's
OpenJDK Temurin 17 (LTS) with HotSpot. On Windows, the installer automatically installs Adoptium's
OpenJDK Temurin 17 (LTS) with HotSpot. On Linux, you need to install Java before you install this
product. You can download Adoptium's OpenJDK Temurin 17 (LTS) with HotSpot from Adoptium's Web
site and unpack the archive anywhere on your machine.

• Enterprise Developer requires a 64-bit Java installation to run a 64-bit Eclipse.
• Microsoft Windows SDK and Microsoft Build Tools: Various actions and operations within your COBOL

development environment depend on certain files that Microsoft distributes in the following package: the
Windows SDK package. See Microsoft Package Dependencies for a full list of actions and operations
that require one or both of these packages.

By default, the product installation installs the latest versions of the Microsoft Windows 10 SDK, and the
Microsoft Build Tools for Visual Studio 2017, to their default locations.

If you need to use any other version of these packages, or use them installed to a non-default location,
use the cblmx`s command line utility post-installation to manage this; see Managing the Microsoft
Build Tools and Windows SDK Packages for more information.

See Java Support in Eclipse (Known Issues) in the product help for any considerations when using Eclipse
and Java.

License Manager requirements

• For local servers, you do not need to install the Micro Focus License Administration tool separately, as
the setup file installs a new Enterprise Developer client and a new licensing server on the same
machine.

• If you have any network license servers, you must update them before you update the client machines.
• If you are upgrading from Enterprise Developer release 2.2 or earlier, uninstall the license manager

before installing the product.

You can download the new version of the license server software by following these steps:

1. Log into the Software Licenses and Downloads (SLD) site at https://sld.microfocus.com/mysoftware/
download/downloadCenter.
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2. Select your account and click Downloads.
3. Select a product and a product version from your orders.
4. In the list of software downloads, locate the License Manager.
5. Click Download to download an archive with the installers.
6. Run the installer suitable for your Operating System to install License Manager on your machine.

Additional Software Requirements

To ensure full functionality for some Enterprise Developer features, you might be required to obtain and
install additional third-party software.

Click here to see this information in the product Help for Enterprise Developer for Eclipse (Windows) on the
Product Documentation pages on OpenText Support for Micro Focus Products.

Click here to see this information in the product Help for Enterprise Developer for Eclipse (UNIX) on the
Product Documentation pages on OpenText Support for Micro Focus Products.

Product Co-Existence

Note: The following applies to Windows only.

• Enterprise Developer and Enterprise Server (or Enterprise Test Server) cannot coexist on the same
machine.

• Micro Focus Visual COBOL and Enterprise Developer cannot coexist on the same machine regardless
of which IDE (Visual Studio or Eclipse) you install.

Installation Restrictions and Requirements

Before starting the installation you should consider the following:

• You need to be logged in with a user-ID that has write access to the registry structure under
HKEY_LOCAL_MACHINE, HKEY_CLASSES_ROOT, and HKEY_CURRENT_USER so the installation
software can set the environment appropriately. You also need to be logged on with Administrator
privileges.

• Various actions and operations within your COBOL development environment depend on certain
Microsoft files distributed in the following packages: the Windows SDK package and the Microsoft Build
Tools package. By default, a standard product installation downloads and installs these. Refer to
Microsoft Package Dependencies to see if these packages are required. If you do not plan to use your
development tool in a way that will depend on any of these packages, you can run a non-standard
installation, which will skip their download and installation, thus saving disk space and time taken for
installation. Refer to Advanced Installation Tasks for details on the available installation options.

On UNIX

System Requirements for Micro Focus Enterprise Developer UNIX Components

Hardware Requirements

The disk space requirements for Micro Focus Enterprise Developer UNIX Components are approximately:

Platform Installer type Setup

file size

Disk space

required for

the installation

Disk space

required for

running

the product

Licensing
technology

POWER
running AIX

Micro Focus 1.1 GB 4.40 GB 2.20 GB 41 MB
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Platform Installer type Setup

file size

Disk space

required for

the installation

Disk space

required for

running

the product

Licensing
technology

System Z
running Red
Hat Linux

Micro Focus 630 MB 2.52 GB 1.26 GB 39 MB

x86-64
running Red
Hat Linux

Micro Focus 1.17 GB 4.66 GB 2.33 GB 50 MB

Red Hat for
Docker

Micro Focus 809 MB 3.24 GB 1.62 GB 50 MB

x64 running
Amazon Linux
2

Micro Focus 804 MB 3.22 GB 1.61 GB 50 MB

Amazon for
Docker

Micro Focus 803 MB 3.21 GB 1.61 GB 50 MB

SPARC
running
Solaris

Micro Focus 877 MB 3.51 GB 1.75 GB 42 MB

System Z
running SUSE
SLES

Micro Focus 585 MB 2.34 GB 1.17 GB 39 MB

x64 running
SUSE SLES

Micro Focus 865 MB 3.46 GB 1.73 GB 50 MB

x64 running
Ubuntu

Micro Focus 834 MB 3.34 GB 1.67 GB 50 MB

SUSE for
Docker

Micro Focus 864 MB 3.46 GB 1.73 GB 50 MB

Ubuntu for
Docker

Micro Focus 864 MB 3.46 GB 1.73 GB 50 MB

x86-64
running Rocky
Linux

Micro Focus 1.17 GB 4.66 GB 2.33 GB 50 MB

Rocky Linux
for Docker

Micro Focus 809 MB 3.24 GB 1.62 GB 50 MB

x86-64
running
Oracle Linux -
Red Hat
Compatibility
Kernel

Micro Focus 1.17 GB 4.66 GB 2.33 GB 50 MB

Operating Systems Supported

For a list of supported operating systems, see Supported Operating Systems and Third-party Software in
your product documentation.

On some platforms, there is only a 64-bit version of this product. 64-bit versions of the product support
compiling to and running 64-bit programs only.
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Software Requirements for Micro Focus Enterprise Developer UNIX Components

The following topic lists the software requirements for Micro Focus Enterprise Developer UNIX
Components.

• Software required by the setup file
• Libraries required by the setup file
• Software required to run the product
• Required environment variables
• License Manager requirements

Software required by the setup file

• The "awk", "ed", "ps", "sed", tar", "sed" and "which" "tar" utilities must be installed and added to the
PATH.

• On AIX 7.2 and 7.3, the installer requires the Open XL C/C++ 17.1 Clang C++ compiler. You need to
install the Open XL C/C++ 17.1 runtime environment and utilities package.

• Xterm, the terminal emulator for the X Window System, is part of your UNIX/Linux distribution but is not
always installed by default. Use your UNIX/Linux installation media to install it.

• GNOME menus and buttons have been standardized across all applications so that icons are not
displayed by default. To keep the icons and the look and feel of previous versions, enable the
menus_have_icons property with the command:

gconftool-2 --type boolean --set /desktop/gnome/interface/menus_have_icons 
true

Libraries required by the setup file

The following table lists the required libraries for Red Hat and SUSE Linux platforms. The setup file checks
that both the 32-bit and 64-bit libraries listed below are installed on both 32-bit and on 64-bit Operating
Systems for this product to install and work correctly.

If installing on a 64-bit OS, the 32-bit libraries are not installed by default and must be installed before you
start the installation.

Library 32-bit
Librar

y
Name

64-bit
Library
Name

Platform

s390 SUSE 12 SUSE 15 Red Hat 6x Red Hat 7 Red Hat 8

glibc glibc-
*.i686

glibc-
*.x86_64

glibc-
*.s390

X X X

libgcc libgcc
-
*.i686

libgcc-
*.x86_64

libgcc-
*.s390

X X X

libstdc++ libstdc
++-
*.i686

libstdc++-
*.x86_64

libstdc++-
*.s390

X X X

glibc-locale glibc-
locale
-32bit

glibc-
locale-2

X X

glibc-devel glibc-
devel-
*.i686

glibc-
devel-
*.x86_64

glibc-
devel-
*.s390

X X X
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Library 32-bit
Librar

y
Name

64-bit
Library
Name

Platform

s390 SUSE 12 SUSE 15 Red Hat 6x Red Hat 7 Red Hat 8

elfutils-libelf elfutils
-
libelf.i
386
or
elfutils
-
libelf.i
686

elfutils-
libelf.x86-
64

N/A X X X

libelf-devel** elfutils
-
devel.
i386
or
elfutils
-
devel.
i686

elfutils-
devel.x86
-64

N/A X X X

libelf-devel** libelf-
devel-
32bit-
0.137
-8.19

libelf-
devel-0.1
37-8.19

N/A X X X

libelf1** libelf1
-32bit-
0.137
-8.19

libelf1-0.1
37-8.19

N/A X X

gcc1 gcc*.i
686

gcc*x86_
64

X X X X X X

cpp1 cpp*x86_
64

X X X

systemd-libs2 X

ld1 Binutil
s*.i68
6

Binutils*x
86_64

X X X X X X

• Libraries marked with an 'X' are not included in the platform and need to be installed separately.
• 1On Red Hat, these libraries are required to enable COBOL and PL/I to compile.
• 2Only required if using 32-bit enterprise server regions on Red Hat where 32-bit systemd libraries are

not installed.
• * Additional libraries required to use the core_on_error run-time system variable. The gdb packages (for

the GNU Project Debugger) can be installed from the install media for your OS.
• ** Operating system libraries required for PL/I support on both SUSE and Red Hat.

Visit the Red Hat Web site for more information.
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Software required to run the product

• Java 1.8 (64-bit) or later is required to run Micro Focus Enterprise Developer UNIX Components. The
recommended version is Adoptium's OpenJDK Temurin 17 (LTS) with HotSpot. You can download
Adoptium's OpenJDK Temurin 17 (LTS) with HotSpot from Adoptium's Web site and unpack the archive
anywhere on your machine.

Required environment variables

• To execute JVM COBOL code, you need to set the environment as follows:

• Set the JAVA_HOME environment variable. When installing the product, set this variable to a 64-bit
Java installation or the installation terminates. For example, execute the following:

export JAVA_HOME=java_install_dir

where java_install_dir is the path to the JAVA installation directory such as /usr/java/javan.n
• Add $JAVA_HOME/bin to your system PATH variable. To do this, execute:

export PATH=$JAVA_HOME/bin:$PATH

• You need to set the LANG environment variable to pick up localized messages. If you do not set it as
specified here, the installation will run but you might experience unexpected behavior from the
installer.

The LANG settings are English and Japanese only so set it to one of the following locales:

C, default, en_GB, en_GB.UTF-8, en_US, en_US.UTF-8

ja_JP, ja_JP.SJIS, ja_JP.UTF-8, ja_JP.eucJP, ja_JP.eucjp, ja_JP.sjis, 
ja_JP.ujis, ja_JP.utf8, japanese

You can set LANG before running the setup file as follows:

export LANG=C

Alternatively, add it to the start of the setup command line:

LANG=C ./setupfilename

See Using the LANG Environment Variable for details.

License Manager requirements

• For local servers, you do not need to install the Micro Focus License Administration tool separately, as
the setup file installs a new Enterprise Developer client and a new licensing server on the same
machine.

• If you have any network license servers, you must update them before you update the client machines.
• If you are upgrading from Enterprise Developer release 2.2 or earlier, uninstall the license manager

before installing the product.

You can download the new version of the license server software by following these steps:

1. Log into the Software Licenses and Downloads (SLD) site at https://sld.microfocus.com/mysoftware/
download/downloadCenter.

2. Select your account and click Downloads.
3. Select a product and a product version from your orders.
4. In the list of software downloads, locate the License Manager.
5. Click Download to download an archive with the installers.
6. Run the installer suitable for your Operating System to install License Manager on your machine.
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Installation on UNIX and Linux (Known Issues)

Installing on Linux

On Linux, the RPM installer for Enterprise Developer for Eclipse installs a 64-bit version of Java. When you
start the installation, if the 32-bit version of Java is already installed on your Linux machine, you might not
be able to install Enterprise Developer. This is a known issue with the Oracle Java installers for Linux which
prevents you from installing both the 32-bit and the 64-bit versions of Java on the same machine. To work
around this problem:

• Download the 64-bit Java distribution in a compressed .tar format from the Oracle Web site.
• Untar the distribution into a location different from the one used for the 32-bit Java version. For example,

untar in /usr/local/java64 and not in /usr/local/java.
• Set JAVA_HOME and LD_LIBRARY_PATH to the 64-bit version of Java so that it is used to install and

run Enterprise Developer.

Installing on Ubuntu 10.10 and later

Every version of Ubuntu starting with 10.10 comes with a setting that prevents an application from using
ptrace to attach to another process. This prevents the PL/I debugger from attaching to user processes, and
therefore debugging fails. To prevent this problem, disable the offending setting as follows before installing
Enterprise Developer:

1. Using any text editor, open the /proc/sys/kernel/yama/ptrace_scope file.
2. Set pctrace=0.

For more information, see Debugging applications that run on Ubuntu (ptrace restriction).

Installing on Red Hat 8.x s390

On Red Hat 8.x s390, the RPM non-root install method is not supported due to errors given by cpio. You
receive the following messages:

error: unpacking of archive failed on file /usr/lib/.build-id/1b/
af99f26c6b4c00ca499a3199a574b73aeb3854;6092b79c: cpio: symlink failed - No 
such file or directory
error: Micro_Focus_cobol_server-7.0.0.0-100700.s390x: install failed

As a result, the installation in this scenario is incomplete.

Installing while using AFS/Kerberos authentication

If you are using AFS/Kerberos authentication to log onto your Linux system then you need to ensure you
have a local user ID which SOA and Enterprise Developer components of the product can use. This user
ID must be set up prior to running the installer. When running the installer you need to specify -
ESadminID=[User ID] on the command line so it is used by the installer.

License Server

You need to configure the computer hostname to ensure the license server will start properly.

To avoid performance issues, "localhost" and the computer hostname must not both be mapped to IP
address 127.0.0.1. You should only map "localhost" to IP address 127.0.0.1.

The following is an example of how to specify these entries correctly in the /etc/hosts file:

127.0.0.1 localhost.localdomain localhost
IP machinelonghostname machineshorthostname

where IP is the unique IP address of the computer in xx.xx.xx.xx format.
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Basic Installation
The instructions in this section apply when you are performing a basic installation of this product for the
first time. If you are an administrator, you can perform a basic installation on a local machine before
performing a more advanced installation when rolling out the product to developers within your
organization.

For considerations when installing this product as an upgrade, for additional installation options or non-
default installations and for installing the mainframe components, see Advanced Installation Tasks in your
product Help.

Installing on Windows
Note:

• This version of the product is a full install.
• If you have an earlier version of Enterprise Developer installed on your machine, check Installing

as an Upgrade before you start the installation - see Advanced Installation Tasks.

These are the steps to install Enterprise Developer:

1. Run the ede_100.exe file and follow the wizard instructions to complete the installation.

By default, this installs Enterprise Developer in the %ProgramFiles(x86)%\Micro Focus
\Enterprise Developer folder and installs a full version of Eclipse 4.28 (2023-06) 64-bit, with the
Enterprise Developer plugins already installed, in the C:\Users\Public\Micro Focus\Product
Name\eclipse directory.

The setup file installs any missing prerequisite software as listed in the topic Software Requirements.

Note: See Advanced Installation Tasks for information about non-default installation tasks.

Installing Micro Focus Enterprise Developer UNIX Components
Micro Focus offers two types of installers on UNIX and Linux - a proprietary Micro Focus installer for
installing on UNIX and Linux and a standard RPM (RPM Package Manager) installer for installing on Linux.
See your product Help for instructions on how to use the RPM installer.

Before starting the installation, see Software Requirements.

These are the steps to install this product using the Micro Focus installer:

1. Give execute permissions to the setup file:

chmod +x setup_entdev_10.0_platform

2. Run the installer from the Process User ID login:

./setup_entdev_10.0_platform

When the installer starts it will prompt you to enter the superuser password so it can perform operations
that require root permissions.

Note: On Ubuntu, the prompt for superuser password is not available. On this platform you must
either log in as root or use the sudo command to get root permissions before you run the installer.

The COBOL environment is installed by default into /opt/microfocus/EnterpriseDeveloper,
(COBDIR).

Enterprise Server System Administrator Process

During the installation process, the installer configures the product's Enterprise Server System
Administrator Process User ID. The Process User ID will be the owner of all Enterprise Server processes

90 | Installation



except the one for the Micro Focus Directory Server (MFDS). The Directory Server process (Enterprise
Server Administration) runs as root as this allows it to access the system files and ports.

All Enterprise Server processes you start from Enterprise Server Administration run under the Process
User ID which can affects the file access and creation.

You must supply the user ID at the command line - specify -EsadminID=[ ID ] as part of your
command.

By default, the installer uses the login id of the user that runs the installer for the Process User ID. To
change the user id after you complete the installation, execute $COBDIR/bin/casperm.sh and follow the
onscreen instructions.

AutoPass Licensing considerations

• The installation of this product could affect the AutoPass licensed components running on your
machine. During installation, the licensing shuts down to allow files to be updated. To ensure the
processes running on your machine are not affected, you need to use the -skipautopass option, which
skips the installation of AutoPass:

./setup file -skipautopass

• To protect the AutoPass installation from accidental updating, you can create an empty file named
SKIP_AUTOPASS_INSTALL in /opt/microfocus/licensing as follows:

touch /opt/microfocus/licensing/SKIP_AUTOPASS_INSTALL

While the file is present, the AutoPass installer does not make changes to the installation or shutdown
the running license daemons. If licensing needs to be updated later, you can rerun the
MFLicenseServerInstall.sh from within the $COBDIR/licensing folder with the force command
line option:

cd $COBDIR/licensing
./MFLicenseServerInstall.sh force

Advanced Installation Tasks
This section includes instructions about how to perform a non-default installation, install this product as an
upgrade, or about how to install the additional components.

The advanced installation tasks include:

• Installing as an Upgrade - included in these Release Notes
• Command line installation options - included in these Release Notes
• Installing using an RPM installer on Linux - available in the product Help and on the Product

Documentation pages on OpenText Support for Micro Focus Products
• Installing and licensing Micro Focus Rumba - available in the product Help and on the Product

Documentation pages on OpenText Support for Micro Focus Products
• Installing into other instances of Eclipse - available in the product Help and on the Product

Documentation pages on OpenText Support for Micro Focus Products
• Installing the Mainframe Components, - Mainframe Access Server, Application Workflow Manager into

IDz, z/Server - available in the product Help and on the Product Documentation pages on OpenText
Support for Micro Focus Products

• Installing on Microsoft Terminal Server and Citrix - available in the product Help and on the Product
Documentation pages on OpenText Support for Micro Focus Products

Click here to see this information on the Product Documentation pages on OpenText Support for Micro
Focus Products.

On Windows
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Installing as an Upgrade

• This release cannot be installed as an upgrade to an earlier release of Enterprise Developer. You must
uninstall the previous version before you start the installation.

Licensing Coexistence when Upgrading to Release 10.0

With release 10.0 of the Enterprise Developer product suite, the SafeNet Sentinel licensing technology has
been deprecated. This can result in some compatibility issues if you install 10.0 on a machine where there
are other Micro Focus products or versions installed that use SafeNet Sentinel licensing. While the 10.0
installation process has been designed to address such issues, you should be aware of the following
scenarios and if any action might be required to ensure licensing works as expected:

Scenarios

Your installed products
use SafeNet Sentinel
Licenses (Windows and
UNIX)

Warning: Installing 10.0 deprecates SafeNet Sentinel licensing on
the machine.

If you use SafeNet Sentinel licenses for any other Micro Focus products,
such as Enterprise Analyser or Relativity, you need to contact your account
manager to obtain AutoPass licenses for these products. See the
Troubleshooting section further in this topic, Action 7 for how to obtain a list
of your installed licenses.

Your older products use
AutoPass licenses
(Windows and UNIX)

Existing AutoPass licenses are compatible with the 10.0 products.

Upgrading to 10.0 (UNIX) After installing 10.0 on a machine with a previous version of licensing
installed, the lserv daemon is retained (and might be running) but is not
required. See Troubleshooting > Action 2 for details.

Downgrading from 10.0
(Windows and UNIX)

In order to revert to a previous version of the product (for example, if 10.0 is
installed but no longer required), the 10.0 product and licensing must be
uninstalled. See Troubleshooting > Action 1 for details.

Installing a product or
Patch Update of an older
product release (UNIX)

Use the "skip license installation" command line arguments.

• See Troubleshooting > Action 3 for details.
• Else, see Troubleshooting > Action 4 to reset mfcesd.
• SystemD may be overwritten - see Troubleshooting > Action 6.

Installing a product or
Patch Update of an older
product release (AIX only)

If after 10.0 is installed a customer installs a Patch Update for an older
release, the lserv entry is moved back to /etc/inittab.

• See Troubleshooting > Action 3 about how to avoid this.
• To correct the /etc/inittab entry, see Troubleshooting > Action 5.
• Alternatively, re-run the 10.0 license install. See Troubleshooting > Action

6.

Troubleshooting

Action 1 To reset licensing from the 10.0 installation to an older product configuration, you need to
perform the following:

Windows Uninstall the product and the License Manager from "Uninstall a Program" in the
Windows Control Panel.
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UNIX Execute the following commands:

sudo $COBDIR/bin/Uninstall_[Product Name]_10.0.sh.
sudo /opt/microfocus/licensing/bin/
UnInstallMFLicenseServer.sh

Action 2 (UNIX) To disable the lserv daemon on a machine, execute the following commands:

cd /var/microfocuslicensing/bin
sudo ./stopmfcesd.sh
sudo systemctl stop MFSafeNet
sudo systemctl disable MFSafeNet

Action 3 When installing an older release or Patch Update, use -skipsafenet -skipautopass to
the install command. This will skip the licensing installation for that release.

Action 4 To restart mfcesd from the correct location, execute the following commands:

cd /var/microfocuslicensing/bin
sudo ./stopmfcesd.sh
cd /opt/microfocus/licensing/bin
sudo ./startmfcesd.sh

Action 5 To reset the inittab on AIX 7.3/7.4:

1. Edit the /etc/inittab file.
2. Delete the line:

mFls:2345:wait:sh /var/microfocuslicensing/bin/startlserv.sh 2>&1

Action 6 To reinstall the 10.0 licensing and reset any issues from installing a previous version, execute
the following:

cd [10.0-COBDIR-location]/licensing
sudo MFLicenseServerInstall.sh force

Action 7 In order to get a list of the installed licenses:

Windows 1. From a COBOL command environment, execute mfsupportinfo.
2. View the Micro Focus Licensing section.

UNIX 1. In a terminal, run cobsetenv to set the product environment.
2. Run mfsupport.
3. See mfpoll.txt for the licenses details.

Enterprise Developer Installation Options

To see what parameters you can use, execute the following from the command line:

install-file /help

where install-file for the following products is as follows:

Enterprise Developer ede_100.exe

See the Examples section further in this topic for examples of some of the parameters you can use.

Directory considerations

• You must have read and write access for every directory accessed during the installation.
• You can override the default installation folder using the InstallFolder parameter.
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• Installing creates a group of log files prefixed Micro_Focus_ in the %temp% folder, by default. To
change the location or name, use the /log parameter on your Setup command line and specify the
path and file name, for example:

/log drive:\path\LogFilename

Skipping installation of the Microsoft package dependencies

A standard installation downloads and installs the latest versions of the Microsoft Build Tools (for Visual
Studio 2017) and the Windows 10 SDK packages to their default locations. Using the following option, you
can skip installation of these packages, thus reducing the footprint and duration of the installation. See
Microsoft Package Dependencies to see if you can safely skip installing these packages.

ede_100.exe skipmstools=1 

Offline installations

An offline installation is one where the client running an install is not connected to the internet; the problem
this presents is that the installer cannot download and install certain file and package dependencies; see
Microsoft Package Dependencies. In such circumstances, an administrator (or at least someone connected
to the internet) must download and make any dependencies available on the local network beforehand.

To prepare an offline installation, the administrator should run their own (online) installation using the
downloadmstools parameter: this downloads the package dependencies to <directory>, which should
be a fully-qualified path to a location accessible to the client when they run an installation.

start /wait ede_100.exe /q downloadmstools=<directory>

A client can then run an offline installation by pointing their installer at the location of the packages:

ede_100.exe installmstools=<directory>

This command runs a full product install; during which it uses the locally-accessible <directory> to install
the package dependencies.

Installing silently
You can install Micro Focus products silently by specifying /q at the command line and using command line
parameters to specify the installation directory (installfolder=path), user information, and which
features to install. You must execute the command with superuser permissions.

start /wait install-file.exe /q [parameters]

Examples

• To silently install Enterprise Developer into a directory other than the default:

start /wait ede_100.exe /q InstallFolder=c:\DirectoryName

• If you want to silently install the Eclipse IDE in a location other than the default, execute:

start /wait ede_100.exe /q InstallFolder2=c:\EclipseInstallDirectory

Microsoft Package Dependencies

Various actions and operations within your COBOL development environment depend on certain files that
Microsoft distributes in the following package: the Windows SDK package.

There is a dependency on the Microsoft Windows SDK if you:

• Produce COBOL .exe or .dll files.
• Call Windows APIs from your COBOL .exe or .dll files.
• Link a C object file into a COBOL .exe or .dll file.
• Call Windows APIs from a C object file linked into a COBOL .exe or .dll file.

94 | Installation



• Create MIDL files for OLE RPC.

There is a dependency on the Microsoft Build Tools if you:

• Produce COBOL .exe or .dll files.
• Manage .lib files.
• Convert resource files to object modules.

If you distribute a COBOL product installation to clients that do not have access to the internet, then you
need to have downloaded these packages and placed them in an accessible place on the network before
clients can run an 'offline installation'. The installer includes options to achieve this: downloadmstools
enables you to download the required packages to a specific location; and installmstools enables an
offline client to install the packages from a local network location.

If you do not use any of the features described above, you can use an install parameter (skipmstools=1)
that will skip the download and installation of these dependencies.

All of these installation options are discussed in more detail in the Installation Options topic for your
product.

One of the final steps of the installation process configures the downloaded and installed package versions
for use in your COBOL environment. You can view these versions using the Windows SDK Configuration
Utility - see Managing the Microsoft Build Tools and Windows SDK Packages. This utility also enables you
to specify alternative versions should you need to depend on a specific package other than the one
downloaded, or one stored in a non-default location.

On UNIX

Installing as an Upgrade

This release works concurrently with the previous version of Micro Focus Enterprise Developer UNIX
Components, so you do not need to uninstall it. See the rest of this topic for considerations when installing
alongside older releases.

Install the latest version in a different location and set the environment to point to it. To do this, run the
Micro Focus Enterprise Developer UNIX Components installer with the –installlocation option:

1. Execute the following command:

./InstallFile -installlocation="/opt/microfocus/EnterpriseDeveloper"

Note: You can use variables when specifying an absolute path for –installlocation. For
example, the following examples are equivalent:

-installlocation="/home/myid/installdir"

-installlocation="$HOME/installdir"

2. Execute cobsetenv to set the environment and point to the new install location:

. <product-install-dir>/bin/cobsetenv

Note: cobsetenv is only compatible with POSIX-like shells, such as bash, ksh, or XPG4 sh. It is
not compatible with C-shell or pre-XPG4 Bourne shell.

Preserving the Licensing Configuration Alongside Older Releases

The following is required when you use release 10.0 alongside earlier supported releases of this product
on the same machine. The licensing configuration file has changed in release 10.0 and you need to ensure
that the older releases do not overwrite it as this can result in issue with licensing and auto-start setup.

You can do this in one of the following ways:
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• Execute the following after you install release 10.0:

touch /var/microfocuslicensing/SKIP_SAFENET_INSTALL
touch /opt/microfocus/licensing/SKIP_AUTOPASS_INSTALL

• Alternatively, when installing releases earlier than 10.0, use the following command line options during
the installation:

-skipsafenet -skipautopass

This skips the license installation step for those releases and preserves the licensing configuration for
release 10.0.

Preserving Product Configuration

The following information applies when you are upgrading from releases 8.0, 9.0, and above.

If you install this release to the same install location as release 8.0 or above, the product in the current
location is moved to a backup directory name.

For example, if the 7.0 product is installed in the default install location, /opt/microfocus/
EnterpriseDeveloper, during the installation process it is moved to /opt/microfocus/
EnterpriseDeveloper.BKP.YYYY-MM-DD.HH:MM:SS. The new release will be installed in /opt/
microfocus/EnterpriseDeveloper. The backup location will store your original installation along with
any files you deployed to that directory. It will also contain any configuration files you modified post-install.

When installing 9.0 and above the installer moves a number of specific configuration files to a different
configuration location and symbolically links them back to the new release install location. The
configuration location will be one of the following:

• The default config location is /opt/microfocus/config/.
• For non-root installation, the default location is $HOME/microfocus/config/.
• To specify your own configuration location, run the setup file with the following command-line option: -

mfconfiglocation=[location]

The setup file creates a directory in the configuration location using a 5-digit checksum of the $COBDIR
path. This is so that each configuration location is unique to each product installation. The configuration
files and directories are then placed in this COBDIR checksum directory. In the following example, the
install location generates a checksum of 39082.

The file /opt/microfocus/config/39082/COBDIRlocation.txt details the COBDIR the
configuration area is associated with.

If you have changed any other files in the original installation, you need to be copy these manually from the
backup directory, /opt/microfocus/EnterpriseDeveloper.BKP.YYYY-MM-DD.HH:MM:SS, into the
install location after the upgrade installation is complete.

You can access the configuration area from $COBDIR/etc/config.

Currently, the setup file only moves the following files and directories, where applicable:

Source Destination

$COBDIR/etc/mfds /opt/microfocus/config/39082/mfds/mfds

$COBDIR/etc/ccsid /opt/microfocus/config/39082/config/
ccsid

$COBDIR/etc/secrets /opt/microfocus/config/39082/secrets

$COBDIR/bin/mf370ctl.cfg /opt/microfocus/config/39082/config/
mf370ctl.cfg
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Source Destination

$COBDIR/bin/CCI.INI /opt/microfocus/config/39082/config/
CCI.INI

$COBDIR/deploy/.mfdeploy /opt/microfocus/config/39082/
deploy/.mfdeploy

$COBDIR/etc/cas/CTFesjcl.cfg /opt/microfocus/config/39082/cas/
CTFesjcl.cfg

$COBDIR/etc/cas/dfhdrdat /opt/microfocus/config/39082/cas/
dfhdrdat

$COBDIR/etc/commonwebadmin.json /opt/microfocus/config/39082/escwa/
commonwebadmin.json

$COBDIR/etc/mfdsacfg.xml /opt/microfocus/config/39082/mfds/
mfdsacfg.xml

$COBDIR/etc/mfdsacfg.dat /opt/microfocus/config/39082/mfds/
mfdsacfg.dat

$COBDIR/etc/mf-client.dat /opt/microfocus/config/39082/mfds/mf-
client.dat

$COBDIR/etc/mf-server.dat /opt/microfocus/config/39082/mfds/mf-
server.dat

$COBDIR/etc/cobol.dir /opt/microfocus/config/39082/config/
cobol.dir

$COBDIR/etc/cobopt /opt/microfocus/config/39082/config/
cobopt

$COBDIR/etc/cobopt64 /opt/microfocus/config/39082/config/
cobopt64

$COBDIR/etc/cobjvm.cfg /opt/microfocus/config/39082/config/
cobjvm.cfg

$COBDIR/etc/cobutf8.cfg /opt/microfocus/config/39082/config/
cobutf8.cfg

$COBDIR/etc/default.tcf /opt/microfocus/config/39082/config/
default.tcf

$COBDIR/etc/mfescache.cfg /opt/microfocus/config/39082/config/
mfescache.cfg

$COBDIR/etc/dsdef.cfg /opt/microfocus/config/39082/config/
dsdef.cfg

Licensing Coexistence when Upgrading to Release 10.0

With release 10.0 of the Enterprise Developer product suite, the SafeNet Sentinel licensing technology has
been deprecated. This can result in some compatibility issues if you install 10.0 on a machine where there
are other Micro Focus products or versions installed that use SafeNet Sentinel licensing. While the 10.0
installation process has been designed to address such issues, you should be aware of the following
scenarios and if any action might be required to ensure licensing works as expected:
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Scenarios

Your installed products
use SafeNet Sentinel
Licenses (Windows and
UNIX)

Warning: Installing 10.0 deprecates SafeNet Sentinel licensing on
the machine.

If you use SafeNet Sentinel licenses for any other Micro Focus products,
such as Enterprise Analyser or Relativity, you need to contact your account
manager to obtain AutoPass licenses for these products. See the
Troubleshooting section further in this topic, Action 7 for how to obtain a list
of your installed licenses.

Your older products use
AutoPass licenses
(Windows and UNIX)

Existing AutoPass licenses are compatible with the 10.0 products.

Upgrading to 10.0 (UNIX) After installing 10.0 on a machine with a previous version of licensing
installed, the lserv daemon is retained (and might be running) but is not
required. See Troubleshooting > Action 2 for details.

Downgrading from 10.0
(Windows and UNIX)

In order to revert to a previous version of the product (for example, if 10.0 is
installed but no longer required), the 10.0 product and licensing must be
uninstalled. See Troubleshooting > Action 1 for details.

Installing a product or
Patch Update of an older
product release (UNIX)

Use the "skip license installation" command line arguments.

• See Troubleshooting > Action 3 for details.
• Else, see Troubleshooting > Action 4 to reset mfcesd.
• SystemD may be overwritten - see Troubleshooting > Action 6.

Installing a product or
Patch Update of an older
product release (AIX only)

If after 10.0 is installed a customer installs a Patch Update for an older
release, the lserv entry is moved back to /etc/inittab.

• See Troubleshooting > Action 3 about how to avoid this.
• To correct the /etc/inittab entry, see Troubleshooting > Action 5.
• Alternatively, re-run the 10.0 license install. See Troubleshooting > Action

6.

Troubleshooting

Action 1 To reset licensing from the 10.0 installation to an older product configuration, you need to
perform the following:

Windows Uninstall the product and the License Manager from "Uninstall a Program" in the
Windows Control Panel.

UNIX Execute the following commands:

sudo $COBDIR/bin/Uninstall_[Product Name]_10.0.sh.
sudo /opt/microfocus/licensing/bin/
UnInstallMFLicenseServer.sh

Action 2 (UNIX) To disable the lserv daemon on a machine, execute the following commands:

cd /var/microfocuslicensing/bin
sudo ./stopmfcesd.sh
sudo systemctl stop MFSafeNet
sudo systemctl disable MFSafeNet

Action 3 When installing an older release or Patch Update, use -skipsafenet -skipautopass to
the install command. This will skip the licensing installation for that release.
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Action 4 To restart mfcesd from the correct location, execute the following commands:

cd /var/microfocuslicensing/bin
sudo ./stopmfcesd.sh
cd /opt/microfocus/licensing/bin
sudo ./startmfcesd.sh

Action 5 To reset the inittab on AIX 7.3/7.4:

1. Edit the /etc/inittab file.
2. Delete the line:

mFls:2345:wait:sh /var/microfocuslicensing/bin/startlserv.sh 2>&1

Action 6 To reinstall the 10.0 licensing and reset any issues from installing a previous version, execute
the following:

cd [10.0-COBDIR-location]/licensing
sudo MFLicenseServerInstall.sh force

Action 7 In order to get a list of the installed licenses:

Windows 1. From a COBOL command environment, execute mfsupportinfo.
2. View the Micro Focus Licensing section.

UNIX 1. In a terminal, run cobsetenv to set the product environment.
2. Run mfsupport.
3. See mfpoll.txt for the licenses details.

Micro Focus Enterprise Developer UNIX Components Installation Options

Installing into a different location

To install in a different location use the -installlocation="Location" parameter to specify an
alternative directory location. For example:

./setup_entdev_10.0_platform -installlocation="full path of new location"

Note: You can use variables when specifying an absolute path for –installlocation. For
example, the following examples are equivalent:

-installlocation="/home/myid/installdir"

-installlocation="$HOME/installdir"

You can see details about which additional parameters can be passed to the install script if you enter the -
help option.

Configuring the Enterprise Server installation

You can use the following options to configure the Enterprise Server installation: [ -ESsysLog="Y/N" ]
[ -ESadminID="User ID" ] [ -CASrtDir="location" ], where:

-ESsysLog Use this to enable ("Y") or disable ("N") Enterprise Server system logging. Logging is
enabled by default. Log files are saved in /var/mfcobol/logs.

-ESadminID Sets the Enterprise Server System Administrator Process User ID from the command line -
for example, -ESadminID="esadm". The default user ID is the one that runs the installer.
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-CASrtDir Specifies the location were the Enterprise Server run-time system files are placed - for
example, -CASrtDir="/home/esuser/casrt/es". The default location is /var/
mfcobol/es.

Installing Silently

You can install Micro Focus products silently by using command line parameters to specify the installation
directory, user information, and which features to install. You must execute the command with superuser
permissions.

You can use the following command line arguments to install silently on UNIX/Linux. You need to execute
the commands as root:

–silent -IacceptEULA

For example, execute:

setup_filename –silent -IacceptEULA

Installing using the TMPDIR environment variable

By default, the product installer uses /tmp for temporary files and log files during installation. If /tmp is not
available on your system you can set the environment variable TMPDIR to an alternative location:

TMPDIR=/home/user/tmp
Export TMPDIR

Then run the installation as normal.

Note:

The TMPDIR setting is lost when the installer is elevated to root user within the installer. This occurs
when you run the installer as a non-root user, and are prompted for the root password during the
installation process. Micro Focus recommends that you log in as root, set TMPDIR and then run the
installer. If you use sudo to run the installer, then use the following command-line syntax:

sudo TMPDIR=$TMPDIR setup…

or:

sudo TMPDIR=/home/user/tmp setup…

After Installing
• See Changes in Behavior or Usage in your product documentation and in the Release Notes for

important information about changes in this release that might affect existing applications.
• Check the Product Documentation section of the OpenText Support and Services Documentation Web

site for Micro Focus products for any documentation updates.

Configuring Enterprise Developer
If you have used Eclipse from the same workspace before, the Eclipse perspective settings are not reset
after installing any Micro Focus product. To pick up any new features, you must reset the perspective you
are working with after installation:

1. Open the existing workspace with this product.

You may receive some warnings or errors which you can ignore.
2. Make sure you are in the perspective you need to reset by clicking Window > Perspective > Open

Perspective > Other.
3. From the Open Perspective dialog box, click the perspective you want to reset.
4. Click OK.
5. Click Window > Perspective > Reset Perspective.
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6. When prompted, click Yes.
7. Reapply any customizations.

Enterprise Server Security Considerations
Starting with this release, the Enterprise Server security functionality provided by the VSAM External
Security Manager (VSAM ESM) module is enabled by default out of the box. This means you now need to
supply valid credentials when you interact with:

• Enterprise Server Common Web Administration (ESCWA)
• The Micro Focus Directory Server (MFDS)
• enterprise server regions via:

• ESCWA
• Certain command-line utilities (such as casstart)
• TN3270 emulator access
• The Server Explorer window in the IDE or in the new Data Tools available in 10.0
• IMTK deployment

For more information about the default VSAM Security Manager, see VSAM ESM Module in your product
Help.

Upgrading an Existing Security Configuration

If security is already configured for a domain (Data Tools, MFDS, or the default Enterprise Server security),
the installation process does not change this configuration. If data already exists in either the old or new
VSAM ESM default data directory, it will not be altered. However, Micro Focus recommends backing up the
following before reinstalling or updating the product - the Data Tools and MFDS configuration files
(commonwebadmin.json and mfdsacfg.xml), the MFDS repository data, and the VSAM ESM Module
security data. By default, the MFDS repository data and the VSAM ESM Module data are located under
%ProgramData%\Micro Focus (Windows) or $COBDIR/etc (UNIX).

Default Generated Password for SYSAD

The installation generates a random password for the system administrator account, SYSAD. To retrieve
this password, execute the following from an Enterprise Developer command prompt or Enterprise Server
command prompt (Windows) or from a terminal that has the COBOL environment set (UNIX):

mfsecretsadmin read microfocus/temp/admin

The password value stored in this vault location is not used by the default Security Manager (VSAM ESM)
to validate input credentials. Its purpose is to enable users to initially discover their randomly generated
password. Additionally, Server Explorer uses this location to pre-populate the Micro Focus Servers
connection and the credentials dialog box at region start-up. Once entered, you can optionally save the
credentials in IDE-specific storage. Micro Focus recommends that once the credentials are safely known or
changed that you remove this value from the vault (using mfsecretsadmin delete microfocus/
temp/admin).

Change the Default Password for SYSAD

Micro Focus recommends that you promptly replace this password with one that conforms to your security
policy. You can do this from the ESCWA logon page - click Change Password. Alternatively, you can use
the esfadmin SETPASSWORD command.and specifying the "vsam_esm" module file.

Authentication in the Browser-Based ESCWA

You need to provide credentials to access ESCWA. After the installation, the ESCWA logon page shows
information on how to obtain the default admin (SYSAD) generated password. You can disable this
message in the ESCWA Security Settings dialog ("Show Default Security Warning on Log On").
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For local installations, the default Directory Server will automatically be authenticated with the ESCWA
credentials. Otherwise, you might need to provide its own credentials. You may use the same credentials
as the ones for ESCWA.

Note the default 5-minute (300 second) session time out setting for inactivity in ESCWA. If required, you
can change this from the ESCWA Security Settings dialog ("Session Inactivity Timeout").

Authentication Inside the IDE and the Data Tools Utility

The Server Explorer window in the IDE and in Data Tools, requires credentials for the Micro Focus
Servers node to connect to the default local ESCWA and the MFDS. Additionally, you need to provide
credentials to start any regions. By default, the credentials will be pre-populated in the dialog using the
values stored in the microfocus/temp/admin vault location. These credentials can optionally be stored
by the IDE so they do not need to be manually input again.

Note: If you delete the SYSAD user or change the password generated for it by the installer in the
default VSAM Security Manager, you need to provide new sufficiently authorized credentials for the
Server Explorer connection.

Authentication for HACloud

HACloud will initially use the default generated "readonly" credentials specified in the microfocus/
common/readonly vault location. If ESCWA and/or the Micro Focus Directory Server are subsequently
configured with non-default credentials, you need to manually configure HACloud to use these. See
Authenticating HACloud for Work with ESCWA and MFDS in your product Help.

Fileshare

If you want to view or delete Fileshare instances in ESCWA, you now need to log on using authorized
credentials (such as the default SYSAD user).

Command-Line Utilities

There are multiple command line utilities that control and access enterprise server region. These use
Enterprise Server credentials specified as parameters - for example, casstart /z.

See Administration and Configuration Commands in your product Help for individual commands to
determine how to specify authorized credentials.

Samples and Tutorials

There are a variety of samples and tutorials supplied with the product. Many of these assume that security
is not enabled, so to work through these unaltered default security will first need to be disabled. See To
Disable the Default Enterprise Server Security Configuration in your product Help. If security is not
disabled, you will need to it take into account when you:

• Use ESCWA
• Start a region
• Run a cas command line utility
• Run a transaction using TN3270. You need to sign in via CESN.
• Submit a JCL job

In Server Explorer inside the IDE, the SignOn dialog boxes to ESCWA will have the default generated
SYSAD credentials pre-populated. If the SYSAD password has been changed, or you need to use different
credentials, you need to sign on using the required details.

Micro Focus Common Client

The mf-client.dat file which is used by the Micro Focus Common Client (MFCC), is configured out-of-
the box to use the default generated "readonly" credentials from the microfocus/common/readonly
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vault location. This means that access to the Micro Focus Directory Server using the default security
configuration works automatically for read-only access.

MFCC is used by COBOL web service proxy programs, the Interface Mapping Toolkit service-deployment
mechanism, Fileshare clients (when configured appropriately), various utilities such as cassub (depending
on the operating mode), the CICS Web Interface and CICS Web Services, and product components such
as MFCS and ESCWA. See Micro Focus Common Client in your product Help.

On Windows

Using an X Server on Windows

Some features of Enterprise Developer for Eclipse on Windows require an X Server installation such as
OpenText™ Reflection Desktop for X or Micro Focus ViewNow X.

Managing the Microsoft Build Tools and Windows SDK Packages

There are a number of COBOL development features that depend on the Microsoft Build Tools and
Windows SDK packages. By default, the product installer downloads and installs these packages to their
default locations. The installer then sets your COBOL environment to depend on those downloaded
versions.

You can use the Microsoft Build Tools and Windows SDK Packages configuration utility - cblms - to view
which versions are in use, and also configure your COBOL environment if you require something other
than the standard usage.

There is an option within the product installer to skip the installation of the default packages
(skipmstools=1); however, this does skip both packages, so make sure that you do already have the
package(s) that you require before setting this - see Microsoft Package Dependencies for details on the
package(s) you may require.

The Microsoft Build Tools and Windows SDK Configuration Utility

Use the cblms command line utility to view and set the package versions in effect for your COBOL environment.

Important: If you are updating or clearing package versions, you must run this utility from a command
prompt with administrative privileges.

Syntax:
cblms <option>

Parameters:

Note: <option> settings are case insensitive.

<option> can be one of:

-U
Updates the COBOL environment to use the latest versions of the Microsoft Build Tools
and SDK packages that are located in the default folders. Any open IDE instance or
command prompt must be restarted before these changes take effect.

-U<ms-pkg>
Updates the COBOL environment to use the latest version of the particular package type
that is located in the default folder. Any open IDE instance or command prompt must be
restarted before these changes take effect.

-U<ms-pkg>:<version>
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Updates the COBOL environment to use a specific version of the particular package type
that is located in the default folder.Any open IDE instance or command prompt must be
restarted before these changes take effect.

-U<ms-pkg>:<path>
Updates the COBOL environment to use the latest version of the particular package type
that is located in the (non-default) folder specified. Any open IDE instance or command
prompt must be restarted before these changes take effect.

-U<ms-pkg>:<path>?<version>
Updates the COBOL environment to use a specific version of the particular package type
that is located in the (non-default) folder specified. Any open IDE instance or command
prompt must be restarted before these changes take effect.

-L
Lists all versions of the Microsoft Build Tools and SDK packages that are located in the
default folders.

-L<ms-pkg>
Lists all versions of a particular package type that are located in the default folder.

-L<ms-pkg>:<path>
Lists all versions of a particular package type that are located in the (non-default) folder
specified.

-Q
Displays the versions currently in use by the COBOL environment.

-Q<ms-pkg>
Displays the version of the selected package type that is currently in use by the COBOL
environment.

-R
Clears all version information. (Only use this option when instructed to by OpenText
Support for Micro Focus Products.)

-H
Displays the available command line options.

Legend:

<ms-pkg> <ms-pkg> can be one of S or SDK for the Microsoft SDK, or B or BT for the Microsoft Build
Tools.

<path> <path> is the path in which to locate packages that are not installed to the default location for
their package type.

<version> <version> is the package version with which to update when the latest version is not the one
required. When specifying version, it must be in the form:

• n.n.n.n for a Windows SDK
• n.n.n for Build Tools
• n for list ID - the list ID is displayed using cblms -L.

The following example updates the COBOL environment to use version 10.0.17134.0 of
the Windows 10 SDK, installed in C:\WinSDK\10.

cblms -USDK:C:\WinSDK\10\10.0.17134.0
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Viewing the Product Help

Enterprise Developer is configured to display the product help available online on the OpenText Support for
Micro Focus Products website: https://www.microfocus.com/en-us/support/documentation/.

You can view the Enterprise Developer product help in one of the following ways:

Choose whether to view the help online or locally

You can configure Eclipse to show the Enterprise Developer help either online or locally:

1. In Eclipse, click Window > Preferences > Micro Focus > Help.
2. Either disable or enable Use online documentation, depending on whether you want to see the

documentation locally or online.

Online help (default)

• Click Help > Micro Focus > Product Documentation.
• Alternatively, press F1 inside the editor or from a UI part.

This opens a browser with the Enterprise Developer help.

Note: Ensure that you have an up-to-date version of your browser.

Local help

1. Configure Eclipse to use local help as detailed above.
2. Access the local help in one of the following ways:

• Click Help > Help Contents to open the Help Viewer, then open the Micro Focus-branded
documentation.

• Alternatively, press F1 inside the editor or after clicking a dialog within the UI.

Repairing on Windows

If any product files, registry settings or shortcuts are accidentally removed at any point, you can perform a
repair on the installation to replace them.

Important: Before performing a repair of the installation, Micro Focus recommends that you create
backups of any configuration files of the product that you might have changed.

To repair your installation:

1. From the Control Panel, click Uninstall a program under Programs.
2. Right-click your Micro Focus product, and select Repair.

Uninstalling

To uninstall the product, you cannot simply delete its files from your hard disk. To uninstall the product:

1. Log in with the same user-ID as you used when you installed the product.
2. Click Uninstall a program under Programs in Control Panel.
3. Select the product and click Remove or Uninstall as appropriate.

During the uninstall process, only those files added during the installation (to the installation and Samples
directories) are removed. If the installation installed the Microsoft Windows 10 SDK or Microsoft Build Tools
packages, these are left in place, although the Micro Focus-related registry entries for these packages are
removed.

If the product directory has not been removed, delete any unwanted files and subdirectories within it using
Windows Explorer.
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Note: The installer creates separate installations for Enterprise Developer Micro Focus Analysis
Services Integration, and Micro Focus License Administration. Uninstalling only Enterprise Developer
does not automatically uninstall the Micro Focus License Administration or any of the prerequisite
software.

To completely remove the product you must uninstall the Micro Focus License Administration as well.

You can optionally remove the prerequisite software. For instructions, check the documentation of the
respective software vendor.

Some registry entries are not removed by the uninstallation process and you need to manually delete
them.

The following folders might not be removed:

• The Micro Focus Product Name folder in the Start menu - you can delete it manually.
• %systemdrive%\Users\Public\Documents\Micro Focus - includes the binaries and the log

files of the samples which you have built.
• %ProgramData%\Micro Focus - includes some data files used by the Micro Focus licensing system.
• %Program Files%\Micro Focus - you can delete it manually.

To silently uninstall the product, you need the setup file and you need to execute the following at the
command line:

start /wait install-file.exe /quiet /uninstall

In addition, the following registry entries are not removed. These are created the first time that an
Enterprise Server that has been enabled for performance monitoring starts up:

• Micro Focus Server\Performance\Active Servers
• Micro Focus Server\Performance\PerfIniFile

On UNIX

Configuring the Remote System Explorer Support

Note: The following only applies if you are using Micro Focus Enterprise Developer UNIX
Components with Enterprise Developer for Eclipse.

The remote development support from the Eclipse IDE relies upon Micro Focus Enterprise Developer UNIX
Components running on the UNIX machine and handling all requests from the IDE for building and
debugging programs. Micro Focus Enterprise Developer UNIX Components provides a UNIX daemon, the
Remote Development Option (RDO) daemon, which initiates the RDO as Eclipse clients connect to it.
Whichever environment is used to start the RDO daemon will be inherited for all servers and hence all build
and debug sessions.

Configuring the Environment

You may need to configure some aspects of the environment before you start the daemon. This is because
when a build or debug session is initiated from one of the Eclipse clients, the environment used will be
inherited from whatever was used to start the daemon. A typical example of the kind of environment that
might need to be set up would include database locations and settings for SQL access at build/run time.

Starting the Daemon

Important: Before starting the daemon you must have the following on your UNIX machine:

• A version of Perl.
• A supported version of Java - current minimum support is Java 17.
• The as (assembler) and ld (linking) programs on the path, as specified by the PATH environment

variable.
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The daemon can be run with or without parameters. If no parameters are specified, the process relies on
the default values in $COBDIR/remotedev/rdo.cfg.

Important: If Micro Focus Enterprise Developer UNIX Components has been installed without
superuser credentials (see Installing Without Superuser Credentials), you must ensure that the
following commands are carried out using superuser credentials. This is because the Micro Focus
Dev Hub RSE and Micro Focus Dev Hub using SAMBA, NFS, etc connection types require elevated
privileges to authenticate upon connection to the server.

Use the following syntax to start the daemon on the remote host:

$COBDIR/remotedev/startrdodaemon [<port> <low port>-<high port>] 

where:

• <port> is the port number that the daemon should use to listen for connections from Eclipse. If no value
is given, it will default to the value specified in $COBDIR/remotedev/rdo.cfg; the default value on
installation is 4075.

Example: To start the daemon listening on port 4999:

$COBDIR/remotedev/startrdodaemon 4999

This command will override the default port in rdo.cfg.
• <low port>-<high port> is the range of ports on which the servers (launched by the daemon) should use

to communicate with Eclipse on the client machine. If no values are given, the range defaults to that
specified in $COBDIR/remotedev/rdo.cfg; the default range on installation is 10000-10003.

Example: To instruct the daemon (on port 4999) to instantiate servers using a range of ports
4090-4993:

$COBDIR/remotedev/startrdodaemon 4999 4090-4993

This command will also override the default ports in rdo.cfg.

If the server has an active firewall, it is important that these ports are open in the firewall settings. You can
use the configrdo utility to set the default ports in rdo.cfg to ones already open in the firewall. If you
are running on a supported Red Hat platform, you can also use the utility to open the required ports in the
active firewall. See Configuring the firewall for more information.

Stopping the Daemon

To stop the daemon, type the following command with super-user authority:

$COBDIR/remotedev/stoprdodaemon <port>

Enabling SHIFT-JIS

By default, support for the character encoding for the Japanese language, Shift-JIS, is not available on
Ubuntu and on RedHat OS version 8 or later.

You need to generate the Shift JIS locale on your machine to be able to execute Shift-JIS applications on
these platforms. You can do this as follows:

1. On RedHat 8, ensure that the glibc-locale-source package is installed.
2. Execute the following command with superuser rights in order to generate a Shift-JIS locale using the

charset:

sudo localedef -f SHIFT_JIS -i ja_JP ja_JP.sjis

3. Set the COBUTF8 environment variable to the generated Shift-SJIS locale and LANG to a UTF8 locale:

export COBUTF8=ja_JP.sjis
export LANG=ja_JP.UTF-8

4. Run the cobutf8 utility:

cobutf8 <command>
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See your product documentation for more details about cobutf8.

Repairing on UNIX

If a file in the installation of the product becomes corrupt, or is missing, we recommend that you reinstall
the product.

Before performing a repair of the installation, Micro Focus recommends that you create backups of any
configuration files of the product that you might have changed.

Uninstalling

Before you uninstall the product, ensure that the Enterprise Server Common Web Administration
(ESCWA), the Micro Focus Directory Server, and any enterprise server regions are stopped.

To uninstall this product:

1. Execute as root the Uninstall_EnterpriseDeveloper10.0.sh script in the $COBDIR/bin
directory.

Note: The installer creates separate installations for the product and for Micro Focus License
Administration. Uninstalling the product does not automatically uninstall the Micro Focus License
Administration or the prerequisite software. To completely remove the product you must uninstall the
Micro Focus License Administration as well.

To uninstall Micro Focus License Administration:

1. Execute as root the UnInstallMFLicenseServer.sh script in the /opt/microfocus/
licensing/bin directory.

The script does not remove some of the files as they contain certain system settings or licenses.

You can optionally remove the prerequisite software. For instructions, check the documentation of the
respective software vendor.

Installing Enterprise Developer for Eclipse (UNIX)

Before Installing

Downloading the Product
1. Log into the Software Licenses and Downloads (SLD) site at https://sld.microfocus.com/mysoftware/

download/downloadCenter.
2. Select your account and click Entitlements.
3. Search for the product by using any of the available search parameters.
4. Click Show all entitlements.
5. Click Get Software in the Action column for the product you want to download or update.

In the File Type column, you see entries for "Software" for any GA products, and "Patch" for any patch
updates.

6. Click Download on the relevant row.

System Requirements for Enterprise Developer for Eclipse (UNIX)

Hardware Requirements for Enterprise Developer for Eclipse

Enterprise Developer has the following requirements in addition to the requirements of Eclipse. See the
Eclipse documentation for details of its requirements.
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The disk space requirements are approximately:

Platform Installer type Setup

file size

Disk space

required for

the installation

Disk space

required for

running

the product

Licensing
technology

x86-64
running Red
Hat Linux

Micro Focus 2.83 GB 8.33 GB 4.17 GB 91 MB

x86-64
running SUSE
SLES

Micro Focus 1.74 GB 6.97 GB 3.49 GB 86 MB

System Z
running SUSE
SLES

Micro Focus 888 MB 3.55 GB 1.78 GB 50 MB

x64 running
Amazon Linux
2

Micro Focus 1.74 GB 6.96 GB 3.48 GB 90 MB

x64 running
Ubuntu

Micro Focus 1.74 GB 6.97 GB 3.49 GB 86 MB

x86-64
running Rocky
Linux

Micro Focus 2.83 GB 8.33 GB 4.17 GB 91 MB

Operating Systems Supported

For a list of supported operating systems, see Supported Operating Systems and Third-party Software in
your product documentation.

On some platforms, there is only a 64-bit version of this product. 64-bit versions of the product support
compiling to and running 64-bit programs only.

Software Requirements

The setup file requires that the following software and libraries are installed before you start the installation,
and that certain environment variables are set.

• Software required by the setup file
• Libraries required by the setup file
• Required environment variables
• Software installed by the setup file
• Requirements for running the product
• License Manager requirements

Software required by the setup file

The following software must be installed in advance:

• Java versions 17 or 21 from Adoptium (such as the Adoptium OpenJDK Temurin 17 (LTS) with HotSpot)
and Oracle are required for Enterprise Developer for Eclipse.

• The unzip utility.
• The "awk", "ed", "ps", "sed", tar", "sed", and "which" utilities must be installed and added to the PATH.

• On AIX 7.2 and 7.3, the installer requires the Open XL C/C++ 17.1 Clang C++ compiler. You need to
install the Open XL C/C++ 17.1 runtime environment and utilities package.
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• If SELinux is installed and you plan to use anything other than core COBOL functionality, or plan to use
Enterprise Server within an environment with ASLR enabled, the "SELINUX" configuration must be
disabled. To do this, set SELINUX=disabled in /etc/selinux/config.

Libraries required by the setup file

The 32-bit libraries listed below are required on both 32-bit and on 64-bit Operating Systems for this
product to install and work correctly.

If installing on a 64-bit OS, the 32-bit libraries are not installed by default and must be installed before you
start the installation.

Library Bitism Platform

32-bit 64-bit SUSE 15 Red Hat 8 Ubuntu 20.04,
22.04

Amazon Linux
2

glibc X X X

libgcc X X X X

libgc1c2 X X

libstdc++ X X X X

glibc-locale X X X

libXtst6 X X X

libXtst X X X

glibc-devel X X

gtk3 X X5 X5

PackageKit-gtk3 X X5 X5

libcanberra-gtk3 X X5 X5

webkitgtk3 X X5

webkit2gtk3 X X5

xterm Any
version

Any
version

X X X X

unzip Any
version

Any
version

X X

libgnome X

libelf-
devel-0.137-8.19**

X

libelf1-0.137-8.19** X

libelf1-32bit-0.137-
8.19**

X

libgtk-3-0 X X7 X

gtk3-tools X X7

gcc23 X X X X X

cpp2 X X X

ld2 X X X

libnotify-tools4 X X X
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Library Bitism Platform

32-bit 64-bit SUSE 15 Red Hat 8 Ubuntu 20.04,
22.04

Amazon Linux
2

libnotify X X

libjasper1 X X

libjasper4 X X

systemd-libs6 X

Note:

• Libraries marked with an 'X' are not included in the platform and need to be installed separately.
• * Additional libraries required to use the core_on_error runtime variable. The gdb packages (for the

GNU Project Debugger) can be installed from the install media for your OS.
• 2On Red Hat, these libraries are required to enable COBOL and PL/I to compile.
• 3On Red Hat, only the 64-bit gcc libraries are required.
• 4For SUSE 15 and later, you might need to install the Notifications Library tools (libnotify-tools).

This is to enable notifications to be displayed by the notify-send tool when starting Enterprise
Developer for Eclipse from a desktop icon. Execute the following command to install the libnotify-
tools library:

zypper install libnotify-tools

• 5The minimum GTK support required is 3.22. Some platforms meet this requirement without the
need of installing the libraries manually.

• 6Only required if using 32-bit enterprise server regions on Red Hat where 32-bit systemd libraries
are not installed.

• **Operating system libraries required for PL/I support on both SUSE and Red Hat.

Visit the Red Hat Web site for more information.

Required environment variables

Before you start the installation, you need to set the environment as follows:

• Set the JAVA_HOME environment variable. When installing the product, set this variable to a 64-bit
Java installation or the installation terminates. For example, execute the following:

export JAVA_HOME=java_install_dir

where java_install_dir is the path to the JAVA installation directory such as /usr/java/javan.n
• Add $JAVA_HOME/bin to your system PATH variable. To do this, execute:

export PATH=$JAVA_HOME/bin:$PATH

• You need to set the LANG environment variable to pick up localized messages. If you do not set it as
specified here, the installation will run but you might experience unexpected behavior from the installer.

The LANG settings are English and Japanese only so set it to one of the following locales:

C, default, en_GB, en_GB.UTF-8, en_US, en_US.UTF-8

ja_JP, ja_JP.SJIS, ja_JP.UTF-8, ja_JP.eucJP, ja_JP.eucjp, ja_JP.sjis, 
ja_JP.ujis, ja_JP.utf8, japanese

You can set LANG before running the setup file as follows:

export LANG=C

Alternatively, add it to the start of the setup command line:

LANG=C ./setupfilename

See Using the LANG Environment Variable for details.
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Software installed by the setup file

• The setup file installs Enterprise Developer and the 64-bit version of Eclipse 4.28 (2023-06). After the
installation, you can install Enterprise Developer as a plug-in into other Eclipse 4.28 (2023-06)
instances available on the same machine - see Installing Enterprise Developer into other instances of
Eclipse.

Note: On SUSE platforms, you can only use the 64-bit version of Eclipse to produce 64-bit
applications; on other 64-bit platforms, you can use Eclipse to produce both 32-bit and 64-bit
applications.

• Xterm, the terminal emulator for the X Window System, is part of your UNIX/Linux distribution but is not
always installed by default. Use your UNIX/Linux installation media to install it.

Requirements for running the product

• Java 17 (64-bit) or 21 is required to run the Eclipse IDE. The recommended version is Adoptium's
OpenJDK Temurin 17 (LTS) with HotSpot. On Windows, the installer automatically installs Adoptium's
OpenJDK Temurin 17 (LTS) with HotSpot. On Linux, you need to install Java before you install this
product. You can download Adoptium's OpenJDK Temurin 17 (LTS) with HotSpot from Adoptium's Web
site and unpack the archive anywhere on your machine.

License Manager requirements

• For local servers, you do not need to install the Micro Focus License Administration tool separately, as
the setup file installs a new Enterprise Developer client and a new licensing server on the same
machine.

• If you have any network license servers, you must update them before you update the client machines.
• If you are upgrading from Enterprise Developer release 2.2 or earlier, uninstall the license manager

before installing the product.

You can download the new version of the license server software by following these steps:

1. Log into the Software Licenses and Downloads (SLD) site at https://sld.microfocus.com/mysoftware/
download/downloadCenter.

2. Select your account and click Downloads.
3. Select a product and a product version from your orders.
4. In the list of software downloads, locate the License Manager.
5. Click Download to download an archive with the installers.
6. Run the installer suitable for your Operating System to install License Manager on your machine.

Installation on UNIX and Linux (Known Issues)

Installing on Linux

On Linux, the RPM installer for Enterprise Developer for Eclipse installs a 64-bit version of Java. When you
start the installation, if the 32-bit version of Java is already installed on your Linux machine, you might not
be able to install Enterprise Developer. This is a known issue with the Oracle Java installers for Linux which
prevents you from installing both the 32-bit and the 64-bit versions of Java on the same machine. To work
around this problem:

• Download the 64-bit Java distribution in a compressed .tar format from the Oracle Web site.
• Untar the distribution into a location different from the one used for the 32-bit Java version. For example,

untar in /usr/local/java64 and not in /usr/local/java.
• Set JAVA_HOME and LD_LIBRARY_PATH to the 64-bit version of Java so that it is used to install and

run Enterprise Developer.
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Installing on Ubuntu 10.10 and later

Every version of Ubuntu starting with 10.10 comes with a setting that prevents an application from using
ptrace to attach to another process. This prevents the PL/I debugger from attaching to user processes, and
therefore debugging fails. To prevent this problem, disable the offending setting as follows before installing
Enterprise Developer:

1. Using any text editor, open the /proc/sys/kernel/yama/ptrace_scope file.
2. Set pctrace=0.

For more information, see Debugging applications that run on Ubuntu (ptrace restriction).

Installing on Red Hat 8.x s390

On Red Hat 8.x s390, the RPM non-root install method is not supported due to errors given by cpio. You
receive the following messages:

error: unpacking of archive failed on file /usr/lib/.build-id/1b/
af99f26c6b4c00ca499a3199a574b73aeb3854;6092b79c: cpio: symlink failed - No 
such file or directory
error: Micro_Focus_cobol_server-7.0.0.0-100700.s390x: install failed

As a result, the installation in this scenario is incomplete.

Installing while using AFS/Kerberos authentication

If you are using AFS/Kerberos authentication to log onto your Linux system then you need to ensure you
have a local user ID which SOA and Enterprise Developer components of the product can use. This user
ID must be set up prior to running the installer. When running the installer you need to specify -
ESadminID=[User ID] on the command line so it is used by the installer.

License Server

You need to configure the computer hostname to ensure the license server will start properly.

To avoid performance issues, "localhost" and the computer hostname must not both be mapped to IP
address 127.0.0.1. You should only map "localhost" to IP address 127.0.0.1.

The following is an example of how to specify these entries correctly in the /etc/hosts file:

127.0.0.1 localhost.localdomain localhost
IP machinelonghostname machineshorthostname

where IP is the unique IP address of the computer in xx.xx.xx.xx format.

Basic Installation
The instructions in this section apply when you are performing a basic installation of this product for the
first time. If you are an administrator, you can perform a basic installation on a local machine before
performing a more advanced installation when rolling out the product to developers within your
organization.

For considerations when installing this product as an upgrade, for additional installation options or non-
default installations and for installing the mainframe components, see Advanced Installation Tasks in your
product Help.

Installing the software
Micro Focus offers two types of installers on UNIX and Linux - a proprietary installer for installing on UNIX
and Linux and a standard RPM (RPM Package Manager) installer for installing on Linux. See your product
Help for instructions on how to use the RPM installer.

Before starting the installation, see Software Requirements.
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These are the steps to install this product using the proprietary Micro Focus installer:

1. Give execute permissions to the setup file:

chmod +x setup_entdev_edeclipse_10.0_platform

2. Run the setup file with superuser permissions:

./setup_entdev_edeclipse_10.0_platform

If you don't run this as superuser, you are prompted to enter the superuser password during the install.

The COBOL environment is installed by default into /opt/microfocus/EnterpriseDeveloper,
(COBDIR). A full version of Eclipse, with the Micro Focus plugins already installed, is present in the
$COBDIR/eclipse directory.

To install in a different location use the -installlocation="Location" parameter to specify an
alternative directory location. For example:

./setup_entdev_edeclipse_10.0_platform -installlocation="full path of new 
location"

Note: You can use variables when specifying an absolute path for –installlocation. For
example, the following examples are equivalent:

-installlocation="/home/myid/installdir"

-installlocation="$HOME/installdir"

You can see details about which additional parameters can be passed to the install script if you enter
the -help option.

Note: See Installing in an Ubuntu Docker Image Running on Windows 11 for specific installation
instructions for this scenario.

AutoPass Licensing considerations

• The installation of this product could affect the AutoPass licensed components running on your
machine. During installation, the licensing shuts down to allow files to be updated. To ensure the
processes running on your machine are not affected, you need to use the -skipautopass option, which
skips the installation of AutoPass:

./setup file -skipautopass

• To protect the AutoPass installation from accidental updating, you can create an empty file named
SKIP_AUTOPASS_INSTALL in /opt/microfocus/licensing as follows:

touch /opt/microfocus/licensing/SKIP_AUTOPASS_INSTALL

While the file is present, the AutoPass installer does not make changes to the installation or shutdown
the running license daemons. If licensing needs to be updated later, you can rerun the
MFLicenseServerInstall.sh from within the $COBDIR/licensing folder with the force command
line option:

cd $COBDIR/licensing
./MFLicenseServerInstall.sh force

Setting up the environment
If you have installed the product to a directory other than the default one, you need to set the environment
as described below.

Note: The default directory is /opt/microfocus/EnterpriseDeveloper.

1. To set up your product, execute:

. <product-install-dir>/bin/cobsetenv

2. To verify that your product is installed, execute:

cob -V
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Important: These commands set the environment only for the current shell. You need to execute
them for each new shell that you start.

To avoid having to run cobsetenv for every shell, add these commands to the shell initialization files
(such as /etc/profile, /etc/bashrc).

Note that cobsetenv is only compatible with POSIX-like shells, such as bash, ksh, or XPG4 sh. It is
not compatible with C-shell or pre-XPG4 Bourne shell.

Configuring licensing for older products

If you use release 10.0 and previous releases on the same machine on UNIX, you need to the set the
environment variable MFCES_INIT_LOCATION to /opt/microfocus/licensing/bin/ces.ini in
order for licensing to work for the older products. Also, see Advanced Installation Tasks > Licensing
Coexistence when Upgrading to Release 10.0 in the Installation section.

Starting the product
To start Eclipse:

• If you are using a GUI interface, double-click the product icon (automatically installed on your desktop).

Note: The installer automatically creates a shortcut icon for the product on the desktop for the user
for which you ran the install script. If you need to create desktop icons for other users' desktops on
the same machine, or if the icon was not created on the desktop for the root user, run the following
shell script as the user you need to login as: $COBDIR/bin/createdesktopicon.sh

• If you are using a non-GUI interface, such as a terminal emulator, type the following from a command
prompt:

eclipse

Advanced Installation Tasks
This section includes instructions about how to perform a non-default installation, install this product as an
upgrade, or about how to install the additional components.

The advanced installation tasks include:

• Installing as an Upgrade - included in these Release Notes
• Command line installation options - included in these Release Notes
• Installing using an RPM installer on Linux - available in the product Help and in the Micro Focus

Infocenter
• Installing and licensing Micro Focus Rumba - available in the product Help and in the Micro Focus

Infocenter
• Installing into other instances of Eclipse - available in the product Help and in the Micro Focus

Infocenter
• Installing the Mainframe Components, - Mainframe Access Server, Application Workflow Manager into

IDz, z/Server - available in the product Help and in the Micro Focus Infocenter
• Installing on Microsoft Terminal Server and Citrix - available in the product Help and in the Micro Focus

Infocenter

Click here to see this information on the Product Documentation pages on Micro Focus OpenText Support
for Micro Focus Products.

Installing in an Ubuntu WSL2 on Windows
The following instructions apply when you install the product inside Ubuntu 20.04 WSL2 on Windows.

Prerequisites

You need to have a new instance of a Ubuntu 20.04 WSL2 running on Windows.
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1. In Windows, open the Ubuntu WSL2 console.
2. Download and install Java. Eclipse supports versions 17 or 21.
3. Create a symbolic link in Ubuntu from java-install-dir/bin/java to /usr/bin/java.

This enables the installer to locate Java when you run commands as the root user.
4. Execute the following commands to install the prerequisites for Enterprise Developer:

sudo apt-get update
sudo apt-get install libgc1c2
sudo apt-get install libgtk-3-0
sudo apt-get install libnotify-bin
sudo apt-get install unzip
sudo apt-get install xterm
sudo apt-get install nasm
sudo apt-get install gcc

Installing the product

• To install the product, execute:

sudo ./setup_enterprisedeveloper_deveclipse_24.3_ubuntu_x64

• Follow the rest of the instructions in these Install Notes to license the product, and to set the
environment.

Known issues in Ubuntu running on Windows 11

• The Eclipse icon in the Windows Start menu does not work.
• If you reset Ubuntu 20.04 WSL2, the Micro Focus icons created in Ubuntu are not removed from the

Start menu.

Installing as an upgrade
This release works concurrently with the previous version of Enterprise Developer, so you do not need to
uninstall it. See the rest of this topic for considerations when installing alongside older releases.

Install the latest version in a different location and set the environment to point to it. To do this, run the
Enterprise Developer installer with the –installlocation option:

1. Execute the following command:

. /InstallFile -installlocation="/opt/microfocus/EnterpriseDeveloper"

Note: You can use variables when specifying an absolute path for –installlocation. For
example, the following examples are equivalent:

-installlocation="/home/myid/installdir"

-installlocation="$HOME/installdir"

2. Execute cobsetenv to set the environment and point to the new install location:

. <product-install-dir>/bin/cobsetenv

Note: cobsetenv is only compatible with POSIX-like shells, such as bash, ksh, or XPG4 sh. It is
not compatible with C-shell or pre-XPG4 Bourne shell.

Preserving the Licensing Configuration Alongside Older Releases

The following is required when you use release 10.0 alongside earlier supported releases of this product
on the same machine. The licensing configuration file has changed in release 10.0 and you need to ensure
that the older releases do not overwrite it as this can result in issue with licensing and auto-start setup.

You can do this in one of the following ways:
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• Execute the following after you install release 10.0:

touch /var/microfocuslicensing/SKIP_SAFENET_INSTALL
touch /opt/microfocus/licensing/SKIP_AUTOPASS_INSTALL

• Alternatively, when installing releases earlier than 10.0, use the following command line options during
the installation:

-skipsafenet -skipautopass

This skips the license installation step for those releases and preserves the licensing configuration for
release 10.0.

Preserving Product Configuration

The following information applies when you are upgrading from releases 8.0, 9.0, and above.

If you install this release to the same install location as release 8.0 or above, the product in the current
location is moved to a backup directory name.

For example, if the 7.0 product is installed in the default install location, /opt/microfocus/
EnterpriseDeveloper, during the installation process it is moved to /opt/microfocus/
EnterpriseDeveloper.BKP.YYYY-MM-DD.HH:MM:SS. The new release will be installed in /opt/
microfocus/EnterpriseDeveloper. The backup location will store your original installation along with
any files you deployed to that directory. It will also contain any configuration files you modified post-install.

When installing 9.0 and above the installer moves a number of specific configuration files to a different
configuration location and symbolically links them back to the new release install location. The
configuration location will be one of the following:

• The default config location is /opt/microfocus/config/.
• For non-root installation, the default location is $HOME/microfocus/config/.
• To specify your own configuration location, run the setup file with the following command-line option: -

mfconfiglocation=[location]

The setup file creates a directory in the configuration location using a 5-digit checksum of the $COBDIR
path. This is so that each configuration location is unique to each product installation. The configuration
files and directories are then placed in this COBDIR checksum directory. In the following example, the
install location generates a checksum of 39082.

The file /opt/microfocus/config/39082/COBDIRlocation.txt details the COBDIR the
configuration area is associated with.

If you have changed any other files in the original installation, you need to be copy these manually from the
backup directory, /opt/microfocus/EnterpriseDeveloper.BKP.YYYY-MM-DD.HH:MM:SS, into the
install location after the upgrade installation is complete.

You can access the configuration area from $COBDIR/etc/config.

Currently, the setup file only moves the following files and directories, where applicable:

Source Destination

$COBDIR/etc/mfds /opt/microfocus/config/39082/mfds/mfds

$COBDIR/etc/ccsid /opt/microfocus/config/39082/config/
ccsid

$COBDIR/etc/secrets /opt/microfocus/config/39082/secrets

$COBDIR/bin/mf370ctl.cfg /opt/microfocus/config/39082/config/
mf370ctl.cfg
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Source Destination

$COBDIR/bin/CCI.INI /opt/microfocus/config/39082/config/
CCI.INI

$COBDIR/deploy/.mfdeploy /opt/microfocus/config/39082/
deploy/.mfdeploy

$COBDIR/etc/cas/CTFesjcl.cfg /opt/microfocus/config/39082/cas/
CTFesjcl.cfg

$COBDIR/etc/cas/dfhdrdat /opt/microfocus/config/39082/cas/
dfhdrdat

$COBDIR/etc/commonwebadmin.json /opt/microfocus/config/39082/escwa/
commonwebadmin.json

$COBDIR/etc/mfdsacfg.xml /opt/microfocus/config/39082/mfds/
mfdsacfg.xml

$COBDIR/etc/mfdsacfg.dat /opt/microfocus/config/39082/mfds/
mfdsacfg.dat

$COBDIR/etc/mf-client.dat /opt/microfocus/config/39082/mfds/mf-
client.dat

$COBDIR/etc/mf-server.dat /opt/microfocus/config/39082/mfds/mf-
server.dat

$COBDIR/etc/cobol.dir /opt/microfocus/config/39082/config/
cobol.dir

$COBDIR/etc/cobopt /opt/microfocus/config/39082/config/
cobopt

$COBDIR/etc/cobopt64 /opt/microfocus/config/39082/config/
cobopt64

$COBDIR/etc/cobjvm.cfg /opt/microfocus/config/39082/config/
cobjvm.cfg

$COBDIR/etc/cobutf8.cfg /opt/microfocus/config/39082/config/
cobutf8.cfg

$COBDIR/etc/default.tcf /opt/microfocus/config/39082/config/
default.tcf

$COBDIR/etc/mfescache.cfg /opt/microfocus/config/39082/config/
mfescache.cfg

$COBDIR/etc/dsdef.cfg /opt/microfocus/config/39082/config/
dsdef.cfg

Licensing Coexistence when Upgrading to Release 10.0
With release 10.0 of the Enterprise Developer product suite, the SafeNet Sentinel licensing technology has
been deprecated. This can result in some compatibility issues if you install 10.0 on a machine where there
are other Micro Focus products or versions installed that use SafeNet Sentinel licensing. While the 10.0
installation process has been designed to address such issues, you should be aware of the following
scenarios and if any action might be required to ensure licensing works as expected:
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Scenarios

Your installed products
use SafeNet Sentinel
Licenses (Windows and
UNIX)

Warning: Installing 10.0 deprecates SafeNet Sentinel licensing on
the machine.

If you use SafeNet Sentinel licenses for any other Micro Focus products,
such as Enterprise Analyser or Relativity, you need to contact your account
manager to obtain AutoPass licenses for these products. See the
Troubleshooting section further in this topic, Action 7 for how to obtain a list
of your installed licenses.

Your older products use
AutoPass licenses
(Windows and UNIX)

Existing AutoPass licenses are compatible with the 10.0 products.

Upgrading to 10.0 (UNIX) After installing 10.0 on a machine with a previous version of licensing
installed, the lserv daemon is retained (and might be running) but is not
required. See Troubleshooting > Action 2 for details.

Downgrading from 10.0
(Windows and UNIX)

In order to revert to a previous version of the product (for example, if 10.0 is
installed but no longer required), the 10.0 product and licensing must be
uninstalled. See Troubleshooting > Action 1 for details.

Installing a product or
Patch Update of an older
product release (UNIX)

Use the "skip license installation" command line arguments.

• See Troubleshooting > Action 3 for details.
• Else, see Troubleshooting > Action 4 to reset mfcesd.
• SystemD may be overwritten - see Troubleshooting > Action 6.

Installing a product or
Patch Update of an older
product release (AIX only)

If after 10.0 is installed a customer installs a Patch Update for an older
release, the lserv entry is moved back to /etc/inittab.

• See Troubleshooting > Action 3 about how to avoid this.
• To correct the /etc/inittab entry, see Troubleshooting > Action 5.
• Alternatively, re-run the 10.0 license install. See Troubleshooting > Action

6.

Troubleshooting

Action 1 To reset licensing from the 10.0 installation to an older product configuration, you need to
perform the following:

Windows Uninstall the product and the License Manager from "Uninstall a Program" in the
Windows Control Panel.

UNIX Execute the following commands:

sudo $COBDIR/bin/Uninstall_[Product Name]_10.0.sh.
sudo /opt/microfocus/licensing/bin/
UnInstallMFLicenseServer.sh

Action 2 (UNIX) To disable the lserv daemon on a machine, execute the following commands:

cd /var/microfocuslicensing/bin
sudo ./stopmfcesd.sh
sudo systemctl stop MFSafeNet
sudo systemctl disable MFSafeNet

Action 3 When installing an older release or Patch Update, use -skipsafenet -skipautopass to
the install command. This will skip the licensing installation for that release.
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Action 4 To restart mfcesd from the correct location, execute the following commands:

cd /var/microfocuslicensing/bin
sudo ./stopmfcesd.sh
cd /opt/microfocus/licensing/bin
sudo ./startmfcesd.sh

Action 5 To reset the inittab on AIX 7.3/7.4:

1. Edit the /etc/inittab file.
2. Delete the line:

mFls:2345:wait:sh /var/microfocuslicensing/bin/startlserv.sh 2>&1

Action 6 To reinstall the 10.0 licensing and reset any issues from installing a previous version, execute
the following:

cd [10.0-COBDIR-location]/licensing
sudo MFLicenseServerInstall.sh force

Action 7 In order to get a list of the installed licenses:

Windows 1. From a COBOL command environment, execute mfsupportinfo.
2. View the Micro Focus Licensing section.

UNIX 1. In a terminal, run cobsetenv to set the product environment.
2. Run mfsupport.
3. See mfpoll.txt for the licenses details.

Installation Options

Installing into a different location

To install in a different location use the -installlocation="Location" parameter to specify an
alternative directory location. For example:

./setup_entdev_edeclipse_10.0_platform -installlocation="full path of new 
location"

Note: You can use variables when specifying an absolute path for –installlocation. For
example, the following examples are equivalent:

-installlocation="/home/myid/installdir"

-installlocation="$HOME/installdir"

You can see details about which additional parameters can be passed to the install script if you enter the -
help option.

Configuring Enterprise Server

You can use the following options to configure the Enterprise Server installation: [ -ESsysLog="Y/N" ]
[ -ESadminID="User ID" ] [ -CASrtDir="location" ], where:

-ESsysLog Use this to enable ("Y") or disable ("N") Enterprise Server system logging. Logging is
enabled by default. Log files are saved in /var/mfcobol/logs.

-ESadminID Sets the Enterprise Server System Administrator Process User ID from the command line -
for example, -ESadminID="esadm". The default user ID is the one that runs the installer.
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-CASrtDir Specifies the location were the Enterprise Server run-time system files are placed - for
example, -CASrtDir="/home/esuser/casrt/es". The default location is /var/
mfcobol/es.

Installing Silently

You can install Micro Focus products silently by using command line parameters to specify the installation
directory, user information, and which features to install. You must execute the command with superuser
permissions.

You can use the following command line arguments to install silently on UNIX/Linux. You need to execute
the commands as root:

–silent -IacceptEULA

For example, execute:

setup_filename –silent -IacceptEULA

After Installing
• See Changes in Behavior or Usage in your product documentation and in the Release Notes for

important information about changes in this release that might affect existing applications.
• Check the Product Documentation section of the OpenText Support and Services Documentation Web

site for Micro Focus products for any documentation updates.

Configuring Enterprise Developer
If you have used Eclipse from the same workspace before, the Eclipse perspective settings are not reset
after installing any Micro Focus product. To pick up any new features, you must reset the perspective you
are working with after installation:

1. Open the existing workspace with this product.

You may receive some warnings or errors which you can ignore.
2. Make sure you are in the perspective you need to reset by clicking Window > Perspective > Open

Perspective > Other.
3. From the Open Perspective dialog box, click the perspective you want to reset.
4. Click OK.
5. Click Window > Perspective > Reset Perspective.
6. When prompted, click Yes.
7. Reapply any customizations.

Enterprise Server Security Considerations
Starting with this release, the Enterprise Server security functionality provided by the VSAM External
Security Manager (VSAM ESM) module is enabled by default out of the box. This means you now need to
supply valid credentials when you interact with:

• Enterprise Server Common Web Administration (ESCWA)
• The Micro Focus Directory Server (MFDS)
• enterprise server regions via:

• ESCWA
• Certain command-line utilities (such as casstart)
• TN3270 emulator access
• The Server Explorer window in the IDE or in the new Data Tools available in 10.0
• IMTK deployment
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For more information about the default VSAM Security Manager, see VSAM ESM Module in your product
Help.

Upgrading an Existing Security Configuration

If security is already configured for a domain (Data Tools, MFDS, or the default Enterprise Server security),
the installation process does not change this configuration. If data already exists in either the old or new
VSAM ESM default data directory, it will not be altered. However, Micro Focus recommends backing up the
following before reinstalling or updating the product - the Data Tools and MFDS configuration files
(commonwebadmin.json and mfdsacfg.xml), the MFDS repository data, and the VSAM ESM Module
security data. By default, the MFDS repository data and the VSAM ESM Module data are located under
%ProgramData%\Micro Focus (Windows) or $COBDIR/etc (UNIX).

Default Generated Password for SYSAD

The installation generates a random password for the system administrator account, SYSAD. To retrieve
this password, execute the following from an Enterprise Developer command prompt or Enterprise Server
command prompt (Windows) or from a terminal that has the COBOL environment set (UNIX):

mfsecretsadmin read microfocus/temp/admin

The password value stored in this vault location is not used by the default Security Manager (VSAM ESM)
to validate input credentials. Its purpose is to enable users to initially discover their randomly generated
password. Additionally, Server Explorer uses this location to pre-populate the Micro Focus Servers
connection and the credentials dialog box at region start-up. Once entered, you can optionally save the
credentials in IDE-specific storage. Micro Focus recommends that once the credentials are safely known or
changed that you remove this value from the vault (using mfsecretsadmin delete microfocus/
temp/admin).

Change the Default Password for SYSAD

Micro Focus recommends that you promptly replace this password with one that conforms to your security
policy. You can do this from the ESCWA logon page - click Change Password. Alternatively, you can use
the esfadmin SETPASSWORD command.and specifying the "vsam_esm" module file.

Authentication in the Browser-Based ESCWA

You need to provide credentials to access ESCWA. After the installation, the ESCWA logon page shows
information on how to obtain the default admin (SYSAD) generated password. You can disable this
message in the ESCWA Security Settings dialog ("Show Default Security Warning on Log On").

For local installations, the default Directory Server will automatically be authenticated with the ESCWA
credentials. Otherwise, you might need to provide its own credentials. You may use the same credentials
as the ones for ESCWA.

Note the default 5-minute (300 second) session time out setting for inactivity in ESCWA. If required, you
can change this from the ESCWA Security Settings dialog ("Session Inactivity Timeout").

Authentication Inside the IDE and the Data Tools Utility

The Server Explorer window in the IDE and in Data Tools, requires credentials for the Micro Focus
Servers node to connect to the default local ESCWA and the MFDS. Additionally, you need to provide
credentials to start any regions. By default, the credentials will be pre-populated in the dialog using the
values stored in the microfocus/temp/admin vault location. These credentials can optionally be stored
by the IDE so they do not need to be manually input again.

Note: If you delete the SYSAD user or change the password generated for it by the installer in the
default VSAM Security Manager, you need to provide new sufficiently authorized credentials for the
Server Explorer connection.
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Authentication for HACloud

HACloud will initially use the default generated "readonly" credentials specified in the microfocus/
common/readonly vault location. If ESCWA and/or the Micro Focus Directory Server are subsequently
configured with non-default credentials, you need to manually configure HACloud to use these. See
Authenticating HACloud for Work with ESCWA and MFDS in your product Help.

Fileshare

If you want to view or delete Fileshare instances in ESCWA, you now need to log on using authorized
credentials (such as the default SYSAD user).

Command-Line Utilities

There are multiple command line utilities that control and access enterprise server region. These use
Enterprise Server credentials specified as parameters - for example, casstart /z.

See Administration and Configuration Commands in your product Help for individual commands to
determine how to specify authorized credentials.

Samples and Tutorials

There are a variety of samples and tutorials supplied with the product. Many of these assume that security
is not enabled, so to work through these unaltered default security will first need to be disabled. See To
Disable the Default Enterprise Server Security Configuration in your product Help. If security is not
disabled, you will need to it take into account when you:

• Use ESCWA
• Start a region
• Run a cas command line utility
• Run a transaction using TN3270. You need to sign in via CESN.
• Submit a JCL job

In Server Explorer inside the IDE, the SignOn dialog boxes to ESCWA will have the default generated
SYSAD credentials pre-populated. If the SYSAD password has been changed, or you need to use different
credentials, you need to sign on using the required details.

Micro Focus Common Client

The mf-client.dat file which is used by the Micro Focus Common Client (MFCC), is configured out-of-
the box to use the default generated "readonly" credentials from the microfocus/common/readonly
vault location. This means that access to the Micro Focus Directory Server using the default security
configuration works automatically for read-only access.

MFCC is used by COBOL web service proxy programs, the Interface Mapping Toolkit service-deployment
mechanism, Fileshare clients (when configured appropriately), various utilities such as cassub (depending
on the operating mode), the CICS Web Interface and CICS Web Services, and product components such
as MFCS and ESCWA. See Micro Focus Common Client in your product Help.

Configuring the Environment for Developing RDBMS Applications on
UNIX

Note:

• If you are working with remote projects, you need to configure the environment before you start the
remote server process.

• On UNIX, if you are working with local projects, you need to configure the environment before you
start Eclipse.
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1. Ensure the COBOL and the third-party software environments are set.
2. Set up the RDBMS environment.

Refer to your RDBMS vendor documentation for details.
3. Set COBCPY as required in order for the IDE to locate any copybooks that are external to your project.
4. If working with Pro*COBOL/Cobsql applications you need to set COBOPT. This sets the appropriate

linker options for the platform and the COBOL working mode:

To do this, execute the following at the command line:

$COBDIR/src/oracle/set_cobopt_oracle
COBOPT=$PWD/cobopt.ora
export COBOPT

Enabling SHIFT-JIS
By default, support for the character encoding for the Japanese language, Shift-JIS, is not available on
Ubuntu and on RedHat OS version 8 or later.

You need to generate the Shift JIS locale on your machine to be able to execute Shift-JIS applications on
these platforms. You can do this as follows:

1. On RedHat 8, ensure that the glibc-locale-source package is installed.
2. Execute the following command with superuser rights in order to generate a Shift-JIS locale using the

charset:

sudo localedef -f SHIFT_JIS -i ja_JP ja_JP.sjis

3. Set the COBUTF8 environment variable to the generated Shift-SJIS locale and LANG to a UTF8 locale:

export COBUTF8=ja_JP.sjis
export LANG=ja_JP.UTF-8

4. Run the cobutf8 utility:

cobutf8 <command>

See your product documentation for more details about cobutf8.

Viewing the Product Help
Enterprise Developer is configured to display the product help available online on the OpenText Support for
Micro Focus Products website: https://www.microfocus.com/en-us/support/documentation/.

You can view the Enterprise Developer product help in one of the following ways:

Choose whether to view the help online or locally

You can configure Eclipse to show the Enterprise Developer help either online or locally:

1. In Eclipse, click Window > Preferences > Micro Focus > Help.
2. Either disable or enable Use online documentation, depending on whether you want to see the

documentation locally or online.

Online help (default)

• Click Help > Micro Focus > Product Documentation.
• Alternatively, press F1 inside the editor or from a UI part.

This opens a browser with the Enterprise Developer help.

Note: Ensure that you have an up-to-date version of your browser.
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Local help

1. Configure Eclipse to use local help as detailed above.
2. Access the local help in one of the following ways:

• Click Help > Help Contents to open the Help Viewer, then open the Micro Focus-branded
documentation.

• Alternatively, press F1 inside the editor or after clicking a dialog within the UI.

Repairing
If a file in the installation of the product becomes corrupt, or is missing, we recommend that you reinstall
the product.

Before performing a repair of the installation, Micro Focus recommends that you create backups of any
configuration files of the product that you might have changed.

Uninstalling
Before you uninstall the product, ensure that the Enterprise Server Common Web Administration
(ESCWA), the Micro Focus Directory Server, and any enterprise server regions are stopped.

To uninstall this product:

1. Execute as root the Uninstall_EnterpriseDeveloper10.0.sh script in the $COBDIR/bin
directory.

Note: The installer creates separate installations for the product and for Micro Focus License
Administration. Uninstalling the product does not automatically uninstall the Micro Focus License
Administration or the prerequisite software. To completely remove the product you must uninstall the
Micro Focus License Administration as well.

To uninstall Micro Focus License Administration:

1. Execute as root the UnInstallMFLicenseServer.sh script in the /opt/microfocus/
licensing/bin directory.

The script does not remove some of the files as they contain certain system settings or licenses.

You can optionally remove the prerequisite software. For instructions, check the documentation of the
respective software vendor.
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Licensing Information
Note:

• The SafeNet Sentinel licensing system has been deprecated. This product uses the Micro Focus
AutoPass licensing technology. Contact your account manager to replace your existing SafeNet
Sentinel with AutoPass licenses. Also, see Advanced Installation Tasks > Licensing Coexistence
when Upgrading to Release 10.0 in the Installation section in your product Help.

• If you have purchased AutoPass licenses for a previous release of this product, those licenses will
also enable you to use this release.

• If you are unsure of what your license entitlement is or if you wish to purchase additional licenses,
contact your sales representative or OpenText Support for Micro Focus Products.

To start Micro Focus License Administration

Windows: To start the GUI Micro Focus License Administration

Windows 10 From your Windows desktop, click Start > Micro Focus License Manager > License
Administration.

Windows 11 Click the Start button in the Task Bar. Use the search field in the Start menu to find and
start License Administration.

Windows: To start the command-line Micro Focus License Administration tool

1. At a command prompt, navigate to:

C:\Program Files (x86)\Micro Focus\Licensing

2. Type cesadmintool.bat, and press Enter.

UNIX

Log on as root, and from a command prompt type:

/opt/microfocus/licensing/bin/cesadmintool.sh

Configuring licensing for older products

If you use release 10.0 and previous releases on the same machine on UNIX, you need to the set the
environment variable MFCES_INIT_LOCATION to /opt/microfocus/licensing/bin/ces.ini in
order for licensing to work for the older products. Also, see Advanced Installation Tasks > Licensing
Coexistence when Upgrading to Release 10.0 in the Installation section.

Installing licenses
You need a license file (with an .xml extension for AutoPass licenses). You need to install AutoPass
licenses into the existing Micro Focus License Administration tool, and not in the AutoPass License Server.
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Applying your license file

Windows: To use the GUI Micro Focus License Administration

1. Start Micro Focus License Administration.
2. Click the Install tab.
3. Do one of the following:

• Click Browse next to the License file field and select the license file (which has an extension
of .xml).

• Drag and drop the license file from Windows Explorer to the License file field.
4. Click Install Licenses.

Alternatively, you can install the license file from within the IDE as follows:

1. Start Enterprise Developer.
2. Click Help > Micro Focus > Product Licensing to open the Product Licensing dialog box.
3. Click Browse next to the License file field.
4. Select the license file (which has an extension of .xml), and then click Open.
5. Click Finish to install the license.

Windows: To use the command-line Micro Focus License Administration tool

1. Start the command-line Micro Focus License Administration tool.
2. Select the Manual License Installation option by entering 4.
3. Enter the name and location of the license file.

UNIX

1. Start the Micro Focus License Administration tool and select the Manual License Installation option by
entering 4.

2. Enter the name and location of the license file.

To obtain more licenses
If you are unsure of what your license entitlement is or if you wish to purchase additional licenses for
Enterprise Developer, contact your sales representative or OpenText Support for Micro Focus Products.
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Updates and OpenText Support for Micro
Focus Products

Our Web site provides up-to-date information of contact numbers and addresses.

Further Information and OpenText Support for Micro
Focus Products

Additional technical information or advice is available from several sources.

The product support pages contain a considerable amount of additional information, such as:

• Product Updates on Software Licenses and Downloads, where you can download fixes and
documentation updates.

1. Log into the Software Licenses and Downloads (SLD) site at https://sld.microfocus.com/mysoftware/
download/downloadCenter .

2. Select your account and click Entitlements.
3. Search for the product by using any of the available search parameters.
4. Click Show all entitlements.
5. Click Get Software in the Action column for the product you want to download or update.

In the File Type column, you see entries for "Software" for any GA products, and "Patch" for any
patch updates.

6. Click Download on the relevant row.
• The Examples and Utilities section of the OpenText Support for Micro Focus Products Web site,

including demos and additional product documentation. Go to https://supportline.microfocus.com/
examplesandutilities/index.aspx.

• The Support Resources section of the OpenText Support for Micro Focus Products Web site, that
includes troubleshooting guides and information about how to raise an incident. Go to https://
supportline.microfocus.com/supportresources.aspx

To connect, enter https://www.microfocus.com/en-us/home/ in your browser to go to the Micro Focus home
page, then click Support & Services > Support. Type or select the product you require from the product
selection dropdown, and then click Support Portal.

Note: Some information may be available only to customers who have maintenance agreements.

If you obtained this product directly from Micro Focus, contact us as described on the Micro Focus Web
site for Micro Focus products, https://www.microfocus.com/support-and-services/contact-support/. If you
obtained the product from another source, such as an authorized distributor, contact them for help first. If
they are unable to help, contact us.

Also, visit:

• The Micro Focus Community Web site, where you can browse the Knowledge Base, read articles and
blogs, find demonstration programs and examples, and discuss this product with other users and Micro
Focus specialists. See https://community.microfocus.com.

• The Micro Focus YouTube channel for videos related to your Micro Focus product. See OpenText
YouTube Channel for Micro Focus Products.

• Micro Focus webinars: https://www.microfocus.com/en-us/resource-center/webinar.
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Information We Need
If your purpose in contacting Micro Focus is to raise a support issue with OpenText Support for Micro
Focus Products, you should collect some basic information before you contact us, and be ready to share it
when you do.

Click here to see the Preparing to Raise a Support Case topic on the Product Documentation pages on
OpenText Support for Micro Focus Products, in the product help for Enterprise Developer for Eclipse
(Windows)..

Creating Debug Files
If you encounter an error when compiling a program that requires you to contact OpenText Support for
Micro Focus Products, your support representative might request that you provide additional debug files
(as well as source and data files) to help us determine the cause of the problem. If so, they will advise you
how to create them.
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Copyright and Disclaimer
© Copyright 2024 Micro Focus or one of its affiliates.

The only warranties for this product and any associated updates or services are those that may be
described in express warranty statements accompanying the product or in an applicable license agreement
you have entered into. Nothing in this document should be construed as creating any warranty for a
product, updates, or services. The information contained in this document is subject to change without
notice and is provided "AS IS" without any express or implied warranties or conditions. Micro Focus shall
not be liable for any technical or other errors or omissions in this document. Please see the product's
applicable end user license agreement for details regarding the license terms and conditions, warranties,
and limitations of liability.

Any links to third-party Web sites take you outside Micro Focus Web sites, and Micro Focus has no control
over and is not responsible for information on third-party sites.

This product includes software developed by Computing Services at Carnegie Mellon University (http://
www.cmu.edu/computing/).
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